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Using this Guide

How to use this guide
It is highly recommend that you read the first three chapters of this guide prior to attending a
Blackboard Collaborate Web Conferencing session.

1. Read Conventions Used in this Guide on page 3 of this chapter to familiarize yourself with
the various presentation, formatting and typographical conventions used in this guide.

2. Follow the instructions in Getting Started on page 5 to ensure you have the proper hard-
ware and software to run Blackboard Collaborate and to set up your Blackboard Col-
laborate environment.

3. Read The Blackboard Collaborate Web Conferencing Room on page 21 to familiarize your-
self with the Blackboard Collaborate user interface.

Refer to the remaining chapters in any order to become familiar with the available tools and fea-
tures of Blackboard Collaborate.

Note: For a discussion of the accessibility features in Blackboard Col-
laborate Web Conferencing, including Closed-Captioning and the Activity
Window, see the Accessibility Guide for Participants.



Terminology
The following terms are used in this guide when referring to Blackboard Collaborate Web Con-
ferencing users:

l Moderator – Moderators have access to all Blackboard Collaborate features, including the
ability to grant Moderator status to Participants. The person conducting a session, such as
a teacher, is a Moderator.

l Participant – Participants have restricted access to Blackboard Collaborate features. Stu-
dents are typically Participants, although Moderators can grant Participants Moderator
status.

l Session Attendee – Anyone attending the session (both Moderators and Participants).

l Invitee – Anyone invited to the session (both Moderators and Participants).

Getting Help

Documentation and Training Materials
Documentation and training materials (for all Blackboard Collaborate products) are available on
the On-Demand Learning Center, which can be reached in two ways:

o From within Blackboard Collaborate Web Conferencing, select Additional Documentation
from the Help menu.

o In your browser, enter the following address:

http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center.aspx

You can directly open the following documents from within Blackboard Collaborate Web Con-
ferencing by selecting them from the Help menu:

l Keyboard Shortcuts

l Accessibility Guide (Moderator's version)

l Blackboard Collaborate Essentials for Moderators

l Blackboard Collaborate Essentials for Participants

Technical Support
Blackboard Collaborate technical support and the support Knowledge Base are available through
the Support Portal:

http://support.blackboardcollaborate.com
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Conventions Used in this Guide

Operating System Differences
This guide is written for Blackboard Collaborate Web Conferencing users on all supported oper-
ating systems: Windows, Mac OS X, and Linux.

Keystrokes and Mouse Clicks

The same keystrokes and mouse clicks are used on Windows and Linux platforms. Those used
on Mac OS X are different. This guide gives instructions for users of all supported operating sys-
tems. The Windows/Linux keystrokes or mouse clicks are given first, followed by those for Mac
OS X (in parentheses):

Mouse Click Example

Select the object and then right-click (Control-Click on Mac) anywhere on the Whiteboard to dis-
play the context menu.

Keystroke Example

Select the object(s) in the Whiteboard or in the Object Explorer and then enter Ctrl+X (Com-
mand-X on Mac) to cut the object(s).

Screen Captures

Most screen captures shown in this guide were taken in a Windows environment. If you are run-
ning Blackboard Collaborate Web Conferencing on a Mac OS X or Linux platform, the appear-
ance of windows, dialog boxes, etc. will differ slightly from those shown in this guide.

Variables

There are a few places in Blackboard Collaborate Web Conferencing that are populated with data
specific to the session. Because we do not know in advance what those data (e.g., words or
names) will be, in this guide they are represented by variables enclosed in angle brackets. For
example, the variable <Panel Name> is used in the discussion of Restoring Default Prefence Sett-
tings to represent the name of the currently selected panel.

Notes
Six types of notes are used in this guide to highlight information:

Note: Notes are used to highlight important information or to present
asides relevant to the topic at hand.
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Tip: Tips provide helpful information on how to most effectively use a
particular feature of Blackboard Collaborate Web Conferencing.

Caution: Cautions alert you to potentially confusing terminology or
difficulties that may occur when using Blackboard Collaborate Web
Conferencing.

Warning:Warnings alert you to potentially serious problems.

Notes of this format are used to highlight Linux-specific information.

Notes of this format are used to highlight Mac-specific information.

Typographical Conventions

Convention Description

1. Number Indicates a step in a task.

o Hollow bullets Indicates that there are several options available for completing a
task, but only one is necessary.

Bold Represents clickable elements in the user interface (e.g., text
links, buttons, tabs, etc.). Also used to give emphasis to words.

Italics Represents menu items, options and parameters. Also used for
cross references.

Monospace Indicates pathnames, filenames, folders and command lines.

<brackets> Indicates variables.
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Getting Started
There are a few things you should do before you moderate a session:

l Ensure your computer meets the minimum system requirements recommended for run-
ning a Blackboard Collaborate Web Conferencing session on your computer. SeeMini-
mum Client System Requirements on page 6.

l Launch into a private Blackboard Collaborate Web Conferencing session where you can
familiarize yourself with the Whiteboard tools or create or review presentations and/or
quizzes prior to joining your scheduled session. (For instructions on launching a private
session, see Launching an Offline Blackboard Collaborate Web Conferencing Session on
page 20.)

l Join a Blackboard Collaborate Web Conferencing session. You may join a session either
through an email link sent to you by your organization or via a link on a web page. The
method by which you join a session will vary depending on your organization. See Joining
a Blackboard Collaborate Web Conferencing Session on page 7.

l Once you have successfully launched into a Blackboard Collaborate Web Conferencing ses-
sion, run the Audio Setup Wizard (see Using the Audio Setup Wizard on page 82) and set
your proxy settings (see Setting Your Proxy Configuration on page 13). You may also want
to set other preferences, such as your connection speed (see Setting Your Preferences on
page 7).



Minimum Client System Requirements
Before you can get started in a Blackboard Collaborate Web Conferencing session, you should
ensure that your computer is able to support the needs of the collaboration environment.

Tip: For all users, we strongly recommend that you use a headset (or at
least headphones or an echo canceling microphone) rather than speakers
when using simultaneous talkers. This will eliminate potential echoing
and feedback and improve your audio experience.

Your computer should meet or exceed the following minimum requirements:

Windows

n Windows XP (32 bit), Windows Vista (32 or 64 bit) or Windows 7 (32 or 64 bit)

n Pentium III 1 GHz processor

Mac OS X

n Mac OS X 10.5 (32 or 64 bit) or Mac OS X 10.6 (32 or 64 bit)

n G4, G5 or Intel processor

Linux

n Ubuntu 9.10 (64 bit)

n Pentium III 1 GHz processor

In addition to the above requirements, all clients require the following:

n Java version 1.5 or higher

Note: For a 32 bit OS use a 32 bit JVM and for a 64 bit OS use a 64 bit
JVM. If the correct version of Java is not detected, Blackboard Col-
laborate will prompt you to install a new version.

l 256 MB RAM

l 20 MB free disk space

l 28.8 KBps Internet connection

l Windows or Linux: sound card with speakers and microphone or headset (or telephone
for Telephony users)

l Macs: internal, USB, or external iSight microphone (or telephone for Telephony users)
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Joining a Blackboard Collaborate Web Conferencing Session
How you join a Blackboard Collaborate Web Conferencing session varies depending on the
organization hosting the Blackboard Collaborate Web Conferencing session. Follow the instruc-
tions provided by the organization hosting your session.

Your System Administrator or Moderator should provide you with the following information:

l How to access your Blackboard Collaborate Web Conferencing sessions.

l Your username and password (if applicable).

l How to access your recordings.

l Who to contact for help and where to access the user guides and other resource material
for your system.

Setting Your Preferences
Although it is not necessary, you may want to set some of your application preferences before
you begin your session. You can do so through the Preferences dialog. Preferences are set for
each user account on a computer. Once set, they are used for all sessions connected to by that
user from that computer.
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Open the Preferences dialog in one of the following ways:

o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

Instructions for setting preferences are dispersed throughout this guide:

Preference(s) Location in Guide

Connection Speed Setting Your Connection Speed on page 11

Proxy Configuration Setting Your Proxy Configuration on page 13

Notifications Setting Notification Preferences on page 16

Hot Keys Configuring Hot Keys on page 36

User Profile User Profiles on page 52

Application Sharing Advanced Application Sharing Options on page 151

Audio Advanced Audio Configuration on page 87

Video Selecting your Video Camera on page 63

Whiteboard Locating an OpenOffice.org Installation on page 1

In-Session Invitations Setting the Email Text Encoding Format Preference on page 1

Interactive Recordings Recording Your Sessions on page 1

Session Plans Not in this guide. See the Elluminate Plan! Users Guide.

Preferences Dialog Components
The Preferences dialog is organized into two main areas: the Preferences list on the left and the
Preferences panels on the right. The Preferences list contains a list of modules and their asso-
ciated panels organized into a tree structure (in alphabetical order). The panel that is selected in
the Preferences list will be displayed in the Preferences panels area on the right.
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1 Preferences list 3 Modules

2 Preference panels 4 Panels

Note: If you select a module (rather than one of the panels beneath it),
the topmost panel associated with that module will be displayed in the
Preferences panels area.
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Navigating Within the Preferences List
You can move between modules and panels in the Preferences list using the arrow keys or by
simply clicking on a desired module or panel.

You also can collapse and expand the list of panels beneath a module by clicking on the dis-
closure buttons.

Restoring Default Preference Settings
If you are unsure about the preferences you set and want to start over, you can revert back to
the default (factory) settings. The restoration can be done at an application level, module level or
panel level by selecting an option from the Restore Defaults menu.

l To restore defaults for the entire Blackboard Collaborate Web
Conferencing application, select Restore All Modules.

l To restore defaults for all panels within a specific module,
select the module in the Preferences list and then select
Restore Module <Module Name> from the Restore Defaults
menu.

l To restore defaults for a single panel only, select the panel in the Preferences list and then
select Restore Panel <Panel Name> from the Restore Defaults menu.

Resizing and Moving the Preferences Dialog
You can move the Preferences dialog by dragging its title bar. You also can resize it. If the Pref-
erences panel is too large to fit in the right side of the Preferences dialog, scroll bars will appear
so you can move within the panel.

The next time you open the Preferences dialog, it will be located in the same place and be of the
same size as when you last opened it. The panel you last worked in will be displayed.
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Setting Your Connection Speed
The first time you join a session, the Select Connection Speed dialog box appears prompting you
to select the connection speed that you will be using. After you exit the session, the connection
speed is automatically saved with the preferences.

Note: You can quickly see what your current connection speed is by view-
ing it under the Information menu. See Getting Session Connection Infor-
mation on page 38.

Another way to set your connection speed is through the Preferences dialog. You may do this in
an offline session (see Launching an Offline Blackboard Collaborate Web Conferencing Session
on page 20) or anytime within a live session.

Configure your connection speed in the Preferences dialog.

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select Connection under Session. The Con-
nection preferences panel appears.
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3. From the list of Connection Speed options, select the modem or line speed that your com-
puter is using to connect to the Blackboard Collaborate Web Conferencing Server. In most
cases, this means your Internet connection speed.

Warning: Setting the incorrect connection speed (either higher or
lower) may result in poor performance.

Select If your connection is …

28.8K Dialup 28.8K modem

33.6K Dialup 33.6K modem

56K Dialup 56K modem

ISDN High-speed dedicated telephone connection

Wireless Wireless connection

Cable/DSL High-speed cable connection or Digital Subscriber Line

LAN Local Area Network

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Prompting for the Connection Speed
Because your connection speed settings are saved for the next time you log in, you may find the
appearance of the Select connection speed dialog box to be unnecessary. We have provided an
option where you can decide whether you would like this dialog box to appear, never appear, or
appear only when the location changes (that is, your IP Address changes).

Configure your connection speed prompt in the Preferences dialog.

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)
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o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select Connection under Session. The Con-
nection preferences panel appears.

3. From the list of Prompt for speed options, select your desired option.

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Setting Your Proxy Configuration
If you are connecting through an Internet firewall, which is set up to block both outbound and
inbound connections and web browsing that is done through an HTTP or HTTPS proxy server,
you may have to change the Proxy Settings preference in Blackboard Collaborate Web Con-
ferencing

By default, Blackboard Collaborate inherits the same proxy settings as the browser it was
launched through. If Blackboard Collaborate is unable to automatically detect the proxy settings
it will be unable to connect to the Session. In this case, you may be able to start Blackboard Col-
laborate Web Conferencing but not be able to join a session.

If Blackboard Collaborate encounters a proxy configuration error, it will return a Connection
failed error message similar to the one below.
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If this happens, you may have to change your Proxy Settings to enable Blackboard Collaborate
Web Conferencing to communicate with your proxy server.

Note: Ask your System Administrator to provide you with the necessary
proxy server information.

To Configure your Proxy Settings in the Preferences:

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, select Proxy Settings under General. The Proxy
Settings preferences panel appears.

3. Select the desiredMethod option from the Method drop-down list. The choices are the fol-
lowing:

n Proxy Settings From Launcher (<proxy setting>) – Blackboard Collaborate uses the
connection settings from Java Web Start. If manual proxy settings are not provided
to Java Web Start, it will attempt to detect these settings on its own and then pass
the results to Blackboard Collaborate This is the default proxy setting and should be
changed only if you are unable to establish a reliable connection.

Note: <proxy setting> will be whichever type of proxy setting
is detected by the launcher.

n Direct Connection – Specifies that no proxy server is to be used. Blackboard Col-
laborate Web Conferencing will connect directly to the appropriate server.

n SOCKS V4/V5 Proxy Server – Specifies that a version 4 SOCKS proxy server is to be
used.

n HTTPS Proxy Server – Specifies that a secure HTTPS proxy server is to be used.

n HTTP Proxy Server – Specifies that an HTTP proxy server is to be used.

n HTTP Proxy Server (Half-Duplex) – Specifies that an HTTP proxy server is to be
used in reduced bandwidth half duplex mode. Use this option only if you have an
HTTP proxy server and you are unable to establish a reliable connection with the
previous setting.
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n HTTP Direct – Specifies that Blackboard Collaborate Web Conferencing is to con-
nect directly to the server with the HTTP protocol. While this is similar to a direct
connection, the use of the HTTP protocol may reduce performance and should be
used only if a normal direct connection is not possible.

n HTTP Direct (Half-Duplex) – Specifies that Blackboard Collaborate Web Con-
ferencing is to connect directly to the server with the HTTP protocol in a reduced
bandwidth half duplex mode. Use this option only if you require an HTTP direct con-
nection and are unable to establish a reliable connection with the previous setting.

4. Enter your proxy server IP address in the Server field and enter your proxy serverport
number in the Port field. (You may have to ask your System Administrator to provide you
with this information.)

Note: For more information on proxy configuration, visit the
Knowledge Base:
http://support.blackboardcollaborate.com

5. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Setting Notification Preferences

Audible Notifications
Audible notifications are system messages sent by Blackboard Collaborate Web Conferencing to
notify users when certain important events occur within the session. These notifications are pre-
sented as sounds.

In the Preference dialog, you can listen to what each notification sounds like as well as enable or
disable the notifications. There are two built-in sets of notifications: Basic and All.

16 Getting Started
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1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, under General select Audible Notifications. The
Audible Notifications preferences panel appears on the right side of the main Preferences
dialog.

3. To hear the sound used for a notification, click on its Preview icon in the right column
of the panel.

4. Enable and disable the notifications for the various events in the following ways.
o To create a custom set of notifications, click on the Enabled checkbox (middle col-
umn) associated with the desired individual events.

o Click on the Basic button at the bottom of the panel to select the Hand Raised
Alarm, Recording in Progress, Start Recording, Stop Recording and Timer Alarm
events. This is the default setting.

o Click on the All button at the bottom of the panel to select all events.
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5. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Visual Notifications
Visual notifications are system messages sent by Blackboard Collaborate Web Conferencing to
alert users when certain important events occur within a session. These notifications are pre-
sented in a floating window. Multiple notifications get queued: the first one is displayed until it
times out or you dismiss it (by clicking on the Dismiss button in the bottom right corner of the
notification), then the next one is displayed, and so on. When there is more than one noti-
fication, the window will have aDismiss All button beside the Dismiss button and display
the number of notifications in the queue in the bottom left corner of the notification.

You can judge how long the message will remain open by looking at the Timeout Indicator. You
either can dismiss a notification manually (by clicking on the Dismiss button) or wait for it to
close itself automatically (when the Timeout Indicator runs its course).

1 Timeout Indicator 3 Dismissal buttons

2 Number of notifications in the queue

In the Preference dialog, you can enable or disable the notifications. By default, all notifications
are enabled.

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, select Visual Notifications under General. The
Visual Notifications preferences panel appears on the right side of the main Preferences
dialog.

3. Enable and disable the notifications for the various events as desired by select-
ing/deselecting the checkboxes in the Enabled column on the right side of the panel.

Note: The changes you make in the Visual Notifications Pref-
erences panel will not affect what is displayed in the Event panel of
the Activity Window.

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.
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Leaving and Rejoining a Session
To leave a session while keeping the current Blackboard Collaborate Web Conferencing appli-
cation window open, open the Helpmenu and select Leave Session.

To rejoin the session if you have left or been removed, open the Helpmenu and select Join Ses-
sion.

Launching an Offline Blackboard Collaborate Web
Conferencing Session
To familiarize yourself with the Whiteboard tools or to configure your Audio, you can use an off-
line Blackboard Collaborate Web Conferencing session. An offline Blackboard Collaborate ses-
sion can be accessed at any time. You also can create or review presentations and/or quizzes.

Note: The Participants panel, Chat, Audio, Application Sharing and Web
Tour do not function in an offline Blackboard Collaborate session.

Note: To load a Whiteboard presentation into an offline Blackboard Col-
laborate session, you must be in your Private Work Area.

There are two ways to launch an offline session:

n Leave a live session without closing the Blackboard Collaborate application. (See Leaving
and Rejoining a Session above.) All Chat messages and Whiteboard pages that were visible
in the session remain so you can review, print or save them.

n Use the configuration room available through the Support Portal:

1. Open http://support.blackboardcollaborate.com .

2. Browse to First Time Users and then to Step 2 under Blackboard Collaborate Web
Conferencing.

3. Click on the link Configuration Room.
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Chapter 3

Page 21

The Blackboard Collaborate Web
Conferencing Room

The Blackboard Collaborate Web Conferencing room consists of six main components:

n TheMenu bar contains the File, Edit, View, Tools, Windows and Help menus.

n The Audio & Video panel enables you to participate in conversations either using a
microphone and speakers (or headset) or via a teleconference. You also can transmit and
receive Video during the session and preview your video before transmitting it.

n The Participants panel provides a list of all Participants and Moderators in the session
and information about their current activities, such as talking (Audio), transmitting Video,
sending a Chat message, using the Whiteboard drawing tools and conducting an Appli-
cation Sharing session.

Above the Participants list is a small toolbar containing buttons for raising your hand and
stepping away from the session and menus for selecting polling responses and feedback
options.

n The Chat panel enables you to send Chat messages to everyone in the room or to Mod-
erators only. By selecting names in the Participants list, you can send private Chat mes-
sages to individuals. Messages can be printed and saved to track session communication.

n The Collaboration toolbar contains three buttons for switching between the three con-
tent modes (Whiteboard, Application Sharing and Web Tour), an Information menu for
obtaining session information (e.g., connection type) and starting the Timer, a Load Con-
tent button for loading content into the session and the Record button.



n The Content area is the main presentation window. Moderators use this region to load
presentations. Everyone can use the tools on the Whiteboard to draw or write. All the
objects and images on the Whiteboard are dynamic and can be modified. Everyone can
print the Whiteboard pages or save them to a file to review later.

1 Title bar 6 Minimize button

2 Menu bar 7 Maximize button

3 Audio & Video panel 8 Close button

4 Participants panel 9 Collaboration toolbar

5 Chat panel 10 Content area

The Content Area Modes
The Whiteboard, Application Sharing and Web Tour share space in the Blackboard Collaborate
Web Conferencing interface – each represents a "mode" in the content area. Although White-
board content, Application Sharing content and Web Tour content may all be loaded at the same
time, you will be able to see the content of only one mode at a time.
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Only certain users can switch between modes:

n Moderators with can switch between all modes.

n Participants with Application Sharing permission can switch to Application Sharing mode
and back to Whiteboard mode.

n Participants with Web Tour permission can switch to Web Tour mode and back to White-
board mode.

Participants with Whiteboard permission but not Application Sharing or
Web Tour permission cannot switch to Whiteboard mode from either of
the other two modes. This safeguards against Participants switching
modes during someone else's Web Tour or Application Sharing pre-
sentation.

When someone switches modes, everyone in the session will follow them to the new mode.

Be careful not to inadvertently switch modes on someone else who is
presenting content. Everyone in the session will follow you to the new
mode.

To switch modes, do one of the following:

o Click on the button in the Collaboration toolbar associated with the desired mode.
o Select the desired mode from the View menu.
o Use the keyboard shortcut associated with the desired mode:

Whiteboard mode: Ctrl+Alt+W (Command-Option-W on Mac)

Application Sharing mode: Ctrl+Alt+A (Command-Option-S on Mac)

Web Tour mode: Ctrl+Alt+U (Command-Option-U on Mac)

You can easily see which mode is selected by noting which button in the Collaboration toolbar is
colored. In the Collaboration toolbar below, the current mode is Whiteboard mode.
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Managing Panels and Windows
The Blackboard Collaborate Web Conferencing interface consists of panels and windows. Panels
can be collapsed, expanded, detached and reattached, resized and, in their detached state, can be
moved. These side panels (Audio & Video, Participants and Chat) also can be hidden. For details,
seeWorking with Panels below.

The main application window can be minimized, maximized, moved, resized and closed. Other
windows can be opened, moved, resized and closed. For details, seeWorking with Windows on
the facing page.

Working with Panels
The default when you first join a Blackboard Collaborate Web Conferencing session is for the
Participants and Chat panels to be expanded and attached and the Audio & Video panel to be col-
lapsed and attached. Blackboard Collaborate will remember the state in which you left your pan-
els (expanded or collapsed and attached or detached) from one session to the next (but only if
you are logged in to the same computer).

Below are the ways you can manage your panels:

n Collapse and expand a panel: By default, the panels are expanded. If you want to
make more room for one of the panels, you can collapse the others.

To collapse a panel, click on the Collapse button in the panel's title bar:

To expand the panel back to its former state, click on the Expand button in the panel's
title bar:

n Move a panel: Grab the panel (either attached or detached) by its title bar and, while
holding down your mouse, drag it to the desired location and then drop it by releasing the
mouse.
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n Detach and reattach a panel: Panels can be detached so you can move them to a
more convenient location.

To detach a panel, do one of the following:
o From the Options menu, select Detach Panel.
o Drag and drop the panel out of the main application window. (See Move a panel
above.)

To reattach a panel, do one of the following:
o From the Options menu, select Attach Panel.
o Drag and drop the panel back into the main application window. (See Move a panel
above.)

o From the View menu, select Restore Default Layout.
o Click on the panel's Close button:

n Reorder an attached panel: Drag and drop the panel up or down within the side bar
area (left side) of the main application window. (See Move a panel above.)

n Hide attached side panels: You can make the Content area larger by hiding the side
bar area (left side) of the main application window. To do so, in the View menu, unselect
(uncheck) Show Side Bar. To restrore the side bar, reselect it. Alternatively, you can grab
the border of any one of the panels and drag it all the way to the left. To bring the side bar
back, grab it again and move to the right.

n Resize a panel: Grab a panel border and drag it. Hold your mouse over any side (either
attached or detached) or a corner (detached only) and, when the cursor changes to a two-
headed arrow, click and drag the border of the panel to contract or expand it.

n Un-obscure detached panels: If part of the panel is obscured by another panel or win-
dow, click anywhere on the panel to bring it to the front of the other panel or window.

Working with Windows
There are a number of different kinds of windows in Blackboard Collaborate Web Conferencing:
the main application window, module windows (such as the Notes window and the Multimedia
Library), dialog boxes (such as the Preferences dialog and Create Breakout Rooms dialog) and
utility windows (such as the Object Explorer and Page Explorer).
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Below are the ways you can manage your windows:

n Open the main application window: To open the window you need to join the ses-
sion by clicking on a link.

n Open a main module window: To open the window of one of the main modules,
select it from the Window menu or, if available, open it using its associated keyboard short-
cut (see Keyboard Shortcuts on page 29.)

n Move a window: Grab the window by its title bar and, while holding down your mouse,
drag it to the desired location and then drop it by releasing the mouse.

n To resize a window: Grab a window border and drag it. Hold your mouse over any side
or a corner and, when the cursor changes to a two-headed arrow, click and drag the bor-
der of the window to contract or expand it.

n Minimize or maximize the main application window: Use the standard con-
ventions of your operating system for minimizing and maximizing windows. For example,
on Windows, use the Minimize and Maximize buttons in the window's title bar:
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n Un-obscure a window: If part of a window is obscured by another window or panel,
click on the window itself to bring it to the front of the other window or panel.

Tip: If you can't find a window because it is hidden beneath other
windows, an easy way to find it is to select Restore Default Layout
from the View menu and then open your window again.

n Close a main module window: To close a main module window, do one of the fol-
lowing:

o Click on the window’s Close button in the title bar of the window.
o Enter Ctrl+W (Command-W on Mac)
o Enter Alt+F4 (Windows and Linux only)

n Close the main application window: If you close the main application window you
will leave the session. For details, see Closing the Application on page 38.

The Menus
Most of the functionality of Blackboard Collaborate Web Conferencing can be accessed through
the menus. In addition to selecting menu options with your mouse, you can use mnemonics
and, for some functions, keyboard shortcuts (see Using Mnemonic and Keyboard Shortcuts on
page 28).

Menus in the Main Menu Bar
The following menus are available in Blackboard Collaborate in the main menu bar:

n File menu: Contains file-related commands (New, Open, Save and Print) for Whiteboard
files, Multimedia files, quizzes, session plans, Chat conversations and the Participants list.
It is also where you will find the Exit command for closing Blackboard Collaborate Web
Conferencing.

n Edit menu: Contains standard editing commands (Cut, Copy, Paste and Select All) and
enables you to open the Preferences dialog.

n View menu: Contains commands for changing your window layout and changing con-
tent modes (Whiteboard, Application Sharing and Web Tour).

n Tools menu: Contains sub-menus for using the various tools in Blackboard Collaborate:
Application Sharing, Audio, Chat, Interaction, Profile, Video and Whiteboard.

n Window menu: Enables you to open the following windows: Activity, Graphing Cal-
culator, Notes and File Transfer Library.
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n Help menu: Gives you access to documentation (a table of Keyboard Shortcuts and the
On-Demand Learning Center web site), provides diagnostic tools (that Support personnel
may ask you to use to help troubleshoot an issue), enables you to leave the session without
closing the application (and then rejoin it) and provides general information about the
Blackboard Collaborate Web Conferencing software.

Drop-Down Menus
In addition to the menus in the main menu bar, Blackboard Collaborate has a number of drop-
down menus throughout the interface. Two types of drop-down menus are noteworthy:

n Options menus:Most of the main modules in the interface have their own Options
menus to give you quick access to commands specific to those modules. (These commands
also can be found in the main menus.)

To open an Options menu, either click on it with your mouse or use the keyboard shortcut
Ctrl+Shift+O (Command-Shift-O on Mac).

Tip: The keyboard shortcut will open the Options menu of
whichever module currently has keyboard focus. Be sure to move
focus to the desired module before using the keyboard shortcut.

n Participant interaction menus: There are two menus in the Participants panel that
enable you to enter your feedback and responses in the Participants list: the Feedback
menu (see Entering Feedback on page 47) and Polling Response menu (see Polling on
page 50). By default, whatever you select from one of these menus will be displayed in the
Participants list (next to your name) for everyone to see. (A Moderator may turn off the
display of polling responses.)

Tip: You do not need to click on these menus to open them. They
will open up automatically when you hover your mouse over them.

Using Mnemonic and Keyboard Shortcuts
Instead of using your mouse to select a menu option, you can use your keyboard. Using mne-
monic or Keyboard Shortcuts saves time because you do not have to complete multiple steps
(e.g., clicking on a menu and then clicking on an option), nor do you have to take your hand off
the keyboard to issue the command.

Note: Mnemonic and standard Keyboard Shortcuts are enabled only
when you have input focus on the Blackboard Collaborate Web Con-
ferencing window. Focus is not required for Hot Keys.
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Mnemonics
A mnemonic is an underlined letter or number that appears in a menu title or menu option that,
when pressed in conjunction with the ALT key, activates a command or navigates to an element
in the user interface.

Keyboard mnemonics are not supported on the Mac.

Note: On Windows, depending upon your configuration, you may have to
toggle ALT the key before the options in the menus will display the under-
lined character or number.

To choose a menu option with mnemonics, do the following:

1. Press the ALT key, note which letter or number (mnemonic) is underlined in the desired
menu name and enter it on your keyboard. The menu options for that main menu will
appear. For example, if you press ALT+F, the File menu will appear.

2. Again, note the mnemonic for the desired option in the menu and enter it, with or with-
out the ALT key.

To select a menu option from a sub-menu, repeat step 2.

Keyboard Shortcuts
You can quickly accomplish tasks you perform frequently by using keyboard shortcuts (both
standard keyboard shortcuts and hot keys), which are one or more keys you press in com-
bination within Blackboard Collaborate Web Conferencing to perform a function. For example,
instead of clicking the Raise Hand button in the Participants panel or selecting Raise Hand
from the Interaction menu, you can press Ctrl+R (Command-R on Mac OS X) to raise your
hand.

Hot keys differ from standard keyboard shortcuts in some important ways. For details, and a dis-
cussion of hot keys, see Hot Keys on page 35.

Note: The keyboard shortcuts were defined with an extended (full) key-
board layout in mind. If your keyboard does not have a key used in a key-
board shortcut, you will need to use the menu item or toolbar button to
perform the desired function.

Caution: If you are sharing an application that has a keyboard shortcut
identical to one in Blackboard Collaborate, and focus is on Application
Sharing, the shortcut will activate its associated command in the shared
application, not in Blackboard Collaborate.
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The following table lists the keyboard shortcuts (both standard and hot keys) present in Black-
board Collaborate to quickly perform a number of common functions.The first column describes
the function to be performed, the second column lists the Windows and Linux keyboard short-
cuts and the third column gives the Mac keyboard shortcuts. Keys are grouped into sections
based on the Blackboard Collaborate module being used.

Note: To access the list of keyboard shortcuts while in a session, select
Keyboard Shortcuts from the Helpmenu.
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Function Windows, etc. keys Mac keys

Application, Window and File Functions

Quit Blackboard Collaborate Alt+F4

Ctrl+Q

Command-Q

Hide Blackboard Collaborate N/A Command-H

Hide other applications N/A Option-Command-H

Close window (Notes, Activity, Closed-Cap-
tioning, Calculator)

Alt+F4

Ctrl+W

Command-W

Switch to Whiteboard Mode Ctrl+Alt+W Command-Option-W

Switch to Application Sharing Mode Ctrl+Alt+A Command-Option-A

Switch to Web Tour Mode Ctrl+Alt+U Command-Option-U

Open Preferences dialog box Ctrl+Comma Command-Comma

Save Participants list, Chat conversation or
Whiteboard

Ctrl+S Command-S

Print Participants list or Whiteboard Ctrl+P Command-P

Keyboard Navigation Functions

Move to the next main module in the user
interface. The default order is Participants
panel, Chat panel, Collaboration toolbar,
Action bar and Audio& Video panel. (If you
change the order of the panels, the order will
change.)

F6 F6

Open the Action bars of Whiteboard Mode
and Web Tour mode

F6 F6

Move to the previous main module in the
user interface. (See F6 above for the order of
modules.)

Shift+F6 Shift-F6

Move to the next user interface element
(e.g., button, field, option) in a main module
or UI element. For example, if focus is in the
Collaboration toolbar, Tab and Shift-Tab can
be used to move between the three modes
(Whiteboard, Application Sharing and Web
Tour), the Information menu, the Load Con-
tent button and the Record button.

Tab Tab
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Function Windows, etc. keys Mac keys

Move to the previous user interface ele-
ment (e.g., button, field, option) in a main
module (see example for Tab above)

Shift+Tab Shift-Tab

Activate the currently selected function Space Space

Enable tabbing in toolbars of secondary win-
dows (Closed Captioning, Notes, Activity Win-
dow, File Transfer)

Alt+F8 Option-F8

Move keyboard focus between open windows
(Notes, File Transfer, Activity, Closed-Cap-
tioning, Calculator)

Alt+F6
(Windows XP and Linux
only)

Command-`

Open Options menu of the panel or toolbar
in focus (Audio & Video, Chat, Participants,
Whiteboard action bar, Whiteboard navi-
gation bar or Web Tour)

Ctrl+Shift+O Command-Shift-O

Activity Window Functions

Open Activity Window Ctrl+/ Command-/

Close Activity Window Ctrl+/

Alt+F4

Ctrl+W

Command-W

Audio Functions

Press the Talk button

(Note: this is a Hot Key ─ see Hot Keys on
page 35.)

Ctrl+F2 Control+F2

Release the Talk button

(Note: this is a Hot Key ─ see Hot Keys on
page 35.)

Ctrl+F2 Control+F2

Adjust microphone level down Ctrl+Shift+Down Arrow Command-Shift-Down
Arrow

Adjust microphone level up Ctrl+Shift+Up Arrow Command-Shift-Up
Arrow

Adjust speaker level down Ctrl+Alt+Down Arrow Command-Option-
Down Arrow

Adjust speaker level up Ctrl+Alt+Up Arrow Command-Option-Up
Arrow
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Function Windows, etc. keys Mac keys

Video Functions

Start Video transmission
(Note: this is a Hot Key ─ see Hot Keys on
page 35.)

Ctrl+F3 Control-F3

Stop Video transmission
(Note: this is a Hot Key ─ see Hot Keys on
page 35.)

Ctrl+F3 Control-F3

Whiteboard Functions

Select all objects in Whiteboard Ctrl+A Command-A

Open Page Explorer window Ctrl+Shift+P Command-Shift-P

Open Object Explorer window Ctrl+Shift+T Command-Shift-T

Copy selected object(s) or text in Whiteboard Ctrl+C Command-C

Cut selected object(s) or text in Whiteboard Ctrl+X Command-X

Paste copied or cut object(s) or text to White-
board

Ctrl+V Command-V

Group selected objects Ctrl+G Command-G

Ungroup selected objects Ctrl+U Command-U

Delete selected object(s) or text in White-
board

Delete

Backspace

Delete

Backspace

Go to next page Alt+Page Down Option-Page Down

Go to previous page Alt+Page Up Option-Page Up

Move to first page at this topic level Alt+Home Option-Home

Move to last page at this topic level Alt+End Option-End

Application Sharing Functions

Take back control of Application Sharing
(Note: this is a Hot Key ─ see Hot Keys on
page 35.)

Ctrl+Space Control-Space

Stop Application Sharing
(Note: this is a Hot Key ─ see Hot Keys on
page 35.)

Ctrl+Shift+S Control-Shift-S

Chat Functions
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Function Windows, etc. keys Mac keys

Move cursor to the Message text box of the
Chat panel

Ctrl+M Command-M

Select all Chat text in conversation pane Ctrl+A Command-A

Copy selected Chat text in conversation pane Ctrl+C Command-C

Paste copied Chat text to Chat Message text
box, Whiteboard or external application

Ctrl+V Command-V

Participant Panel Functions

Raise or lower your hand Ctrl+R Command-R

Show that you have stepped away or come
back

Ctrl+Shift+A Command-Shift-A

Show smiley face Alt+1 Option-1

Show LOL Alt+2 Option-2

Show applause Alt+3 Option-3

Show confusion Alt+4 Option-4

Show approval Alt+5 Option-5

Show disapproval Alt+6 Option-6

Show Slower (when you want the presenter
to slow down)

Alt+7 Option-7

Show Faster (when you want the presenter
to speed up)

Alt+8 Option-8

Show None (when you want to clear all dis-
played emoticons)

Alt+0 Option-0

Notes Functions

Open Notes window Ctrl+E Command-E

Close Notes window Alt+F4

Ctrl+W

Command-W

Closed-Captioning Functions

Open Closed-Captioning window Ctrl+F8 Command-F8

Close Closed-Captioning window Alt+F4

Ctrl+W

Command-W
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Function Windows, etc. keys Mac keys

Polling Functions

Yes - polling response Ctrl+1 Command-1

No - polling response Ctrl+2 Command-2

A - polling response Ctrl+1 Command-1

B - polling response Ctrl+2 Command-2

C - polling response Ctrl+3 Command-3

D - polling response Ctrl+4 Command-4

E - polling response Ctrl+5 Command-5

None Ctrl+0 Command-0

Hot Keys

Hot keys differ from standard keyboard shortcuts keys in two ways:

n You can modify the definition of these keys.

n You do not need to have input focus on the Blackboard Collaborate Web Conferencing
window to use them (they are available system-wide).

By default, seven hot keys have been defined for the commonly used features in Blackboard Col-
laborate. You can use these default hot keys (listed in the table below) or define your own in the
Preferences dialog. For instructions, see Configuring Hot Keys on next page.

Num Lock and Caps Lock must be turned off for Hot Keys to work in a
Blackboard Collaborate Web Conferencing session running on Linux.

The default values for the two Talk hot keys are the same and the default values for the two
Video hot keys are the same. If you keep the default values for the Talk keys, you can use
Ctrl+F2 (Control-F2 on Mac) to toggle the Talk button on and off. If you keep the default values
for the Video keys, you can use Ctrl+F3 (Control-F3 on Mac) to start and stop Video.

The default hot keys are listed in the table below where the first column describes the function
to be performed, the second column lists the Windows and Linux hot key and the third column
gives the Mac hot key.
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Function Windows & Linux Key Mac Key

Press the Talk button Ctrl+F2 Control-F2

Release the Talk button Ctrl+F2 Control-F2

Take back control of Application Sharing Ctrl+Space Control-Space

Stop Application Sharing Ctrl+Shift+S Control-Shift+S

Start Video transmission Ctrl+F3 Control-F3

Stop Video transmission Ctrl+F3 Control-F3

Configuring Hot Keys

Exercise caution when changing the default definitions of hot keys. Ensure you do not change a
hot key definition to that of a hot key used by another application. You also should avoid key
combinations that conflict with standard keyboard shortcut operations.

Note: On Windows and Linux, the hot key is restricted to one character.
You may include one or more modifier keys (Shift, Control or ALT on
Windows).

Mac OS X users must include at least one modifier key in the keystroke:
⇧Shift, ^ Control,⌥ Option or ⌘ Command) .

Configure your hot keys in the Preferences dialog.

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, select Hot Keys under General. The Hot Keys
preferences panel appears.

Note: If you see an X under the Valid column, this indicates that
the hot key is not available. It is likely being used by another open
application. Either redefine the hot key to something valid or close
the other application.

3. From the Hot key preferences panel, select the hot key you wish to revise and clickMod-
ify…. The Edit Hot Key dialog opens.

4. Assign the keystrokes. Click on the down arrow to select a key from the key option list
and then select the desired modifier keys by clicking on their check boxes. For example,
the keystroke in the screen capture above is Ctrl+F2.

5. Click on OK to save the hot key configuration and close the Edit Hot Key dialog, or Can-
cel to close the Edit Hot Key dialog without saving your changes.
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6. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Getting Session Connection Information
You can get information about your session connection through the Information menu in the
Collaboration toolbar. (This menu also gives you access to the Timer dialog. See The Timer on
page 207.)

n Connection Speed: This the speed you set, either when you first joined the session or
later through the Session Connection preferences panel (see Setting Your Connection
Speed on page 11).

n Signal Strength: This represents the response time of the Blackboard Collaborate
server. The possible values are Excellent, Good, Fair, Low and — (which means Dis-
connected).

n Encryption: This indicates whether or not your communication with the Blackboard Col-
laborate server is encrypted. The possible values are SSL (which means encrypted) and —
(which means not encrypted).

n Session Time: This is the length of time that the session has been in progress, including
the time before you joined the session.

Closing the Application
To close the Blackboard Collaborate Web Conferencing application, do one of the following:
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o From the File menu, select Exit (Windows and Linux) or from the Blackboard Collaborate
Web Conferencing menu, select Quit (Mac OS X).

o Click on the window’s Close button.
o Enter Ctrl+Q (Command-Q on Mac)
o Enter Alt+F4 (Windows and Linux only)

By default, a confirmation dialog will prompt you to confirm whether or not you want to leave
the session. For instructions on how to hide this dialog in the future, see The Confirmation
Dialog.

Note: When you leave a session, you may be directed to a web page
defined by the session creator. Your default web browser will launch auto-
matically.

The Confirmation Dialog
By default, you will be prompted to confirm whether or not you want to leave the session. Click
on OK to leave the session or Cancel to stay in the session.

To turn this confirmation off for future sessions, select the option Don’t remind me again and
click on OK. You can turn the reminder back on for future session, using the Preferences
dialog:

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, select Leaving under Session. The Session Leav-
ing preferences panel appears.

3. Unselect the option Ask for confirmation before leaving a session.

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.
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Chapter 4

Page 41

The Participants Panel
The Participants panel provides you with information about yourself and others in the
session. You can view the user profiles of others and edit your own, see what features others are
currently using and see what permissions you and others have. The Participants panel also gives
you tools for interacting with others in the session: you can enter emoticons, raise your hand,
indicate that you have stepped away from the session, send a private Chat message and respond
to polls conducted by a Moderator.



The Participants panel has the following components:

1 Expand/Collapse button 7 Global options menu

2 Feedback menu 8 Status area

3 Step Away button 9 Toolbar

4 Raise Hand button 10 Activity indicators

5 Polling Response menu 11 Participant options menu

6 Participants list

Your name appears at the top of the Participants panel in the Status area as well as in the Par-
ticipants list below it. In both places you will see information about your permissions (see Under-
standing Permissions below), your current activity (see Status Indicators on page 50) and your
profile (see Editing Your User Profile on page 53). In the Participants list, all the Moderators in
the session are displayed in alphabetical order at the top of the list (above the horizontal rule),
followed by all the Participants, who are also listed in alphabetical order.

For information on working with panels, seeWorking with Panels on
page 24

Understanding Permissions
Your access to Blackboard Collaborate Web Conferencing features is managed by permissions.
Moderators can change your permissions, either by changing the global permissions (those that
apply to all Participants) or by changing your permissions only.
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For information on how permission information is presented in the Par-
ticipants panel, see Permission Indicators in the Participants List on next
page.

The table below shows the icons associated with each permission and describes what the per-
missions entail.

Icon Permissions

The Audio permission allows Participants to talk in the session.

If the permission is not granted, they can still listen to others.
The Video permission allows Participants to transmit video in the session.

If the permission is not granted, they can still preview their own video and view the
video transmissions of others.
The Chat permission allows Participants to enter chat messages in the session.

If the permission is not granted, they can still send private chat messages to Mod-
erators and read the Chat messages of others.
The Whiteboard permission allows Participants to use the drawing tools in the White-
board. It doesn't allow them to load content (e.g., presentations) into the White-
board, which requires Moderator privileges, nor to switch to Whiteboard mode from
another mode (see The Content Area Modes on page 22). Neither does it allow them
to navigate between pages in the Main room, which requires the Moderator to turn
off the Follow option (see The Follow Option).

If the permission is not granted, Participants can still view the Whiteboard content
entered by Moderators.
The Application Sharing permission allows Participants to host an Application Shar-
ing session, including switching to Application Sharing mode (see The Content Area
Modes on page 22) and back to the Whiteboard. It also enables them to request
remote control of anyone's Application Sharing session or the desktop of
Moderators or other Participants who also have the Application Sharing permission;
in both cases, the request can be denied by the host.

If the Application Sharing permission is not granted, Participants can still view
others' shared applications or desktops.
The Web Tour permission allows Participants to host Web Tours and Web Pushes,
including switching to Web Tour mode (see The Content Area Modes on page 22)
and back to the Whiteboard.

If the Web Tour permission is not granted, Participants can still view others' Web
Tours.
The Closed-Captioning permission allows Participants to enter text into the Closed-
Captioning window.

If this permission is not granted, Participants can still read the Closed-Captioning text
of others. (Note: this permission can be set only from the Participant option menu –
i.e, it cannot be set globally for all Participants.)
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Permission Indicators in the Participants List
Only those individual permissions (granted or revoked) that represent exceptions to the global
permissions are displayed in the Participants list.

You can view all your permissions – not just the exceptions – in your Par-
ticipants panel Status Area. See Viewing all of your Permissions on the
facing page.

When a Moderator removes your permission to use a globally permitted feature, the icon rep-
resenting that feature is stamped with a red X and appears next to your name in the Participants
list.

In the example below, the global permissions are set to the default (permission to use Audio,
Video, Chat and Whiteboard but not Application Sharing, Web Tour and Closed-Captioning) and
the exceptions to these are indicated by the icons in the Participants list.

n  The Moderator has granted Charlie the Closed-
Captioning permission and revoked his per-
mission to transmit video .

n Lucy has been granted the Application Sharing
permission.

n Ricky has been granted the Web Tour permission
and his Audio permission has been revoked: .
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Viewing all of your Permissions

If you would like to see a complete list of
all your permissions, not just the excep-
tions to the global permissions, select Show
My Permissions from the Global Options
menu of the Participants panel.

All the individual permissions (granted or revoked) that represent excep-
tions to the global permissions are still displayed in the Participants list.

Knowing When Someone has Joined or Left a Session
There are five ways to tell when someone has joined or left a session:

n The person’s name will appear in the Participants list when they join the session and will
be removed when they leave the session.

n An Audible Notification may be played when someone joins or leaves a session.

n A Visual Notification may be displayed when someone joins a session.

n A message will be displayed in the Chat conversation area.

n A message may be displayed in the Activity Window.

Tip: You can turn Audible and Visual Notifications on and off. For
details, see Setting Notification Preferences

Raising and Lowering Your Hand
Moderators and Participants can raise their hands at any time during the session. The Par-
ticipants list will indicate who has raised their hand and in what order. When a Participant
raises their hand, their name goes to the top of the participant list, just under the Moderators.
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There are two ways to raise your hand:

o Participants panel

Click the button.

o Keyboard shortcut

Enter Ctrl+R (Command-R on Mac).

There are three ways to lower your hand:

o Participants panel

Click the button.

o Participant Options menu

Select Lower Hand.
o Keyboard Shortcut

Enter Ctrl+R (Command-R on Mac).

Raised Hand Notification
Each time someone raises their hand, you may be notified in one or both of the following ways:

n A red hand icon will appear over the profile picture (or avatar) of
the person who raised their hand. A number will appear under
their name indicating where they are in the queue of those who
have raised their hands (the order in which hands were raised).

n An Audible Notification may be played. You can configure your
Audible Notification preferences to play one sound when you
raise your own hand and another when someone else raises
theirs – or you can turn the sound off altogether.

Tip: For details on turning your Audible
Notifications on and off, see Setting Notification
Preferences on page 16.

Stepping Away
The Step Away feature enables you to indicate to the others in the session that you are tem-
porarily unavailable. You are still connected to the session and can see and hear everything that
is going on – others just won't expect you to be available for interaction.
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There are three ways to show that you have stepped away:

o Click on the button in the Participants panel.

o From the Toolsmenu, select Interaction and then select Step Away.
o Enter Ctrl+Shift+A (Shift-Command-A on Mac).

The Step Away indicator (clock icon and the word "Away") will appear next to your name in the
Participants list for everyone to see. You will also see the indicator next to your name in the
Status area (top) of the Participants panel.

Stepping Back
There are three ways to show that you have stepped back into the session:

o Click on the button in the Participants panel.

o From the Toolsmenu, select Interaction and then unselect Step Away.
o Press Ctrl+Shift+A (Shift-Command-A on Mac).

The Step Away indicator will be removed from the Participants list so others will know you are
back in the session.

Entering Feedback
Moderators and Participants can select feedback options from the Feedback menu or via key-
board shortcuts. These options express common reactions to a presentation. An indicator asso-
ciated with each option appears for a short time to the right of the name of the person who
selected it.
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There are three ways to select one of the feedback options:

o Participants panel Feedback menu

Select the desired option.

o Interaction Sub-menu of Tools Menu

From the Toolsmenu, select Interaction followed by Show Emotion and select the
desired option from the submenu. This menu is identical to the menu in the Participants
panel.

o Keyboard Shortcuts

Enter the appropriate keyboard shortcut for the desired option.

Icon Emotion
Windows and Linux Keyboard
Shortcuts

Mac Keyboard Shortcuts

Show Smiley Face Alt+1 Option-1

Show LOL Alt+2 Option-2

Show Applause Alt+3 Option-3

Show Confusion Alt+4 Option-4

Show Approval Alt+5 Option-5

Show Disapproval Alt+6 Option-6

Show Slower (when
you want the pre-
senter to slow down)

Alt+7 Option-7

Show Faster (when
you want the pre-
senter to speed up)

Alt+8 Option-8

(blank
square)

Show None (clears all
displayed feedback
icons)

Alt+0 Option-0
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Activity Indicators
The Participants list presents information about user activity through activity indicators. These
indicators display information about what feature a user is currently using, show if a user is
using the Audio Setup Wizard or indicate if a user has stepped away from the session.

Alongside the activity indicators, you may see other icons in the Par-
ticipants list. There may be permission icons (see Understanding Per-
missions on page 42) or status indicators showing that users are
experiencing delays (see Status Indicators on next page

Activity
Indicator

Meaning

User has turned on his/her microphone. (Using VoIP for Audio.)

The Teleconference Bridge participant is connected and the telephone con-
ference is available to users.

User is using Telephony mode for audio communications. (Using the phone
for Audio.)

User is running the Audio Setup Wizard.

User is transmitting Video.

User is entering a Chat message.

User is entering content into the Whiteboard with one of the Whiteboard
drawing tools or, if the user is a Moderator, may be loading content into the
Whiteboard.

User is hosting an Application Sharing session.

User is conducting a Web Tour or Web Push.

User has stepped away from the session.
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In the example to the right,

n Charlie is entering a Chat message and is also using
the Audio Setup Wizard;

n Ethel has the Talk button pressed;

n Lucy is entering Closed-Captioning text;

n Ricky has stepped away from the session; and

n Vivian is transmitting Video.

Status Indicators
Status indicators appear in the Participants list when there
is a delay in the sending and/or receipt of Audio, Video and
Application Sharing data. An amber status indicator
denotes a moderate delay whereas a red status indicator
denotes a significant delay.

The status indicators are dynamic and are updated and visible throughout the session. By keep-
ing an eye on these indicators, you can see when it might be appropriate to adjust your pace
(e.g., temporarily stop talking, turn off your Video camera or pause your Application Sharing ses-
sion) so others can catch up.

In the Audio example to the right,

n Charlie is talking,

n Ricky is experiencing a moderate
delay in receiving Audio,

n Vivian is experiencing a significant
delay in receiving Audio, and

n Ethel is not having any problems
receiving Audio.

Note: For details about the various status indicators, refer to the chapters
on Application Sharing, Audio and Video.

Polling
A Moderator may ask you to participate in an poll. There are four poll types:

n Yes/No Options (the default)

n Multiple-Choice Responses A – C

50 The Participants Panel



n Multiple-Choice Responses A – D

n Multiple-Choice Responses A – E

People can respond to questions by selecting response options from the Polling Response menu
in the Participants panel or by entering keyboard shortcuts (listed in the table below).

When the Moderator selects a different type of poll, the available response buttons will change
accordingly.

Type of Poll
Response But-

tons

Windows and Linux Short-

cuts
Mac Shortcuts

Yes/No Yes: Ctrl+1

No: Ctrl+2

Yes: Command-1

No: Command-2

Multiple Choice with
three answer choices

A: Ctrl+1

B: Ctrl+2

C: Ctrl+3

A: Command-1

B: Command-2

C: Command-3

Multiple Choice with
four answer choices

A: Ctrl+1

B: Ctrl+2

C: Ctrl+3

D: Ctrl+4

A: Command-1

B: Command-2

C: Command-3

D: Command-4

Multiple Choice with five
answer choices

A: Ctrl+1

B: Ctrl+2

C: Ctrl+3

D: Ctrl+4

E: Ctrl+5

A: Command-1

B: Command-2

C: Command-3

D: Command-4

E: Command-5

None (clears all displayed
polling responses)

blank square Ctrl+0 Command-0
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Moderators can determine whether polling responses are visible to both Moderators and Par-
ticipants or Moderators only. For details about viewing the polling results, see If a Moderator
has enabled it, Participants can see the responses of others displayed next to their names in the
Participants list. Your own response is also shown in the button of the Polling Response menu.
below. 

If a Moderator has enabled it, Participants can see the responses of others displayed next to
their names in the Participants list. Your own response is also shown in the button of the Poll-
ing Response menu.

User Profiles
User Profiles are a means for users to publish information about themselves and to view infor-
mation provided by others.
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Viewing a User’s Profile
A user’s profile appears in a floating display beside the Participants list.

To view a user’s profile, hover your mouse over their name in the Participants list. The content
displayed in the user’s profile varies depending on how completely the user has filled in his or
her profile.

If a user does not have a profile, the display will simply contain the same name that is already
listed in the Participants list.

To dismiss the profile, click on it or move your cursor off of the Participants list.

Editing Your User Profile
Create or edit your Profile in the Preferences dialog.

Note: All fields in the My Profile preferences dialog are optional.

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)
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o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

2. (Skip this step if you selected Edit Profile from your Participants Option menu in the Par-
ticipants list.) In the left pane of the Preferences dialog, select the My Profile preferences
panel under Profile.

3. Enter your information in the desired fields under the Identity tab.

To insert a photo, click the Change button and browse to select your photo. To remove
the photo, click on the Clear button.

Tip: Only .gif and .jpg or .jpeg files can be used for your User
Profile photo. If your photo is larger than 96 x 96 pixels, it will be
automatically scaled to fit the available space.
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4. Click on the Contact tab and enter information in the desired fields.
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5. Click on the Addresses tab and enter information in the desired fields.

6. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings.

Importing a vCard file

Instead of creating a new user profile for a Blackboard Collaboratesession from scratch, you can
import an existing vCard (*.vcf file).

1. Open the My Profile preferences dialog box. (See steps 1 and 2 under Editing Your User
Profile.)

2. Click on the Import button. The Open dialog box will open.
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3. Navigate to the directory containing your vCard, select the .vcf file you wish to import and
then click on Open.

4. Click on OK to save your new profile and close the Preferences dialog, Apply to save your
new profile and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

Exporting a vCard file

You can export your Blackboard Collaborate profile as a .vcf file and import it into other appli-
cations (such as Outlook).

1. Open the My Profile preferences dialog box. (See steps 1 and 2 under Editing Your User
Profile.)

2. Click on the Export button. The Save dialog will open.

3. Navigate to the location in which you want to save the *.vcf file and then click on Save.

4. Click on OK to complete the export and close the Preferences dialog, Apply to complete
the export and leave the Preferences dialog open or Cancel to close the Preference dialog
without completing the export.

Printing the Participants List
You can print the current Participants list to review at a later time. The
printed list will have the session name as its header. The names in the list
will be appended by the session attendees’ roles.

1. Open the Print dialog by doing one of the following:
o From the File menu, select Print and then Participants List…
o Enter Ctrl+P (Command-P on Mac).

2. In the Print dialog, specify your preferences and click OK.

Saving the Participants List to a File
You can save the current Participants List to a text file to review at a later
time. The saved file will have the session name as its header. The names
in the list will be appended by the session attendees’ roles.

1. Open the Save Participants List dialog by doing one of the fol-
lowing:

o From the File menu, select Save and then Participants List… .
o Enter Ctrl+S (Command-S on Mac).
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2. Enter a file name and select the location to which you want to save the file.

3. Click Save. The suffix .txt is added to the filename.

Note: All Participants list files will be saved as text (.txt) files. There are
no other file types supported.

You can use Notepad, WordPad, Text Edit (OS X) or any word processing application to read the
text file.
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Chapter 5

Page 59

Video Broadcast
The Video feature of Blackboard Collaborate Web Conferencing enables you to transmit and
receive video broadcasts with others in a session. This is video you send live via a video camera
(e.g., web cam) – not to be confused with a pre-recorded video (movie) that Moderators can play
using the Multimedia feature.

The Video feature can display up to six simultaneous camera transmissions. For details, seeMul-
tiple Simultaneous Cameras on page 67

The Audio & Video window has the following Video components:



1 Expand/Collapse button 4 Preview Video button

2 Options menu 5 Transmit Video button

3 Primary video display

You will know someone is transmitting video (has their Transmit Video button turned on) when
the blue Video activity indicator ( ) appears next to their name in the Participants list. (For
details on activity indicators, see Video Activity, Permission and Status Indicators below). In
the example below, Vivian and Lisa are transmitting video.

If the Video button is disabled (grayed out) in your Audio & Video panel, it means you do not
have permission to use Video. You can always view another's video transmission, change your
video display, preview your own Video and set your camera preferences but you need the Video
permission in order to transmit. (For information on permissions, see Understanding Per-
missions on page 42.)

Video Activity, Permission and Status Indicators
You can monitor the state of Video activity and permissions through indicators displayed in the
Participants list of the Participants panel.

For details about permissions, see Understanding Permissions on page 42.

Activity and Permission Indicators
The table below describes the icons displayed in the Participant list to indicate Moderator and
Participant permissions and activity while using Video.

Activity
Indicator

Meaning

User has turned on his/her video camera.

Video permission is set globally to "on" but the Moderator has revoked
Video permission from this user.

Video permission is set globally to "off" but the Moderator has granted
Video permission to this user.
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Status Indicators
Status indicators appear on the Video activity indicator icons of Video users in the Participants
list if there are delays in the transmission or receipt of Video. When there are delays, the server
begins to drop frames. You will experience delays as a drop in video quality. The degree of delay
is indicated by color:

l Amber Indicator: Appears when a person's receipt or transmission of video is mod-
erately delayed.

l Red Indicator: Appears when a person's receipt or transmission of video is significantly
delayed.

Note: Video transmitters see status indicators for themselves and video
viewers. Video viewers see status indicators for video transmitters only –
not for themselves. (There is one exception: if using multiple cameras, a
person can be a viewer and transmitter at the same time, so “viewers” may
see status indicator for themselves – but only because they are also “trans-
mitters”.)

In the example to the right,

n Vivian is transmitting video,

n Lisa is experiencing a moderate delay in
receiving Video,

n Lucy is experiencing a significant delay in
receiving Video, and

n Charlie is not having any problems receiv-
ing Video.

Previewing and Transmitting Video
Before you transmit video to everyone in the session, it is a good idea to preview it first to check
the quality of the image. If it is not satisfactory, you may want to adjust your camera settings
(refer to the documentation for your camera) or change the Video Frame Rate (see Setting the
Video Frame Rate).

Tip: If your Video button is inaccessible (grayed out) it may be because a
Moderator has removed your Video permission or the maximum number
of simultaneous cameras has been reached.
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If your Audio & Video panel is in its collapsed state, it will automatically be
expanded when you preview or transmit video.

Previewing Video
To preview video, click on the Preview button. Notice that, when activated, your Preview button
turns blue. The images captured by your camera will be displayed in your primary video display,
along with the word "Preview". No one else will be able to see your preview.

Note: If you get an error when you click on the Preview button (such as
"Cannot connect to the video source"), your camera may be in use by
another application or you don't have the correct camera selected under
Preferences (see Selecting your Video Camera on the facing page).

Transmitting Video
To transmit video to everyone in the room, do one of the following:

o Click on the Transmit Video button in the Audio & Video panel.
o Enter the keyboard shortcut Ctrl+F3 (Command-F3 on Mac).

Tip: This keyboard shortcut is a "hot key", meaning you can redefine it.
You are actually able to configure two hot keys for the Video button: one
to turn it on and one to turn it off. For details, see Hot Keys on page 35.

Note: If you get an error when you click on the Video button (such as
"Cannot connect to the video source"), your camera may be in use by
another application or you don't have the correct camera selected under
Preferences (see Selecting your Video Camera on the facing page).

Notice that, when activated, your Video button displays a red camera.
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Stopping Video Transmission

To stop video transmission, turn your camera off in the same way you turned it on:

o Click on the Video button in the Audio & Video panel.
o Enter the keyboard shortcut Ctrl+F3 (Command-F3 on Mac).
o Click on the Preview button. You will continue to see video images, but others in the ses-
sion will not.

Tip:This keyboard shortcut is a "hot key", meaning you can redefine it.
You are actually able to configure two hot keys for the Video button: one
to turn it on and one to turn it off. For details, see Hot Keys on page 35.

Selecting your Video Camera
If you have only one video camera installed on your computer, that device is automatically used
by Blackboard Collaborate Web Conferencing to preview and transmit video. However, if you
have more than one video input device on your computer, you can select which device you want
to use through the Preferences dialog.

Note: When a connection is established to a video camera device, that
connection is maintained until a different device is connected or the ses-
sion is terminated. While a connection exists to a video device, that device
is not available for use by other applications.

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, select Camera Settings under Audio/Video.

3. Select the desired camera from the Select the camera to use drop-down list.

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Viewing Video
To view the video being transmitted by others, your primary video display must be open. If it is
collapsed, click on the Expand button to open it.
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Alternatively, if you want to preview your Video, click on the Preview
Video button to expand the panel. If you want to transmit Video, click on
the Video button to expand the panel.

If you do not wish to view another's video transmission, collapse the primary video display by
clicking on the Collapse button.

For information on working with panels, seeWorking with Panels on
page 24

In the primary video display, you may see either someone's profile picture (or default profile
icon) or Video transmission. The display will also show their name.

The Default Views
By default, the option Make Video Follow Speaker is turned on and the Moderator-only option,
Make Video Follow Moderator Focus, is turned off. These options affect what is shown in the
primary video display. (For information on these options and how to change what is presented
in the primary video display, see Controlling the Primary Video Display on page 67.)

If the default options are maintained (and you are not previewing your own video), the following
happens in the primary video display as people join the session, transmit video or speak:

n If you are the first person in the session, your primary video display will be blank. If you
click on the Transmit Video button, you will see your own transmission in the primary
video display.

n When a second person joins the session, you will see their video transmission or, if they
are not transmitting video, their profile picture. It is assumed you will want to look at that
person, not yourself, regardless of who is speaking. (This happens even if neither of you
has spoken.)

n As subsequent people transmit video or speak, their video transmissions or profile pictures
are added as thumbnails.

Note: There is one exception: if neither of the first two parties is
transmitting video, when a third person joins the session, the pri-
mary video display will go blank until someone transmits video or
speaks.
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n When someone speaks, your primary video display will always show either the profile pic-
ture or the video transmission of the person currently speaking or, if no one is speaking,
the last person to speak (even if that speaker has left the room).

When someone is transmitting video while you are previewing your own
video, the received video will be displayed in a thumbnail and the video
from your camera will be displayed in your primary video display.

In the example below, Lisa is speaking (she doesn't have her video camera turned on so you just
see her profile picture) and Vivian has her video camera turned on. Vivian's video is shown in a
thumbnail below the primary video display.

Hover your mouse over a thumbnail to display a "tool tip" containing the
transmitter’s name.

Tip: If you are having difficulty with your camera (e.g., it freezes), try
changing the frame rate. For details, see Setting the Video Frame Rate on
page 1.

If desired, you can display a box showing the frame rate of the transmission in the upper-left
corner of the primary video display. (To do so, see Setting the Video Frame Rate on page 1.) This
is useful for troubleshooting video (see Troubleshooting Video Delays).
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Multiple Simultaneous Cameras

Sessions can be enhanced by having the video streams of multiple people displayed at once.
Blackboard Collaborate Web Conferencing has the capacity to show the transmissions of up to
six video cameras simultaneously. Moderators can disable multiple simultaneous cameras (by set-
ting the maximum allowed to one) or enable from two to six simultaneous cameras.

When there is more than one simultaneous camera enabled, the video stream of one person will
appear in the primary video display. Everyone else's transmission will appear in thumbnails, up
to a maximum of five thumbnails

For a discussion of what you will see (by default) in the primary video display as more people
transmit video, see The Default Views on page 65. For a discussion of how you can change that
display, see Controlling the Primary Video Display below.

Multi-Camera Video in Recordings
If a session with multiple simultaneous cameras is recorded, the video from all cameras is saved
and, when playing the recording, you can choose who to show in your primary video display just
as you would if you attended the live session.

For instructions on changing your display, see Controlling the Primary Video Display below.

Controlling the Primary Video Display
The primary video display can be controlled in three ways:

n setting theMake Video Follow Moderator Focus option,

n setting theMake Video Follow Speaker option, and

n by manually selecting what to display.
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TheMake Video Follow Moderator Focus option is set by Moderators only and overrides an
individual'sMake Video Follow Speaker option. Both options override a person's ability to man-
ually select what video stream to show in the primary video display.

Note: When images change in the primary video display, they may be a
bit fuzzy for a few seconds while the server changes the resolution of the
new image from low (which is what is used for thumbnails) to a higher res-
olution (which is used in the primary display).

Make Video Follow Moderator Focus

Moderators can use theMake Video Follow Moderator Focus option to force everyone in the
room to see the same thing in their primary video display as what the Moderator is seeing in his
or her primary video display. This option overrides all other methods of controlling the primary
video display.

Make Video Follow Speaker

By default, the option to Make Video Follow Speaker is turned on. When it is turned on (and a
Moderator has not turned on Make Video Follow Moderator Focus), the primary video display
will always display either the profile picture or the video transmission (and the name) of the per-
son currently speaking or, if no one is speaking, the last person to speak (even if that person has
left the room). The Moderator option Make Video Follow Moderator Focus always overrides
this option.

If you want to manually select the image to be shown in the primary video display, turn off
Make Video Follow Speaker. You can do so in two ways (provided the Moderator doesn't have
Make Video Follow Moderator Focus turned on):

o From the Toolsmenu, select Video and then Make Video Follow Speaker.
o From the Audio & Video Options menu, selectMake Video Follow Speaker.

To turn the option back on, just repeat the process.

Manually Selecting What to Display

If Make Video Follow Moderator Focus andMake Video Follow Speaker are turned off, you
can manually control what is displayed in your primary video display. To move a thumbnail
image into the primary video display, simply click on the thumbnail.

The image that was originally in the primary display will move to the thumbnail in which the
moved image previously resided – the images swap places.
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Sending a Video Image to the Whiteboard
If you want to take a snapshot of an image in your primary video display, you can do so in one of
the following ways:

o From the Toolsmenu, select Video and then Send Camera Snapshot to Whiteboard.
o From the Audio & Video Options menu, select Send Camera Snapshot to Whiteboard.

The image you “snap” is placed in the foreground of the current page of the Whiteboard. You
can manipulate it like you would any other Whiteboard image.

The name of the person transmitting the video will not be captured in the snapshot and, if you
have the Display frame rate option selected in the Camera Setting preferences (see Setting the
Video Frame Rate on page 1), the frame rate box will not be captured in the image. If you take a
snapshot of your Preview view, the word "Preview" will be captured in the snapshot.

Note: For Participants to use this feature, they must have Whiteboard per-
missions.

Tip: If you want to take a snapshot of an image in a thumbnail
(simultaneous cameras), you must move the thumbnail image into the
primary video display and then take a snapshot. (For details, see
Controlling the Primary Video Display on page 67.)

Stopping Video Transmission
To stop transmitting video, do one of the following:
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o Click on the Video button in the Audio & Video panel.
o Enter the keyboard shortcut Ctrl+F3 (Command-F3 on Mac).

Tip: This keyboard shortcut is a "hot key", meaning you can
redefine it. You are actually able to configure two hot keys for the
Video button: one to turn it on and one to turn it off. For details,
see Hot Keys on page 35.

o Click on the Preview button. You will continue to see video images, but others in the ses-
sion will not.

To stop previewing video, click on the Preview button in the Audio & Video panel.
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Chapter 6

Page 71

The Chat Panel
The Chat panel enables you to exchange text messages with others in the session. It has the fol-
lowing components:

1 Expand/Collapse button 4 Options menu

2 Message text box 5 Conversation pane

3 Conversation tabs 6 Emoticon menu

You will know someone is entering a Chat message when the blue Chat activity indicator ( )
appears next to their name in the Participants list. In the example below, Ethel and Lisa are
entering Chat messages. (For details about activity indicators, see Chat Activity and Permission
Indicators on next page.)



If the message text box is not visible in your Chat panel, it means you do not have permission to
use Chat. You will, however, always be able to read Chat messages and send a message to a Mod-
erator. For instructions, follow the steps under Sending Messages to Selected Individuals on
page 75.

For information on working with panels, seeWorking with Panels on
page 24

Chat Activity and Permission Indicators
You can monitor the state of Chat activity and permissions through indicators displayed in the
Participants list of the Participants panel. These indicators are described in the table below.

For details about permissions, see Understanding Permissions on page 42.

Activity
Indicator

Meaning

User is typing a Chat message.

Chat permission is set globally to "on" but Moderator has revoked Chat per-
mission from this user.

Chat permission is set globally to "off" but Moderator has granted Chat per-
mission to this user.

Viewing Chat Messages
New Chat messages appear at the bottom of the conversation pane of the Chat panel. You can
scroll back and forth to read messages in the conversation pane.
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When a new message arrives,

n if the scroll thumb is at the bottom of the scroll bar (the last Chat message is visible), the
conversation pane will scroll as new messages are received; but

n if you had scrolled back to review earlier messages, the conversation pane will not scroll
when new messages are received – you must manually scroll to the bottom to see the new
message.

NewMessages in Other Conversation Tabs
If you are not in a conversation when a message arrives, you will see a New Message Indicator
(Chat bubble) in the tab of that conversation. Simply click on the tab to read your message. (For
details on conversation tabs, see Conversation Tabs below.)

Also, if you have the Chat Message Received audible notification turned on, you will hear a ding.

Tip: You can turn audible notifications off. For details, see Setting
Notification Preferences.

Conversation Tabs
When chatting in Blackboard Collaborate Web Conferencing, you can participate in more than
one conversation at a time. These conversations take place under conversation tabs. When a ses-
sion begins, there are no conversation tabs.

When a new private conversation is initiated (by you or by someone else with you), a new con-
versation tab is added to the bottom of the Chat panel for that conversation and a Room con-
versation tab added for the room you are in (main room or breakout room).

As more private chat conversations are initiated, more tabs are opened. When you run out of
space for more tabs, new conversation tabs are added to a list on the right side of the Chat panel.
Just click on the double arrow icon to open the list of hidden conversation tabs.
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Note that, when there is a new Chat message in a conversation (one in which you are currently
not participating), a New Message Indicator (Chat bubble) is displayed in its tab. In the example
above, there is a new message in the conversation with Lucy.

Moving Between Conversations

You can move freely between conversations simply by clicking on the conversation tabs. You will
be able to catch up on all the messages others entered while you were away.

Closing Conversation Tabs

To close a conversation tab, hover your mouse over the people/person icon in the tab until it
changes to an X. Click on the X to close the conversation tab.

Changing the Text Size in the Conversation Pane
You can set the font size of the text in the conversation pane anywhere from 7 points to 109
points, in increments of 2 points. The default value is 13 points, which may be influenced by
your system-wide font defaults.

To increase the font size, do one of the following

o From the Toolsmenu, select Chat and then Increase Font Size.
o From the Chat Options menu, select Increase Font Size.

To decrease the font size, do one of the following

o From the Toolsmenu, select Chat and then Decrease Font Size.
o From the Chat Options menu, select Decrease Font Size.

Sending Chat Messages
With Chat, you can send the following types of messages:

n public messages to everyone in your current room (main room or breakout room). For
details, see Sending Messages to Everyone in a Room or Existing Group Conversation on
the facing page
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n privatemessages to one or more selected individuals. This will initiate a new con-
versation in its own tab. For details, see Sending Messages to Selected Individuals below

Sending Messages to Everyone in a Room or Existing Group Conversation

1. If the desired room tab or existing group conversation tab is not in focus, move to it. (For
details, seeMoving Between Conversations on previous page.) Go directly to step 3 since
your cursor will already by in the message text field.

To start a new group conversation, see Sending Messages to
Selected Individuals below.

2. If it isn't already there, place your cursor in the message text field by doing one of the fol-
lowing:

o Click anywhere in the message text field.
o Press Ctrl+M (Command-M on Mac).

3. Enter your text in the message text field. (You can type it or copy and paste from an exter-
nal source.)

4. Press Enter to send your message. The message will appear in the conversation pane and,
if session attendees have the Chat Message Received audible notification turned on, they
will hear a ding.

Tip: You can turn audible notifications off. For details, see Setting
Notification Preferences.

Sending Messages to Selected Individuals
You can send private messages to a specific person or group of people by selecting their names in
the Participants list.

These messages will appear to only yourself and those you selected from the Participants list,
with one notable exception: when a session is supervised.

A note on Supervised sessions: Some sessions are supervised, meaning that Moderators
will be able to see the activity of everyone in the session. You will know a session is supervised
by the presence of the word "Supervised" in the title of the Chat panel.

When you are entering a "private" message, keep in mind that all Moderators can read it in
supervised sessions.
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1. Initiate the message in one of the following ways:
o (If sending to one person) Double-click on the name of the person in the Par-
ticipants list.

o (If sending to one person) Select the person's name in the Participants list and then
select Send a Private Chat from their Participant Option menu.

o (If sending to multiple people) Select the names of the people in the Participants list
(using the standard Shift or Control methods), right-click (Control-click on Mac) on
the highlighted names to open the Participants Option menu and then select Send a
Private Chat.

Do not click on the Participant Option menu of any
individual – that will unselect all the others you've selected in
the Participants list.

2. Enter your text in the message text field. (You can type it or copy and paste from an exter-
nal source.)

3. Press Enter to send your message.

A new conversation tab will open in the recipient's Chat panel, with a New Message Indi-
cator (Chat bubble) in the tab. The recipient will need to click on the new tab to read your
message.

Also, if the intended recipient has the Chat Message Received audible notification turned
on, they will hear a ding.

Tip: You can turn audible notifications off. For details, see Setting
Notification Preferences.

Adding Emoticons to your Chat Message
You can add emoticons to your Chat messages by selecting them from the Chat Emoticon menu
or by entering text strings in the Chat message text field. The text string equivalent of the emot-
icon selected in the Emoticon menu is displayed in the bottom left corner of the menu.
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The following table lists a few of the most popular emoticons and their respective text strings.

Emotions Icons Text strings

Smiley :) or :-)

Wink ;) or ;-)

Sad :( or :-(

Surprised :-o or :-O

Confused :/ or :-(

Grin :D or :-D

Angry :@ or :-@

Thumbs up (n)

Thumbs down (y)

Adding External Links to your Chat Message
You can include HTTP links in your Chat messages either by typing them in directly, copying
and pasting them or dragging and dropping them from a browser or email message. Recipients
of your messages will be able to click on the links to open web sites in their default browsers.

Link Type Syntax Example

HTTP web site http:// http://www.blackboard.com

Secure HTTP web site https:// https://addons.mozilla.org/
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Saving Chat Conversations to a File
You can save a Chat conversation to a text file to review at a later time. If you made the
date/time stamps visible, these will be saved to the text file as well.

1. Move to conversation you want to save. (For details, seeMoving Between Conversations
on page 74.)

2.  Open the Save Chat Conversation dialog by doing one of the following:
o From the File menu, select Save and then Chat Conversation….
o Enter Ctrl+S (Control-S on Mac). The Save dialog appears. Select Chat Conversation
and click on Save.

3. Enter a file name and select the location to which you want to save the file.

4. Click Save.

All Chat files are saved as text (.txt) files. There are no other file types supported. You can use
Notepad, WordPad or any word processing application to read the text file.

Note: You cannot load the file back into the Blackboard Collaborate
Web Conferencing Chat panel.
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Chapter 7

Page 79

The Audio Feature
The Audio feature enables you to participate in conversations during a Blackboard Collaborate
Web Conferencing session using a microphone and speakers (or headset) via Voice over Internet
Protocol (VoIP). If your organization offers teleconferencing services with Blackboard Col-
laborate, you can use the Telephony (telephone conferencing integration) feature for your in-ses-
sion communications. For details, see Chapter 8, “Telephone Conferencing”.

Audio shares a panel with Video in the Blackboard Collaborate interface. The panel has the fol-
lowing components relevant to Audio:



1 Expand/Collapse button 5 Options menu

2 Microphone Level indicator and slider 6 Primary video display

3 Talk button 7 Speaker Level indicator and slider

4 Audio Setup Wizard button

You will know someone has their microphone turned on (has activated the Talk button) when
the blue Audio activity indicator ( ) appears next to their name in the Participants list. (For
details on activity indicators, see Audio Activity, Permission and Status Indicators on page 80.)
In the example below, Vivian and Lisa have their microphones turned on.

You may see the Video transmission or the profile picture (or default profile icon) of the person
currently speaking in the primary Video display. The display will also show their name. Whether
or not you see this depends on the configuration of the Video display. For details, see Viewing
Video on page 64.

For information on working with panels, seeWorking with Panels on
page 24

If the Talk button is disabled (grayed out) in your Audio & Video panel, it means you do not have
permission to use Audio. You can always receive audio and adjust your microphone and speaker
levels, but you need the Audio permission in order to send audio. (For information on per-
missions, see Understanding Permissions on page 42.)

Audio Activity, Permission and Status Indicators
You can monitor the state of Audio activity and permissions through indicators displayed in the
Participants list of the Participants panel.

Activity and Permission Indicators
The table below describes the icons displayed in the Participant list to indicate Moderator and
Participant permissions and activity while using Audio or Telephony. (For details on Telephony,
see Chapter 8, “Telephone Conferencing”.)

For details about permissions, see Understanding Permissions on page 42.
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Activity
Indicator

Meaning

User has turned on his/her microphone. (Using VoIP for Audio.)

Audio permission is set globally to "on" but the Moderator has revoked
Audio permission from this user.

Audio permission is set globally to "off" but the Moderator has granted
Audio permission to this user.

User is running the Audio Setup Wizard.

The Teleconference Bridge participant is connected and the telephone con-
ference is available to users.

The Teleconference Bridge participant is connected but has had its Audio
permission removed and, therefore, the teleconference is muted.

User is using Telephony mode for audio communications. (Using the phone
for Audio.)

User is using Telephony mode for audio communications (using the phone
for Audio) but the teleconference is muted.

Status Indicators
Status indicators appear on the Audio activity indicator icons of Audio users in the Participants
list if there are delays in the receipt of Audio or if the talker or listener is not responding to the
Audio service.

Note: All Talkers see status indicators for all listeners, Moderator lis-
teners see status indicators for all listeners (including themselves) and Par-
ticipant listeners see status indicators for themselves only. There are no
status indicators shown next to Talkers. (There is one exception: if there
are multiple simultaneous talkers, a person can be a talker and listener at
the same time, so “talkers” may see status indicator for themselves – but
only because they are also “listeners”.)

n Amber Indicator: Appears when a listener's receipt of audio is delayed.

n Red Indicator: Appears when a talker or listener experiencing a significant delay (is
non-responsive) and may be offline from the session. This may indicate a problem with
the network connection and often will be followed by the user getting disconnected from
the session.
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In the example to the right,

n Charlie is talking,

n Ricky is experiencing a moderate delay in
receiving Audio,

n Vivian is experiencing a significant delay in
receiving Audio, and

n Ethel is not having any problems receiving
Audio.

Basic Audio Configuration
Generally speaking, it is recommended that you configure your Audio before the session begins.
There are a number of Audio settings that you can configure but you will likely only need to set
your microphone and speaker levels (see Using the Audio Setup Wizard on page 82).

The other available configuration items are advanced and, in most cases, you probably won’t
need to modify them. However, if you wish to modify the advanced Audio settings, you can do
so in the Preferences dialog. (For details, see Advanced Audio Configuration on page 87.)

Using the Audio Setup Wizard
To verify that your Audio is set up correctly, we recommend that you use the Audio Setup Wiz-
ard before the session begins. This wizard is comprised of a series of panels that guide you
through selecting Audio input (microphone) and output (speaker) devices and setting your
speaker and microphone volumes.

Tip: To run the Audio Setup Wizard before your session begins, either join your session early
or open the Configuration Room on the Blackboard Collaborate Support Portal:

http://support.blackboardcollaborate.com

To open the Configuration Room, browse to First Time Users and then to Step 2 under Black-
board Collaborate Web Conferencing.

You can run the Audio Setup Wizard again at any time within your session.

Note: When you are using the Audio Setup Wizard during a session, you
will not be able to hear any of the session Audio. Others will know you
can't hear them because the Audio Setup Wizard icon will appear next
to your name in the Participants list.
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To open the Audio Setup Wizard, do one of the following:

o Click on the Audio Setup Wizard button at the top of the Audio & Video panel.

o From the Toolsmenu select Audio and then Audio Setup Wizard.
o From the Audio & Video Options menu, select Audio Setup Wizard.

On Windows or Linux

1. Select your audio output device (speakers), following the instructions given in the dialog
box. (For further details on selecting an audio output device, see Selecting a Speaker
Device on page 92.)

2. Play the recorded audio message provided and adjust your speaker volume to a suitable
level. (Follow the instructions given in the dialog box.)

3. Confirm whether or not your speaker was set to an appropriate level.

n If you clicked on Yes, go to step 4.

n If you clicked on No, you are prompted to try again or cancel. Click on Try Again
to go back to step 1.

4. Select an audio input device (microphone), following the instructions given in the dialog
box. (For further details on selecting an audio input device, see Selecting a Microphone
Device on page 87.)

Note: Whichever microphone you select here will become the
selected microphone in the Microphone Settings Preferences
dialog.

5. Select your microphone type to get the best results when testing your microphone.

n Single Talker: Select this option if using a headset or a microphone just for your-
self.

n Multiple Talkers: Select this option if using a single microphone to pick up multiple
talkers, such as when you are in meeting room sharing the microphone with others.
This is the default.

6. Press Record and adjust your microphone recording level as you speak into the micro-
phone (audio input device). (Follow the instructions given in the dialog box.) Press Stop
when you are done.

7. Press Play to listen to the recording you just made and, based on the loudness and clarity
of the recording, determine if your microphone was set to an appropriate level.
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8. Confirm whether or not your microphone was set to an appropriate level.

n If you clicked on Yes, go to step 8.

n If you clicked on No, you are prompted to try again or cancel. Click on Try Again
to go back to step 4.

9. Read the message in the dialog box and click on OK to complete Audio setup and exit the
Audio Setup Wizard.

On Mac OS X

1. Mac users cannot change their audio output (speaker) devices directly in Blackboard Col-
laborate Web Conferencing – Blackboard Collaborate uses the system default device. To
change your output device, click on the speaker icon in the Select Audio Output Device
dialog of the Audio Setup Wizard and make your changes in the System Preferences
Sound Output panel. (For further details on selecting an audio output device, see Selecting
a Speaker Device on page 92) When done, click on OK to advance to the next panel of
the wizard.

2. Play the recorded audio message provided and adjust your speaker (audio output device)
volume to a suitable level. (Follow the instructions given in the dialog box.)

3. Confirm whether or not your speaker was set to an appropriate level.

n If you clicked on Yes, go to step 3.

n If you clicked on No, you are prompted to try again or cancel. Click on Try Again
to go back to step 1.

4. Select an audio input (microphone) device from the list or select the option Use System
Default Device. Follow the instructions given in the dialog box. (For further details on
selecting an audio input device, see Selecting a Microphone Device on page 87.)

5. Select your microphone type to get the best results when testing your microphone.

n Single Talker: Select this option if using a headset or a microphone just for your-
self.

n Multiple Talkers: Select this option if using a single microphone to pick up multiple
talkers, such as when you are in meeting room sharing the microphone with others.
This is the default.

Note: Whichever microphone you select here will become the
selected microphone under Microphone Settings Preferences
dialog.

6. Press Record and adjust your microphone recording level as you speak into the micro-
phone (audio input device). (Follow the instructions given in the dialog box.) Press Stop
when you are done.

7. Press Play to listen to the recording you just made and, based on the loudness and clarity
of the recording, determine if your microphone was set to an appropriate level.
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8. Confirm whether or not your microphone was set to an appropriate level.

n If you clicked on Yes, go to step 8.

n If you clicked on No, you are prompted to try again or cancel. Click on Try Again
to go back to step 3.

9. Read the message in the dialog box and click on OK to complete Audio setup and exit the
Audio Setup Wizard.

Using Your Microphone
You can turn on your microphone in one of two ways:

o Click on the Talk button in the Audio & Video panel.
o Enter the keyboard shortcut Ctrl+F2 (Command-F2 on Mac).

This keyboard shortcut is a "hot key", meaning you can redefine it. You
are actually able to configure two hot keys for the Talk button: one to turn
it on and one to turn it off. For details, see Hot Keys on page 35

To turn your microphone off, again click on the Talk button or use the keyboard shortcut.
Notice that, when activated, your Talk button displays a blue microphone.

You also may hear an audible notification when you activate or release your microphone.

Tip: You can turn audible notifications off. For details, see Setting
Notification Preferences.

Tip: If your Talk button is inaccessible (grayed out) it may be because a
Moderator has removed your Audio permission, the maximum number of
simultaneous talkers has been reached or you are using the Telephony
feature for audio communications.

Adjusting Microphone and Speaker Levels
The microphone level indicator (microphone icon) shows the volume levels when you are speak-
ing and the speaker level indicator (speaker icon) shows the volume levels when someone else is
speaking.
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Tip: If all talkers have their microphones set properly, listeners won’t
need to keep adjusting their speakers to accommodate changes in volume.
The best way to ensure proper microphone and speaker levels is to run
the Audio Setup Wizard at the beginning of the session. See Using the
Audio Setup Wizard on page 82.

Microphone Level
There are four ways to adjust your microphone level:

o Audio & Video panel: Grab the microphone level slider in the Audio & Video panel and
drag it to the right to increase the volume and to the left to decrease the volume.

o Options menu: From Audio & Video Options menu, select either Adjust Microphone
Level Up (to increase the volume) or Adjust Microphone Level Down (to decrease the vol-
ume).

o Tools menu: From the Toolsmenu, select Audio and then select either Adjust Micro-
phone Level Up (to increase the volume) or Adjust Microphone Level Down (to decrease
the volume).

o Keyboard Shortcuts: Enter Ctrl+Shift+Up Arrow (Shift-Command-Up Arrow on Mac)
to increase the volume or Ctrl+Shift+Down Arrow (Shift-Command-Down Arrow on Mac)
to decrease the volume.

Speaker Level
There are four ways to adjust your speaker level:

o Audio & Video panel: Grab the speaker level slider in the Audio & Video panel and
drag it to the right to increase the volume and to the left to decrease the volume.

o Options menu: From Audio & Video Options menu, select either Adjust Speaker Level
Up (to increase the volume) or Adjust Speaker Level Down (to decrease the volume).

o Tools menu: From the Toolsmenu, select Audio and then select either Adjust Speaker
Level Up (to increase the volume) or Adjust Microphone Speaker Down (to decrease the
volume).

o Keyboard Shortcuts: Enter Ctrl+Up Arrow (Command-Up Arrow on Mac) to increase
the volume or Ctrl+Down Arrow (Command-Down Arrow on Mac) to decrease the vol-
ume.
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Advanced Audio Configuration
In most cases, you probably won’t need to modify the advanced Audio configuration settings
(the default settings should be adequate). However, if you wish to modify them, you can do so in
the Preferences dialog.

For information on modifying the advanced Audio settings, refer to the following sections:

n Selecting a Microphone Device below

n Selecting a Speaker Device on page 92

n Setting Level Controls on page 91

n Suppressing Transmission of Silence on page 92

n Muting Speakers When Talking on page 96

n Setting the Sample Rate on page 92

Note: When you configure the Audio preferences, Blackboard Collaborate
Web Conferencing will remember these settings each time you join
another session.

Selecting a Microphone Device
The first time you use Blackboard Collaborate Web Conferencing, it will use the microphone
(audio input) device that is the system default at the time your session is launched. You can
select a different device through the Audio Setup Wizard or the Microphone Settings Pref-
erences dialog.

Tip: A headset with microphone works well for most Blackboard
Collaborate users as both their speaker device and microphone device.

Selecting a Microphone on Windows or Linux

You can change the microphone device in one of two places:

o Audio Setup Wizard (see Using the Audio Setup Wizard on page 82)
o Microphone Settings Preferences dialog (seeMicrophone Configuration on next page)

The device you select will be used in all future sessions (provided it is available when you launch
Blackboard Collaborate) until you explicitly select a different device. Changing your system
default microphone device will not affect which device Blackboard Collaborate will use.
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Tip: If you join a Blackboard Collaborate session when no microphone
device is connected, you don’t have to run the Audio Setup Wizard or use
the Microphone Settings Preferences dialog. Just connect your device
and, after the system recognizes the new device, click on the Talk button
– Blackboard Collaborate will automatically connect to the device. You
may need to adjust your microphone level.

Selecting a Microphone on Mac OS X

You can change the microphone device in one of two places:

o Audio Setup Wizard (see Using the Audio Setup Wizard on page 82)
o Microphone Settings Preferences dialog (seeMicrophone Configuration below)

You can make a change at any time during a session, except while you are talking. If you try to
select the input device from within Blackboard Collaborate when talking, you will get an error
message.

Tip: If you are talking, release the microphone, change the microphone
device and then re-engage the Talk button.

If you select the option Use System Default Device (selected by default), your Blackboard Col-
laborate input device will change every time you change your system default. You can change the
system default any time during a Blackboard Collaborate session under System Preferences,
Sound panel, Input tab.

If you do not select the option Use System Default Device, the device you select will be used in
all future sessions (provided it is available when you launch Blackboard Collaborate) until you
explicitly select a different device or select the option Use System Default Device.

Microphone Configuration
Set the microphone configuration preferences as follows.

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, selectMicrophone Settings under Audio/Video.
The Microphone Settings preferences panel appears.

Note: The available audio input line options will vary depending on
your sound card.

3. Select your Microphone device from the input devices listed in the box. For a complete dis-
cussion about microphone devices, see Selecting a Microphone Device on page 87.
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4. Select the desired options:

n (Mac only) Use System Default Device – Select this option if you want to use your
system's default input device. Each time you change the system default it will
change the microphone used by Blackboard Collaborate.

n Amplify quiet sounds from microphone dynamically – Select this option to enable
Audio to automatically increase the microphone signal level when the volume is too
low. By default, this option is enabled.

For further details, seeMicrophone Configuration on page 88.

n Adjust volume automatically to limit distortion – Select this option to enable Audio
to automatically reduce the microphone signal level when the signal peaks are exces-
sive (volume is too high). By default, this option is enabled.

For further details, seeMicrophone Configuration on page 88.

n To optimize the Adjust volume automatically to limit distortion control, select the
type of microphone you are using.

n Microphone used by a single person: Select this option if using a headset or a
microphone just for yourself.

n Microphone used by multiple people: Select this option if using a single micro-
phone to pick up multiple talkers. This is the default.

Note: The first time you open the Microphone Settings pref-
erences panel, it may appear thatMicrophone used by a sin-
gle person is the default. This will be the case if you earlier
selected Single Talker in the Audio Setup Wizard; the Micro-
phone Settings preferences panel inherits this setting from
the Audio Setup Wizard.

n Transmit all sounds, even when it appears to be silence – Select this option if you
want audio transmission to continue in times of silence. By default, this option is dis-
abled.

For further details, seeMicrophone Configuration on page 88.

n Microphone Sample Rate – Select a sample rate from the option menu if your
microphone is being shared with other applications.

For further details, seeMicrophone Configuration on page 88.

5. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.
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Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Setting Level Controls

During a session, a microphone may receive a wide range of signal levels – from very soft to very
loud. For example, the signal gets louder or softer as you move to or away from the microphone.
When sharing a microphone between a number of people in a room, not only will the signal
vary with the distance of each talker from the microphone but also will vary with the volume of
individual talkers.

For optimal clarity, sound must stay within a certain volume range. Within that range, if audio
signals are too weak (e.g., you are too far from the microphone or are talking very softly),
Amplify quiet sounds from microphone dynamically will automatically amplify the volume com-
ing from the microphone (without moving the volume slider). It provides a gain (increase in vol-
ume) of up to four times the signal level, which should be sufficient to handle most
circumstances. If it is insufficient, you should probably re-adjust your microphone level slider.

If the sound surpasses the optimal range (on either end), the Adjust volume automatically to
limit distortion option kicks in and brings the volume within the optimal range by adjusting the
microphone volume slider. If your microphone level is too high, causing distortion on loud sig-
nals, the Adjust volume automatically to limit distortion option will automatically slide the
microphone level slider to the left until the signal no longer distorts. If you have selectedMicro-
phone shared by multiple people rather than Microphone used by a single person, it also can
move the slider to the right to try to pick up quiet voices.

You can set the level controls Adjust volume automatically to limit distortion and Amplify quiet
sounds from microphone dynamically in the Preferences dialog. For details, see Setting Level
Controls on page 91.

When Not to Use Adjust volume automatically to limit distortion

The only time you may want to turn Adjust volume automatically to limit distortion
off is if you have a microphone so sensitive that Adjust volume automatically to limit
distortion is unable to fully control the signal and manual volume adjustment is required.

When Not to Use Amplify quiet sounds from microphone dynamically

If the ambient room noise is quite loud, Amplify quiet sounds from microphone dynamically
may raise the volume of the noise to a level that becomes bothersome to others. If this occurs,
turn this option off.
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Suppressing Transmission of Silence

When the Talk button is pressed, bandwidth is being used. Bandwidth usage increases with
every user that has the Talk button pressed. The more bandwidth that is used for Audio, the less
bandwidth will be available for the other features such as Application Sharing, playing of Mul-
timedia files, etc. Even if no one is talking while the Talk button is pressed, audio is still being
transmitted.

By default, Blackboard Collaborate Web Conferencing will detect when no one is talking and will
stop the transmission of audio (suppress the silence), thereby reducing the amount of bandwidth
used.

If your microphone does not generate a sufficiently strong signal, your speech may be erro-
neously detected as silence. If this is the case, silence suppression will cause your speech to cut
in and out. When this occurs, you should increase your microphone volume. If the volume is at
maximum, then you should enable Transmit all sounds, even when it appears to be silence. For
details, see Suppressing Transmission of Silence on page 92.

Note: When enabled, Transmit all sounds, even when it appears to be
silence does not become activated until there are at least three simul-
taneous talkers.

Setting the Sample Rate

Some systems that allow the microphone or speakers to be shared by multiple applications
require all applications to use the same audio sample rate.

If you have such a system, and you wish Blackboard Collaborate Web Conferencing to share the
microphone or speakers with another application (e.g., an email application that beeps when
you get new mail), you will need to set the Blackboard Collaborate preferred sample rate to the
other application’s sample rate – if the sample rates are different.

To set the sample rate for your microphone, see Setting the Sample Rate on page 92. To set the
sample rate for your speakers, see Speaker Configuration below.

Selecting a Speaker Device
The first time you use Blackboard Collaborate Web Conferencing, it will use the speaker (audio
output) device that is the system default at the time your session is launched.

If you are on a Windows or Linux system, you can select a different device through the Audio
Setup Wizard or the Speaker Settings Preferences dialog. If you are on Mac OS X, you can select
a different device by changing the system default.
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Tip: A headset with microphone works well for most Blackboard
Collaborate users as both their speaker device and microphone device.

Selecting Speakers on Windows or Linux

You can change the speaker device in one of two places:

o Audio Setup Wizard (see Using the Audio Setup Wizard on page 82)
o Speaker Settings Preferences dialog (see Speaker Configuration on next page)

The device you select will be used in all future sessions (provided it is available when you launch
Blackboard Collaborate Web Conferencing) until you explicitly select a different device. Chang-
ing your system default speaker device will not affect which device Blackboard Collaborate will
use.

Tip: If you join a Blackboard Collaborate session when no speaker device
is connected, you don’t have to the run the Audio Setup Wizard or use the
Speaker Settings Preferences dialog. Just connect your device and, after
the system recognizes the new device, Blackboard Collaborate will
automatically connect to it. You may need to adjust your speaker level.

Note: If you have been receiving audio before connecting your audio out-
put device, there will be a backlog of audio transmitted to you in an accel-
erated “chipmunk” form until the backlog is cleared. Depending on the
degree of backlog, you may be given the opportunity (through a con-
firmation dialog) to discard the backlog.

Selecting Speakers on Mac OS X

Blackboard Collaborate Web Conferencing uses the system’s current speaker device. To select a
different device, change the system default under System Preferences, Sound panel, Output tab.
Blackboard Collaborate will use that newly selected device the next time you join a session. You
can change your device while Blackboard Collaborate is running.

Tip: If sound is not being transmitted by your speaker, change to a
different device.
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Speaker Configuration
Set the speaker configuration preferences as follows.

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select Speaker Settings under Audio/Video. The
Speaker Settings preferences panel appears.

3. (Windows and Linux only) Select your Speaker device from the output devices listed in the
box. For a complete discussion about speaker devices, see Selecting a Speaker Device on
page 92.

Note: The available audio output device options will vary depending
on your sound card.
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4. (Mac only) Blackboard Collaborate uses your system's default output device. To change it,
click on the Speaker button to open your System Preferences Sound Output panel and
select your new device there. For a complete discussion about speaker devices, see Select-
ing a Speaker Device on page 92.

5. Set your Speaker options:

n Mute speakers when “Talk” pressed to prevent feedback – Select this option to
mute the speakers when you have the Talk button pressed. By default, this option is
disabled.

For further details, seeMuting Speakers When Talking on next page.

n Speaker Sample Rate – Select a sample rate from the option menu if your speakers
are being shared with other applications.

For further details, seeMicrophone Configuration on page 88.

For optimal performance, Mac users should set their speaker
sample rate to 8000 Hz.
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6. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Muting Speakers When Talking

If you are using a microphone and speakers rather than a headset, you may wish to mute the
speakers when you have the Talk button pressed so the microphone will not pick up any audio
feedback coming from the speakers. To mute your speakers, enable the preferenceMute speak-
ers when “Talk” is pressed to prevent feedback. For details, see Speaker Configuration on page
94.

Just be aware that, when this option is enabled and the Moderator has configured the Black-
board Collaborate session to allow Simultaneous Talkers, when you have your Talk button
pressed, you will not be able to hear others speak until you release your Talk button.

Note: Some systems do not allow the microphone and the speakers to be
active at the same time. In this case,Mute speakers when “Talk” is
pressed to prevent feedback will be enabled and you won’t be able to dis-
able it.

Troubleshooting Audio Delays
In general, when others are experiencing Audio delays, you can continue to talk. Blackboard Col-
laborate Web Conferencing will buffer the audio for those who have fallen behind and ensure
they are caught up to real-time. As they are catching up, they may hear the Audio in an accel-
erated “chipmunk” form until the backlog is cleared.

Depending on the degree of backlog, they may be given the opportunity
(through a confirmation dialog) to discard the backlog.
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Chapter 8

Page 97

Telephone Conferencing
The Telephony feature of Blackboard Collaborate Web Conferencing enables you to conduct
your audio communications with other session attendees via telephone conferencing, while con-
tinuing to use your computer for all other Blackboard Collaborate features. As a telephone con-
ference user, you will be fully integrated into the Blackboard Collaborate session: you can
communicate with users not connected via teleconference (the traditional microphone and
speaker users) and your communications will be captured in session recordings. (The visual ele-
ments of the Telephony user interface will not be visible in the recording.)

Note: Telephone conferencing is not available in Blackboard Collaborate
Web Conferencing vRoom™.

Note: You can use the Telephony (telephone conferencing integration)
feature for your in-session communications only if your organization
offers teleconferencing services with Blackboard Collaborate.

To incorporate a telephone conference into your Blackboard Collaborate session, a Blackboard
Collaborate Moderator needs to establish a bridge between the teleconference and the Black-
board Collaborate session by configuring teleconference connection information and connecting
the session to the teleconference. Although this bridge is not a person (it is software), it shows
up as a session attendee in the Participants List (as depicted below).



Any session attendee (Moderator or Participant) can join a teleconference, provided a Mod-
erator has set one up for the session. You will know you can join a teleconference by the pres-
ence of the Telephone icon in the title bar of the Audio & Video panel:

Activity Indicators
You can monitor the state of Audio and Telephony activity and permissions through indicators
displayed in the Participants list of the Participants panel.

The table below describes the icons displayed in the Participant list to indicate Moderator and
Participant permissions and activity while using Telephony or Audio. (For details on Audio, see
Basic Audio Configuration.)

For details about permissions, see Understanding Permissions on page 42.

Activity
Indicator

Meaning

User has turned on his/her microphone. (Using VoIP for Audio.)

The Teleconference Bridge participant is connected and the telephone con-
ference is available to users.

The Teleconference Bridge participant is connected but has had its Audio
permission removed and, therefore, the teleconference is muted.

User is using Telephony mode for audio communications. (Using the phone
for Audio.)

User is using Telephony mode for audio communications (using the phone
for Audio) but the teleconference is muted.
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Joining a Teleconference
Any session attendee (Moderators and Participants) can join a teleconference, provided a Mod-
erator has set one up for the session.

1. Open the Connect to Teleconference dialog in one of the following ways:
o From the Toolsmenu, select Audio and then Use Telephone for Audio.
o In the Audio & Video panel Options menu, select Use Telephone for Audio.
o Click on the Telephone icon in the title bar of the Audio & Video panel.

Note: You cannot start the connection process if you have
the Audio Talk button pressed. The Telephone icon in the
title bar will be disabled: .

2. Using your telephone, dial the teleconference telephone number displayed in the Connect
to Teleconference dialog.

3. Enter the teleconference PIN when prompted to do so by the teleconference (if required).

4. When you’ve successfully connected to the teleconference, click on OK in the Connect to
Teleconference dialog.

Note: To let people know they have successfully connected, the tel-
econference chairperson may choose to enable the teleconference service
announcement, which may be in the form of a recorded message or an
audio signature of some sort.

When you are connected to the teleconference, the word Teleconferencing... appears at the bot-
tom of your Audio & Video panel.
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You will also see the Teleconference activity indicator appear next to your name in the Par-
ticipants list.

Note: When you are using Telephony mode, your Talk button will be dis-
abled.

Leaving a Teleconference
To leave a teleconference and once again use your microphone and speakers for Audio, do the
following:

1. Open the Switch to Microphone and Speakers dialog in one of the following ways:
o From the Toolsmenu, select Audio and then Use Microphone & Speakers for
Audio.

o In the Audio & Video panel Options menu, select Use Microphone & Speakers for
Audio.

o Click on the Telephone icon in the title bar of the Audio & Video panel.
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2. Click OK to disconnect from the teleconference.

3. Hang up your phone.

When you are disconnected from the teleconference, the word Teleconferencing... is removed
from the bottom of your Audio & Video panel and the Teleconference activity indicator is
removed from next to your name in the Participants list.
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Chapter 9

Page 103

The Whiteboard
The Whiteboard is a type of content that, like Application Sharing and Web Tour, appears in the
Content area.

The Whiteboard is the main presentation area in the Blackboard Collaborate Web Conferencing
interface. If you have permission to use the Whiteboard drawing tools, the Tools palette appears
in the Whiteboard Content area.

The Whiteboard has the following components:



1 Whiteboard Action bar 6 Information menu

2 Collaboration toolbar 7 Whiteboard Page

3 Web Tour Mode button 8 Properties Editor palette

4 Scaling menu 9 Tools palette

5 Page name

When someone is loading content into the Whiteboard or using the Whiteboard tools, the blue
Whiteboard activity indicator ( ) appears next to their name in the Participants list. In the
example below, the Moderator Vivian is loading a presentation into the Whiteboard. (For details
on activity indicators, seeWhiteboard Activity, Permission and Status Indicators on the facing
page.)
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Whiteboard Activity, Permission and Status Indicators
You can monitor the state of Whiteboard activity and permissions through indicators displayed
in the Participants list of the Participants panel.

Activity and Permission Indicators
The table below describes the icons displayed in the Participant list to indicate Moderator and
Participant permissions and activity while using the Whiteboard.

Activity
Indicator

Meaning

User is loading content into the Whiteboard or using the Whiteboard tools.

Whiteboard permission is set globally to "on" but the Moderator has
revoked Whiteboard permission from this user.

Whiteboard permission is set globally to "off" but the Moderator has
granted Whiteboard permission to this user.

Adding Content to the Whiteboard
A number of different kinds of content can be added to the Whiteboard. Everyone in the session
can add objects using the Tools Palette (see The Tools Palette on page 107) and Moderators can
load image, PowerPoint, OpenOffice and Whiteboard files.

Copying Text and Images to or from Other Applications
Rich or plain text and images from other applications can be dragged and dropped or copied and
pasted into the Whiteboard. The following image formats are also supported: bmp, .gif, .jpg,
.jpeg and .png. Images can be selected in the external application and dragged/dropped or cop-
ied/pasted directly onto the Whiteboard, or you can drag/drop or copy/paste image files from
your file management system (e.g., Windows Explorer, Finder, etc.). You cannot drag/drop or
copy/paste text files.

Note: Other applications must provide the text or image in a suitable for-
mat – this cannot be controlled by Blackboard Collaborate Web Con-
ferencing Therefore, this feature is very application-specific.
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Tip: If you are unsuccessful with drag/drop, try copy/paste – and vice
versa.

Copying and Pasting

From another application to the Whiteboard: Copy the text or image in your third party appli-
cation (using its own copy function). The text or image will be placed in the clipboard. See Past-
ing Objects on page 124 for instructions on pasting the text or image into the Whiteboard.

You can copy and paste only one object at a time.

Note: Text will be placed in a Text Editor object – not a Simple Text
object.

Note: Images from web pages that have links associated with them may
not paste into the Whiteboard. Depending on your browser, the link may
be pasted as text instead.

From the Whiteboard to another application: You also can copy a text object or image in the
Whiteboard and paste it into another application. And, using the Page Explorer, you can copy an
entire Whiteboard page and paste into another application. The page will be inserted as a single
image into the other application.

Note: When copying or cutting a Simple Text object or Text Editor
object, Blackboard Collaborate Web Conferencing will place an image of
the cut or copied text in the system clipboard, not the text proper. For
Text Editor objects, to place the actual text in the clipboard, open the
object for editing and select the text to be copied. (This is not possible
with the Simple Text tool.)

Dragging and Dropping

From another application to the Whiteboard: Select the text or image in your third party appli-
cation (using its own selection function) or a graphics file in your file browser and drag it onto
the Whiteboard.

From the Whiteboard to another application: Open the Object Explorer and drag and drop one
or more objects to your third party application. You can also drag and drop an entire Whiteboard
page into another application by dragging the page from the Page Explorer (see Using the Page
Explorer). The page will be inserted as a single image into the other application.

Note: In the Main Room (public work area) of the Whiteboard, only Mod-
erators can drag and drop objects from the background.
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The Tools Palette
The Tools palette contains drawing and text tools you can use to create and manipulate objects
in the workspace. It also has options to place a screenshot or clip art from the included libraries.

Tools in the palette with a tabbed lower right corner have additional optional tools that can be
swapped into their spot. Click and hold the tool to expand the options.

Participants have access to the Whiteboard tools if they have been granted the Whiteboard tools
permission (see Understanding Permissions).

1 Selector tool 7 Line tool

2 Pointer tools 8 Screenshot tool

3 Pencil tool 9 Clip art tool

4 Text box tool 10 Highlighter tool

5 Filled shape tools 11 Simple text tool

6 Empty shape tools

The Properties Editor

When you click on any of the text or drawing tools in the Tools palette, the Properties Editor pal-
ette will appear at the bottom of the Whiteboard. From here you can format your text or graphic
by specifying various properties. The contents of the Properties Editor palette changes depend-
ing on which tool is being used or which objects are selected. For example, if you are using the
Filled Ellipse or Filled Rectangle tool, the Properties Editor will present color buttons only.
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The Properties Editor for the Simple Text and Text Editor tools contains buttons to set color,
font, size and style properties.

Note: If you select two different kinds of objects, the Properties Editor
Palette will display the attributes common to those objects.

Note:When changing the color on the Properties Editor, clicking outside
the color palette for the first time closes the palette. Click a second time to
start drawing.

Inserting Text

The Whiteboard has two text tools. The Simple Text tool creates text as an object directly on the
canvas. The text can be manipulated just like a shape or image in a graphic design program. The
Text Box tool creates a bounding box for text, and the text inside can be edited as in a word proc-
essor or publishing program.

Using the Simple Text Tool

Follow the steps below to enter a single line of text:

1. Click on the Simple Text tool.

If the Simple Text tool is not in the Tools Palette, click and hold the Text Box tool

until it expands to reveal the Simple Text tool icon, the click on the Simple Text tool.

2. Select the font name, color, size, bold, underline and/or italics from the Properties Editor.

3. Click the Whiteboard to place an insertion point, and then type the text.

4. Press Enter when you are done typing the line of text.

Note: The Simple Text Tool lets you type only one line of text at a time.
You cannot insert a line break and the text does not automatically wrap to
the next line when it reaches the edge of the Whiteboard page, as the Text
Editor does.
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Using the Text Editor Tool

Follow the steps below to enter multiple lines of wrapping text:

1. Click on the Text Box tool.

If the Text Box tool is not in the Tools Palette, click and hold the Simple Text tool

until it expands to reveal the Text Box tool icon, then click on the Text Box tool.

2. Single-click on the Whiteboard to create a text box of the default size (250 x 70 pixels).
Alternatively, click and hold down the mouse button as you drag the cursor to create a text
box of the desired size. Either way, the Properties Editor will appear at the bottom of the
Whiteboard.

3. Select the font name, color, size, bold, underline and/or italics from the Properties Editor.

4. Type your text, pressing Enter when you want to create a new line of text within the text
box.

Note: If the amount of text you type exceeds the space available in the
text box, a scroll bar will appear on the right side of the text box. If you
don’t want the scroll bar, resize the text box to display all the text.

Note: The maximum number of characters that can be entered in a Text
Editor object is 10,000.

Inserting External Links

You can insert links into Whiteboard text using either the Simple Text tool or the Text Editor
tool. Anyone viewing your Whiteboard page will be able to click on your links to access an Inter-
net site or send an email.

Note: To enter a link using the Simple Text tool, do not enter any text
except that contained in the link. If you do, the link will not work.

Link Type Syntax Example

HTTP web site http:// http://www.blackboardcollaborate.com

Secure HTTP web site https:// https://addons.mozilla.org/

FTP site ftp:// ftp://ftp.linuxfocus.org/

Email message mailto: mailto:docs@blackboard.com

109The Whiteboard

http://www.elluminate.com/
https://addons.mozilla.org/


Note: To launch a link, pass over the link with the Selection tool. The
pointer will change to a hand. Single click on the link with the hand
pointer. The application that opens the link will be specific to your sys-
tem.

Inserting Special Symbols and Characters (Windows only)

To type a special symbol or character on the Whiteboard, locate the ANSII numeric code for the
special symbols or character that you want to type (for a list of all available codes, see 1252 Win-
dows Latin 1 (ANSI)and follow these steps:

1. Select the Simple Text tool or Text Editor and click on the Whiteboard where you want to
insert the symbol or character.

2. Make sure NUM LOCK is on.

3. Hold down the Alt key and then, using the numeric keypad, type the numeric character
code for the character that you want to type. For example, to place the copyright symbol
on the Whiteboard hold down the Alt key and enter the numeric character code 0169.

Note: Some special characters only can be typed using Bold text. If
the character you want does not appear when you enter the char-
acter code, select the character you typed and choose Bold from the
Properties Editor.
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Inserting Graphics

Use the following tools to insert graphics into the Whiteboard:

Tool Options

Freehand Select the color, transparency, and line thickness from the
Properties Editor.

Line Select the color, transparency, and line thickness from the
Properties Editor.

Filled Shapes (rectangle

and ellipse)

Select the color and transparency from the Properties
Editor.

Empty Shapes (rectangle

and ellipse)

Select the color, transparency, and line thickness from the
Properties Editor.

Tip: Holding down the Shift key while drawing the line will result in a
horizontal, vertical or a line at a 45 degree angle depending on the
direction that you draw it. Holding down the Shift key while drawing an
ellipse will result in a circle. Holding down the Shift key while drawing a
rectangle will result in a square.

Inserting Clip Art Images

Clip art images can be loaded from a Clip Art library of presentation and mathematical symbols.
(Refer to Customizing Clip Art Collections on page 133 for details on the default clip art col-
lections and how to create your own clip art collection.)
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Follow the steps below to insert a clip art image on the Whiteboard:

1. Click on the Insert Clip Art button. The Clip Art dialog opens.

2. Select the tab that contains the clip art you wish to load.

3. Select (single-click on) the desired image.

Tip: As you hover your mouse over an image, a tool tip will provide
a description of the image.

4. Move your cursor to the desired position on the Whiteboard then click on the Whiteboard
to anchor the image into position.

Inserting Clip Art Images as Stamps

You can use clip art images as stamps, so you can repeatedly insert the same image over and
over. To do so, double-click on the desired image in the Clip Art dialog.

Your cursor will change to a stamp icon. Click on the Whiteboard in as may places as you
want to leave a stamp. The cursor will remain a stamp tool until you select a different clip
art image or use one of the Whiteboard drawing tools.

Inserting Screen Captures

The Screen Capture tool creates an image of a portion of your desktop, any application, or web
site and loads it into the Whiteboard.

Follow the steps below to capture a screen image:

1. Click on the Insert Screen Capture button. A transparent frame appears with four but-

tons in the middle.
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2. Click inside the frame and drag it into position on the screen so that the desired area is
completely enclosed by it. Click and drag the edges of the frame to resize it.

Switching between programs or performing certain other tasks under the frame may
cause the frame to stop updating. Click Refresh to manually update the frame if this
occurs.

3. Do one of the following:
o Select the option OK to capture exactly what is enclosed in the frame at that
moment.

o SelectWith Delay to add a ten second delay before the frame is captured. This
gives some time to position the cursor or other feature of the desktop that must be
maintained with the mouse in order to be captured.

o Select Cancel to close the frame without capturing an image.

4. The image appears on the Whiteboard. Position the image on the Whiteboard by dragging
it to a new location and click on the Whiteboard region to anchor it in position.

Setting Whiteboard Preferences
The Whiteboard Content Options preferences panel is used to set content loading options and
Whiteboard page size. To set the options, do the following:

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)
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From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select the Content Options preferences panel
underWhiteboard. This opens the Whiteboard Content Options preferences panel.

3. Set the following options as needed:

n Page Insertion Location: Select where you want newly loaded Whiteboard
content to be placed in relation to existing pages: after the current page,
before the current page or replace the current page.

Before you load content into the Whiteboard,
remember to move to the appropriate "current" page.
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n Page Size: You can size your pages for a specific monitor resolution or you
can specify the width and height in pixels.

l If you select Monitor Resolution, use the drop-down menu to choose
the appropriate resolution from the list. The default screen resolution is
1024 by 768 pixels.

l If you select Canvas Size, enter the Width and Height in the text boxes
provided.

Each of the Monitor Resolution options has a corresponding Canvas Size –
they are just two ways of expressing the same thing. These options can be
used interchangeably.

n Presentation Import Options: When selected, the Include Speaker Notes
option will place the presenter notes from your imported PowerPoint or Ope-
nOffice.org presentation into the Notes editor of all session attendees. For
details, see Viewing Presenter Notes Imported with a Presentation on
page 195.

n OpenOffice.org Application: The OpenOffice.org executable will be found
automatically on Mac and Windows systems if you select the option Use
default OpenOffice.org installation (this is the default). If you wish to use an
installation other than the default, unselect Use default OpenOffice.org instal-
lation and browse to the location of that installation.

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Manipulating Objects and Text
All objects on the Whiteboard are dynamic. The objects can be edited, moved, layered, re-sized,
and grouped.
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Using the Object Explorer
The Object Explorer allows you to easily take an inventory of objects and perform operations on
them. You can right-clicking (Control-click on Mac) on objects in the Object Explorer to open a
context menu and perform all of the same operations on an object that you can by opening the
context menu on that object on the Whiteboard canvas.

To open the Object Explorer, do one of the following:

o From the Toolsmenu, selectWhiteboard followed by Object Explorer…
o Right-click (Control-click on Mac) on the Whiteboard canvas to open the Whiteboard con-
text menu. In the menu, select Object Explorer…

o Type Ctrl+Shift+T (Shift-Command-T on Mac).

The Object Explorer window opens, displaying all of the objects on the current page. You can
resize and reposition this window as needed.

1 An image of the current page 5 An object on the Whiteboard created by a
Participant who has left the session

2 The page background 6 A group of objects

3 An object component of the background 7 A text object, labeled by its contents

4 An image imported to the Whiteboard 8 An object component of a group
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Objects are labeled with the icon of the tool used to create them and the name of their creator.
If the creator’s name appears in parentheses, that creator is still in the session. If the name
appears in <angle brackets>, the creator has left the session.

The objects are listed in the order that they appear on the Whiteboard. Objects at the bottom of
the list appear above objects at the top, and new objects are added to the bottom. Grouped
objects appear indented below an expandable Group sub-list. Backgrounds are a special type of
group that automatically drop behind other objects (go to the top of the list in the Object
Explorer). For more information on backgrounds, seeMoving Objects to the Background or
Foreground.

Clip Art and Screen Capture objects use the same icon as that of the
Image object:

Viewing Page Thumbnails

Pages in the Object Explorer can be displayed as either thumbnails of the page or as icons.

To view thumbnails, open the Toolsmenu and selectWhiteboard, then check Show Thumbnails
in Explorer Windows. To disable thumbnails, uncheck the option.

Note: The Show Thumbnails option affects not only the page viewed in
the Object Explorer but also the page(s) viewed in the Object Explorer and
the Select Page(s) dialog.

Selecting Objects
Select objects directly in the Whiteboard or in the Object Explorer.

Selecting Objects in the Object Explorer
Open the Object Explorer in one of the following ways.

o From the Toolsmenu, selectWhiteboard followed by Object Explorer…
o Right-click (Control-click on Mac) on the Whiteboard canvas to open the Whiteboard
context menu. In the menu, select Object Explorer…

o Type Ctrl+Shift+T (Shift-Command-T on Mac).

From within the Object Explorer, click on the objects you wish to select. Use Ctrl+Click (Con-
trol-Click on Mac) to select more than one object. Use shift+Click to select all objects between
two selected objects.
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Selecting One Object in the Whiteboard

To select a single object, select the Selection tool in the Tools Palette and click on the

object. The selected object will appear with a border around it.

Selecting More Than One Object in the Whiteboard

You can select several objects at the same time or add objects to an existing
selection. All objects must be on the same page.

To select more than one object, hold down the Shift key and use the Selection tool to click

on each object you wish to select. As each object is selected, a border will appear around it.

Selecting Several Objects Simultaneously in the Whiteboard

To select several objects simultaneously, use the Selection
tool to drag a selection area that touches a part of each

object. As each object is selected, a border will appear
around it.

Selecting All Objects in the Whiteboard or Object Explorer

To select all the objects, do one of the following:

o Right-click (Control-Click on Mac) anywhere on the Whiteboard. The Whiteboard context
menu appears. Select the option Select All Objects.

o Right-click (Control-Click on Mac) anywhere in the Object Explorer and select the option
Select All Objects from the context menu.

o Type Ctrl+A (Command-A on Mac).

Selecting All Objects Created by Participants

To select all objects created by selected Participant(s), do the following:

1. Select an object from the Participant or Participants on either the Whiteboard canvas or
in the Object Explorer.

If a Group is selected, the Participant will be the creator of the Group, not the creator of
the objects within the Group.

2. In the Toolsmenu, selectWhiteboard and then Select All Objects from Participant.
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Identifying the Creator of an Object

To identify the creator of a specific object, right-click (Control-Click on Mac) on the object to
bring up the Whiteboard context menu. The creator’s name appears at the top of the menu (in
gray). If you have selected more than one object created by different Participants, the creator
will be listed as “Multiple Creators.”

Selecting Simple Text and Text Editor Objects Containing Links

To select a Simple Text or Text Editor object that contains a link (see
Inserting External Links on page 109), hold down Shift or Control
(same on Mac) while using the Selection tool to click on the

object. The selected object will appear with a border around it.

You also can select a Text Editor object with a simple click, as long as you don’t click directly on
the link. Make sure your cursor is an arrow (not a hand) before you click.

Moving Objects
Move objects to other positions on the page with the mouse.

1. Select the object(s) you wish to move (See Selecting Objects.). In Windows, the cursor

changes to a 4-point arrow cursor ( ).

2. Hold the mouse button down and drag the object(s) to a new position on the page.

Restore Offscreen Objects

If you drag an object completely off the Whiteboard, you can retrieve it by opening the Tools
menu, selectingWhiteboard and then choosing Restore Offscreen Objects. The object will be
placed in the center of the Whiteboard.

If you dragged more than one object off the Whiteboard, you may have to separate the objects
once you have moved them back onto the Whiteboard. Refer to Using the Object Explorer on
page 116 to use the Object Explorer to separate these objects if you cannot select them manually.

Aligning and Distributing Objects
When multiple objects on the Whiteboard are selected, they can be aligned and distributed in var-
ious ways. This feature can be accessed from the Tools menu by selecting Whiteboard and then
Object Alignment.

Note: The order in which the objects are selected is important as the
first one is considered the anchor and all other objects will be aligned
according to the first.

To align and distribute objects open the Align Objects window or use the context menu.
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To use the Align Objects window,

1. Open the Align Objects window in one of the following
ways:

o Right-click (Control-click on the Mac) on the
Whiteboard canvas to open the context menu.
Select Align Objects, followed by Align Objects…

o In the Toolsmenu, selectWhiteboard, followed
by Align Objects…

2. Select the objects to be aligned or distributed.

3. Click an alignment option in the window. Refer to the
descriptions of each option below.

To use the menu,

1. Select the objects to be aligned or distributed.

2. Right-click (Control-click on a Mac) on the Whiteboard
canvas to open the context menu. Select Align Objects.

3. Choose one of the alignment options on the menu.
Refer to the descriptions of each option below.

Depending on your selection, only some of the options may be available.

Objects may be aligned with each other, or with the Whiteboard. Multiple selected objects will
be aligned using the first-selected object as the anchor. A single selected object will be aligned
using the Whiteboard as the anchor.

n Align Top Edges – aligns the tops of the selected objects to the top of the anchor.

n Align Vertical Centers – aligns the vertical center of the selected objects to the vertical
center of the Anchor.

n Align Bottom Edges – aligns the bottom of the selected objects to the bottom of the
anchor.

n Align Left Edges – aligns the left edges of the selected objects to the left edge of the
anchor.

n Align Horizontal Centers – aligns the horizontal center of the selected objects to the hor-
izontal center of the anchor.

n Align Right Edges – aligns the right edges of the selected objects to the right edge of the
anchor.

Distribution requires three or more objects to be selected. If less than three objects are selected,
the Distribute panel options will be grayed out and will not be accessible. The first-selected and
the last-selected objects are used as anchors and the remaining objects will be distributed
between the two anchors in the order selected
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n Distribute Vertical Centers – distributes the objects between the anchors so that the
centers of the objects are all evenly spaced.

n Distribute Vertical Spacing – distributes the objects between the anchors so that the
edge-to-edge spacing between the objects is the same.

n Distribute Horizontal Centers – distributes the objects between the anchors so that the
centers of the objects are all evenly spaced.

n Distribute Horizontal Spacing – distributes the objects between the anchors so that the
edge-to-edge spacing between the objects is the same.

Resizing Objects
You can resize a single object, multiple objects and grouped objects.

1. Select the object(s) you wish to resize. (See Using the Object Explorer.)

2. Place the cursor over the object’s border or corner. The cursor will change to an arrow
shape.

3. Hold the mouse button down while you drag the edge or corner of the object. When resiz-
ing multiple objects, they will all be resized proportionally.

To keep the same proportions when resizing, click and drag a corner of the object or group
while holding shift. Release the mouse button before releasing the shift key.

Note: Text inside cannot be resized by dragging a corner. Instead, you
can resize it by selecting it and changing the font properties. (See Chang-
ing Properties of Text Objects on page 127.)

Grouping and Ungrouping Objects
Grouped objects retain their size and position relative to each other. The entire group can be
resized, moved around the Whiteboard, or moved forward or backward as a layer.

To group objects, perform the following Steps:
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1. Select the objects on either the Whiteboard or in the Object Explorer (see Selecting
Objects on page 117).

2. Do one of the following:
o Right-click (Control-click on a Mac) on a selected object on the Whiteboard or in
the Object Explorer to open the context menu. Select Group Objects.

o Type Ctrl+G (Command-G on a Mac).

A dashed box will appear, containing all of the grouped objects. The group can be selected by
clicking on any of the contained objects with the Selection tool .

To ungroup one or more groups of objects

1. Select the objects on either the Whiteboard or in the Object Explorer.

2. Do one of the following:
o Right-click (Control-click on a Mac) on a selected object on the Whiteboard or in
the Object Explorer to open the context menu. Select Ungroup Object Groups.

o Type Ctrl+U (Command-U on a Mac).

Adding or Removing Objects from a Group

Add or remove objects to or from a group using the Object Explorer (see Using the Object
Explorer on page 116). To do so, select the object(s) in the Object Explorer and drag it to the
desired position.

Tip: Removing an object from a group is easier if you drop it above the group, rather than below
it. To place the removed object in front of the group, drag it above the group and then hide the
object components by clicking the black arrow , and drag the group above the object.

Moving Objects to the Front/Back
All objects placed on the Whiteboard are layered and hence can be moved forward or backward
in relationship to each other. They also can be moved directly to the front or back of all other
objects.

Note: Moving objects forwards and backwards is not the same as moving
objects to the background or foreground. All objects you move forwards
or backwards reside in the foreground. You cannot move objects in the
background.

1. Open the Whiteboard context menu by doing one of the following:
o Select the object(s) to be moved in the Whiteboard and then right-click (Control-
Click on Mac) anywhere on the Whiteboard.
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o Right-click (Control-Click on Mac) on the objects to be moved in the Object
Explorer.

2. Select one of the following options:

Move to Front — moves the selected object(s) directly to the front of the White-
board

Move Forward— moves the selected object(s) one layer closer to the front.

Move Backward— moves the selected object(s) one layer closer to the back.

Move to Back — moves the selected object(s) directly to the back of the White-
board.

Cutting, Copying and Pasting Objects in the Whiteboard
Cutting removes the selected objects from the Whiteboard and places them on the clipboard.
Copying retains the selected objects in the Whiteboard and places them in the clipboard. The
clipboard is overwritten whenever you copy or cut another object.

Once an object is cut or copied, you can paste it from the clipboard to the same or a different
Whiteboard page. The last object(s) placed in the clipboard will be the object(s) pasted.

Note: An object can be pasted multiple times. Each paste will be layered
on top of the last.

Copying and Cutting Objects

To copy or cut an object, do one of the following:

o

o Select the object(s) on the Whiteboard or Object Explorer and then right-click (Control-
Click on Mac) on a selected object. The Whiteboard context menu appears. Select either
Copy or Cut.
Select the object(s) in the Whiteboard or in the Object Explorer and then type:

Copy: Ctrl+C (Command-C on Mac)

Cut: Ctrl+X (Command-X on Mac)

Note: Participants can cut only their own objects. Moderators can cut
anyone’s objects.
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Pasting Objects

To paste an object from the clipboard, do one of the following:

o Right-click (Control-Click on Mac) anywhere on the Whiteboard or Object Explorer. The
Whiteboard context menu appears. Select Paste.

o Click anywhere on the Whiteboard or Object Explorer and then type Ctrl+V (Command-V
on Mac).

Use the Selection tool to reposition the objects on the Whiteboard, if desired.

Note: Rich or plain text and images from other applications can be pasted
into the Whiteboard. The following image formats are supported: bmp,
.gif, .jpg, .jpeg and .png. See Loading External Content into the White-
board .

Duplicating Whiteboard Objects by Dragging and Dropping

You can copy a Whiteboard object in a single step by dragging and dropping the object to a new
position within the Object Explorer while holding the Control key (Command on a Mac).
Release the mouse before releasing the Control (or Command) key. On Windows, a plus symbol
(+) appears overlaying the mouse when an object will be duplicated instead of moved.

Editing Text
You can edit text in both Simple Text and Text Editor objects, however editing of Simple Text
objects is very limited.

For information on formatting the text, see Changing Properties of Text Objects on page 127.

Text Editor Objects

To put the object in editing mode, select the object and then double-click on the text box.

You can use most standard text editing mouse actions within the text, such as double-clicking to
select a word and dragging to select text. The following standard text editing keyboard shortcuts
can be used to perform functions within the text of individual notes.
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Function Windows & Linux Shortcuts Mac OS X Shortcuts

Select all text in current text box Ctrl+A Command-A

Copy selected text Ctrl+C Command-C

Cut selected text Ctrl+X Command-X

Paste copied text Ctrl+V Command-V

Delete selected text Delete, Backspace Delete

Simple Text Objects

Select the object and then double-click on the text box. To edit a Simple Text object that con-
tains a link (see Inserting External Links), hold down the Control (Command on Mac) key
while double-clicking on the text box.

Editing Object Properties
Whether you are working with a single object, multiple objects or a grouped object, an object’s
properties, including line width, line color and transparency, line style, line cap style, fill color
and transparency, and font can be changed.

Use the Selection tool to select the object(s). The Properties Editor appears, containing a set

of options for that object. If multiple objects are selected, the properties editor contains only
those options that apply to all of the objects. See The Properties Editor on page 107

A few object properties can only be edited in the Object Properties window. The properties for
each object type that can only be edited by opening the Edit Object window are listed in the fol-
lowing table:
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Object Type Properties

Freehand tools n Select rounded or flat line caps.

n Select broken or solid line.

Text tools n None

Filled shapes n None

Empty shapes n Select rounded or flat caps (for broken strokes).

n Select broken or solid strokes.

n Select a fill color.

n Select fill transparency.

Line tool n Select rounded or flat caps.

n Select broken or solid line.

Images and Clipart n Select a stroke width.

n Select a cap style (for broken strokes).

n Select solid or broken strokes.

n Select transparency (applies to both stroke and image).

n Select stroke color.

n Select show or hide strokes.

To edit an object's properties in the Object Properties window, do the following:

1. Open the Object Properties window in one of the two following ways:
o Right-click (Control-Click on Mac) anywhere on the Whiteboard or Object Explorer.
The Whiteboard context menu appears. Select the option Object Properties…

o From the Toolsmenu, selectWhiteboard, followed by Object Properties.

2. Select an object or objects on the Whiteboard or in the Object Explorer.

3. Edit the desired options.

4. Click OK to make the chosen edits to the Object(s) and close the Object Properties win-
dow.

Click Apply to make the chosen edits and leave the Object Properties window open.

Click Cancel to close the Object Properties window without making any changes. To can-
cel the changes without closing the window, simply deselect the object(s).

Within the Object Properties dialog box, you can change an object’s properties.
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The Object Properties window contains tabs related to
each type of content that can be edited directly on the
Whiteboard: Shape, Text, Filled Shape, and Image.
Depending on the object selected, some of the tabs will
be available and others will be grayed out. Click on the
tab for the object you wish to update. The details of
each tab are explained below.

Changing Properties of a Shape

Freehand shapes , empty shapes , and

lines , are edited in the Shapes tab. You can change

the line properties (width, cap style, line style and line
color and transparency) of all these shapes and the fill
color and transparency of the Ellipses and Rectangle
shapes.

If the selection consists of more than one shape, each
shape will acquire the settings selected in the dialog box.

Changing Properties of Text Objects

You can change the color and transparency and font properties for all text in a simple text shape
or for selected text in a text box.

Note: Text formatting will not be retained if you copy and paste for-
matted text within the same text box, from one text box to another or into
an external application (e.g., Notepad or Word).

Changing Properties of a Filled Shape

You can change the fill color and transparency for any shape.

If the selection consisted of more than one filled shape, each filled shape will acquire the set-
tings selected in the dialog box.

Changing Properties of an Image or Clipart

You can change the image frame style, and the transparency for any image.

If the selection consisted of more than one image, each image will acquire the settings selected
in the dialog box.

Deleting Objects
To delete an object from the Whiteboard, do one of the following:
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o Select the object(s) in the Whiteboard or Object Explorer and press the Delete key.
o Select the object(s) on the Whiteboard or Object Explorer and then right-click (Control-
Click on Mac) anywhere on the Whiteboard or Object Explorer. The Whiteboard context
menu appears. Select Delete.

Deletion is permanent and cannot be undone or restored.

Note: Participants cannot delete objects created by others – only their
own. Moderators can delete all objects.

Working with Whiteboard Pages
As a Participant, you can navigate between pages in a Breakout Room and save and print pages
in Breakout Rooms or the Main Room.

Navigating Between Pages

n To move to the next page, do one of the following:
o Click the Next Page button .

o Enter Alt + Page Down (Option-Page Down on Mac).

n To move to the previous page, do one of the following:
o Click the Previous Page button .

o Enter Alt + Page Up (Option-Page Up on Mac) .

Navigating Between Pages
To navigate between pages, you can use the Whiteboard navigation bar, the Page Explorer (see
Using the Explore Pages Window), or the Page Up and Page Down keys on your keyboard.

Note: You can freely navigate between pages in breakout rooms but must
be given permission by the Moderator to navigate between pages of the
Main room. You will know you are free to move between Main room
pages when you see a red border around your Whiteboard content area.

n To move to the next page:
o In the Whiteboard Navigation bar or Page Explorer, click the Next Page button .
o In the Toolsmenu, selectWhiteboard followed by Go to Next Page.
o Type Alt + Page Down (Option-Page Down on Mac) .
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o If focus is on the Go to Page menu of the Navigation bar, press the Down Arrow.
o Double-click on the desired page in the Page Explorer.

n To move to the previous page:

l In the Whiteboard Navigation bar or Page Explorer, click the Previous Page button
.

o In the Toolsmenu, selectWhiteboard followed by Go to Previous Page.
o Type Alt + Page Up (Option-Page Up on Mac).
o If focus is on the Go to Page menu of the Navigation bar, press the Up Arrow.
o Double-click on the desired page in the Page Explorer.

Using the Whiteboard Navigation Bar

The Whiteboard navigation bar allows you to move within a page Group, to a new page Group or
to your private work area.

The Whiteboard Navigation bar is located in the upper right corner of the Content area when-
ever the Page Explorer is not open.

1 Previous Page button 3 Go to Page menu

2 Next Page button 6 Navigation Options menu

When the Page Explorer is open, the Navigation bar is located at the top of the Page Explorer
window.

n Use the Previous Page and Next Page buttons to move within the current page Group. The
navigation buttons allow you to navigate only through the current page Group. Use the Go
to Page Menu or the Page Explorer to go to a different page Group.

n Use the Go to Page menu to select and move to a particular page. When you move to a pri-
vate page or a page belonging to a different room, or have Explore Mode activated, other
Participants will remain on their current page.

n The Navigation Options menu contains a menu item to open the page Explorer. For more
information, see Using the Explore Pages Window.
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Editing Page Properties
You can edit the properties of your current page in the Edit Page Properties dialog box.

Note: You cannot edit properties of pages within the Main Room (public
work area) – only those in your own private work area. However, you can
view page properties of pages in the public work area.

To open the Edit Page Properties dialog box, do one of the following:

o In the Whiteboard, navigate to the page you wish to edit and right-click (Control-Click on
Mac) anywhere on the Whiteboard. From the context menu, select Selected Page(s) and
then choose Current Page Properties.

o In the Whiteboard, navigate to the page you wish to edit. From the Tools menu, select
Whiteboard and then choose Current Page Properties…

o From the Tools menu, select Whiteboard >Explore Pages… or press Ctrl+Shift+S (Shift-
Command-S on Mac). The Page Explorer appears. Select the page(s) you wish to edit and
then right-click (Control-Click on Mac) on the selected page. The context menu appears.
Select Selected Page(s) > Current Page Properties…

From the Page Properties dialog box you are able to change the following:

n The preferred Page Size for a specific monitor resolution or you can specify the width and
height in pixels.

n Edit the name of each page by double-clicking on the text box in the Page Name column
and editing it.
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Selecting All Page Peers
The command Select All Page Peers will select all the pages in that Group or Room. Once
selected, operations can be performed on all of the pages at once. This is different from merely
selecting the Group, because the pages will not be moved, cut, or pasted as part of a Group, and
operations performed on the pages will not affect the Group.

1. Select a page or pages in the Page Explorer and then right-click (Control-Click on Mac) on
a selected page. The context menu appears.

2. Select Selected Pages and then select the command Select All Page Peers.

In the Page Explorer, all page peers are highlighted.

Saving Whiteboard Pages
You can save the Whiteboard pages in Blackboard Collaborate Web Conferencing in the fol-
lowing formats:

l WBD File – When Whiteboard pages are saved as a Whiteboard file (.wbd), they are
saved as one file that can only be imported and reviewed in a Blackboard Collaborate ses-
sion.

l WBP File – When Whiteboard pages are saved as a Protected Whiteboard file (.wbp),
they are saved as one file that can only be imported and reviewed in a Blackboard Col-
laborate session. These files are protected and cannot be printed, saved, or edited unless
the Moderator removes the protection flag by selecting Tools, then Whiteboard, and de-
selecting the command Protect Whiteboard.

l PDF File – When Whiteboard pages are saved as a PDF file (.pdf), they are saved as one
file and can be reviewed outside of the Blackboard Collaborate environment.

l PNG File – When Whiteboard pages are saved as Image files (.png), they are saved as sep-
arate images and can be loaded individually onto the Whiteboard as images or used in any
other image processing application.

To save Whiteboard pages, do the following:

1. Open the Save Whiteboard dialog by doing one of the following:
o From the File menu, select Save followed byWhiteboard…
o In the Page Explorer, select the page(s) and/or Group(s) you wish to save and then
right-click (Control-Click on Mac) on the selected page. The context menu appears.
Select Save…

o Type Ctrl+S (Command-S on Mac). The Save dialog appears. Select Whiteboard and
click on Save.
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2. The Select Pages dialog box appears. Choose
whether you want to save All Pages in the
Current Group, only the Current Page or
Selected Pages. If you choose Selected
Pages, a list of pages in the Whiteboard
appears. Select the page(s) you wish to save.
Use Shift or Control (same on Mac) to
select multiple pages. Then click OK.

3. From the Save Whiteboard dialog box, navi-
gate to and open the file folder in which you
want to save the Whiteboard.

4. Type a file name in the File name text box.

5. Scroll through the Files of type drop-down
menu and choose the file format.

6. Click Save to save the file and close the
Save Whiteboard dialog box.

Printing Whiteboard Pages
You can print individual pages, multiple selected
pages and page Groups.

1. Open the Select Pages dialog by doing one
of the following:

o From the File menu, select Print and then chooseWhiteboard…
o Enter Ctrl+P (Command-P on Mac). The Print dialog appears. Select Whiteboard
and click on Print.

2. The Select Pages dialog box opens. Choose whether you want to print All Pages in the
current page Group, only the Current Page or Selected Pages. If you choose Selected
Pages, you will then see a list of all the pages available to you in the current session. Select
the desired page(s) from the list. Use Shift or Control (same on Mac) to select multiple
pages. Then click OK.

3. The Page Set-up dialog box opens. Specify your preferences and click OK.

Note: If the Whiteboard is protected, no one, including the Moderator,
can print any pages.
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Customizing Clip Art Collections
Blackboard Collaborate Web Conferencing offers you the ability to customize and add images to
those available in the Clip Art library from the button in the Whiteboard toolbar. A set of

images can be saved as a collection and any number of clip art collections can be created and
can be loaded each time you join Blackboard Collaborate Web Conferencing

The Clip Art Collections dialog lists all the clip art collections that are available.

Organizing the Clip Art Library

The clip art collections that are available to use with
the Whiteboard must be loaded into the Clip Art
library and then selected to appear.

To view and/or modify the collections that have
already been added to the library, do the following:

1. From the Toolsmenu, selectWhiteboard, fol-
lowed byManage Clip Art Collections… The
Clip Art Collections dialog box appears.

2. Place a check mark in the box to the left of
the collections that you want to appear in the
Clip Art library.

3. Click Done to close the dialog.

Clip Art collections selected in this window will be
loaded each time you join a Blackboard Collaborate
Web Conferencing session.

Collections without a checkmark are disabled.

Creating New Clip Art Collections
New Clip Art collections can be created at any time. To create a new collection, do the following:

1. Open the Create/Edit Clip Art Collections dialog by doing one of the following:
o From the Toolsmenu, selectWhiteboard, followed by Create/Edit Clipboard Col-
lections…

o From the Manage Clip Art collections dialog, click the New Clip Art Collections icon
.

The Create/Edit Clip Art Collections dialog opens.
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2. Click on the New Collection button in the Create/Edit Clip Art Collections dialog to dis-

play a blank collection file template.

3. Enter the title of the collection in the Collection Title: text box (highlighted in pink).
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4. Click on the Add Image File to Collection button to load a new image into the collection.
Use the operating system's dialog to select the files to load.

When loading multiple images, they can be loaded in the order that they are selected, in
alphabetical or in alphanumeric order. Alphanumeric sorts first by number (1, 2, 3, etc.)
and then by text (a, b, c, etc.).

The images appear on the list

5. For every image, the Tool Tip Text to display for file column will show the name of the
image. You may edit the names by double-clicking in the text box and entering the name.

6. Re-order the images by clicking on either the up button to move the image up or click-
ing on the down button to move the image down. You can also delete the image by
clicking on the button.

7. You can add an existing collection into the current collection by clicking on the but-

ton. This will add the collection to the existing set and will appear as a new tab in the cur-
rent collection.

8. Once you have entered the images, click on the button to save the collection(s) to a

new file.

9. Click Close to exit this window. The new collection will now appear on the Clip Art Col-
lections dialog box.
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Adding a Clip Art Collection to the Library

To add a Specified Clip Art Collection to the Clip Art Library, do the following:

1. From the Clip Art Collections dialog box, click on the button in the tool bar.

2. The “Browse for Collections Files to Use” dialog box appears.

3. Navigate to the folder containing the clip art collection file and select the file from the list.

4. Click Open to load the collection and dismiss the dialog box.

The Clip Art collection is loaded into the Clip Art library and appears in the Clip Art Collections
dialog box.

Removing Clip Art Collections from the Library

1. To remove a customized Clip Art collection from the Clip Art Library, do the following:

2. From the Clip Art Collections dialog box, select the collection to be deleted and then click

on the button. This button is deactivated if there are no user-imported clip art col-
lections available.

3. The Remove User Collections Confirmation dialog box appears.

4. Click OK to remove the Clip Art collection from the library.

Note: You cannot remove the default Collections, only turn them off.

Editing, Deleting, and Merging Clip Art Collections
To edit a customized Clip Art collection file, load the file in one of the following methods:

1. From the Toolsmenu, selectWhiteboard, followed byManage Clip Art Collections…

The Clip Art Collections dialog box appears.

2. Select the Collection file to be edited.

3. Click the Edit the Clip Art Collection button .

The Create/Edit Clip Art Collections dialog opens.
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1 New collections button. Click to create a
new collection in the current file.

9 The title of the current collection. Click to
edit.

2 Load collection file button. Click to load a
collection from the computer.

10 The type of the images in the current col-
lection. Choose Clip Art Images or Back-
ground Images. Background images are
placed as backgrounds on the White-
board. clip art images are placed as objects
in the foreground.

3 Save collections button. Click to save a col-
lection

11 Arrows. Click to move the currently
selected image up or down on the list.

4 Save to specified file button. Click to save
the currently open collections as a new
file.

12 Add new image button. Click to add
another image to the current collection.

5 Delete collection button. Click to delete
the current collection from the file.

13 Delete image file. Click to remove the cur-
rently selected file from the collection.

6 Add collections button. Click to add col-
lections from another collections file to
this collection file.

14 Tool tip text that appears over each image
when the clip art is hovered over with the
mouse cursor. Double click to edit.

7 The name and location of the current col-
lections file.

15 Preview area.

8 Currently open collections. Each is rep-
resented by a tab with its title. Click the
tabs to move to a different collection.
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Chapter 10

Page 139

Application Sharing
Application Sharing enables session participants to share their applications or entire desktops
with others in the session. Application Sharing is a type of content that, like the Whiteboard and
Web Tour, appears in the Content area.

You will know someone is hosting an Application Sharing session when the blue Application
Sharing activity indicator ( ) appears next to their name in the Participants list. (For details on
activity indicators, see Application Sharing Activity, Permission and Status Indicators on next
page.) In the example below, Vivian is sharing an application or her desktop.

There are two conditions that need to be met before you can host an Application Sharing
session: you must have been granted the Application Sharing permission and a Moderator must
have switched to Application Sharing mode in the Content Area.



Application Sharing Activity, Permission and Status
Indicators
You can monitor the state of Application Sharing activity and permissions through indicators dis-
played in the Participants list of the Participants panel.

Activity and Permission Indicators
The table below describes the icons displayed in the Participant list to indicate Moderator and
Participant permissions and activity while using Application Sharing.

Activity
Indicator

Meaning

User is conducting an Application Sharing session.

Application Sharing permission is set globally to "on" but the Moderator has
revoked Application Sharing permission from this user.

Application Sharing permission is set globally to "off" but the Moderator
has granted Application Sharing permission to this user.

Status Indicators
Status indicators appear on the Application Sharing activity indicator icons of Application Shar-
ing users in the Participants list if they are experiencing delays in the receipt of Application Shar-
ing content.

n Amber Indicator: Appears when receipt of Application Sharing content is moderately
delayed.

n Red Indicator: Appears when receipt of Application Sharing content is significantly
delayed.

Note: Only the person currently hosting an Application Sharing session
can see status indicators. Viewers do not see them.
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In the example to the right,

n Lucy is sharing an application,

n Vivian is experiencing a moderate delay in
receiving the Application Sharing content,

n Lisa is experiencing a significant delay in
receiving the Application Sharing content,
and

n Charlie is not having any problems receiv-
ing the Application Sharing content.

An Application Share is a type of content, and appears in the Content area like the Whiteboard
and Web Tour.

All participants have an Action bar in the upper left corner of the Content area while in Appli-
cation Share mode. For Participants without the Application Sharing permission, the bar con-
tains only the option to scale the shared area of the host's desktop to fit in the Participant's
content area.

Participants who have Application Sharing permission have the additional option to request con-
trol of the host's desktop. For information on this feature refer to Requesting Control of
Another's Application or Desktop on page 148

Scaling the Shared Content
The screen area shared by the Host can be scaled to fit the Content area or viewed at its native
size.

To view the content at the same size as the Host, do one of the following:

o Uncheck Scale To Fit in the Action bar.
o From the Toolsmenu select Application Sharing and then uncheck Scale to Fit.

To restore scaling, recheck Scale To Fit.
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Maximizing the Content Area
Your other option is to resize the Application Sharing Content area.

You can optimize the space available in the Content area in two ways; for maximum space, do
both:

o Maximize your Blackboard Collaborate Web Conferencing window.
o Hide the side bar (Audio & Video, Participants and Chat panels) by unselecting Show Side
Bar in the View menu or by grabbing the border of any one of the panels and dragging it
all the way to the left.

To restore the side bar, reselect Show Side Bar or drag the panel border back to the right.

Emphasized Cursor
If the application host has turned on the option Emphasize Cursor, you will see their cursor sur-
rounded with a circle (the default color is yellow), making it easier for you to follow.

Hosting an Application Sharing Session

Application Sharing Mode
Before you can conduct an Application Sharing session, you must have been granted the Appli-
cation Sharing permission and must switch to Application Sharing mode in the Content area.
(For details on modes, see The Content Area Modes on page 22.)

Be careful not to inadvertently switch modes on someone else who is
presenting content. Everyone in the session will follow you to the new
mode.

Switch to Application Sharing Mode in one of the following ways:

o In the Collaboration toolbar, click the Application Sharing Mode button.
o In the View menu, select Application Sharing.
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o Enter the keyboard shortcut Ctrl+Alt+A (Command-Option-A on Mac).
o In the Toolsmenu, select Application Sharing followed by Start Sharing….
o Open the Toolsmenu, select Application Sharing, and choose Share Entire Desktop. This
will start Application Sharing immediately without opening the Available Sharing Selec-
tions dialog.

When in Application Sharing mode, the Available Sharing Selections dialog will open.

Starting Application Sharing
Before you can start an Application Sharing session, you must be in Application Sharing mode.
For details, see Application Sharing Mode on previous page.

To start Application Sharing, do the following:

1. Open the Available Sharing Selections dialog by clicking on the Start Sharing button in
the Action bar.
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2. Click on Share Desktop or an available program window to highlight it. For programs
with multiple available windows, click the arrow icon to expand the list if you wish to
share only one window from the program.

Note:Minimized (Windows) program windows will not be available
to share.

3. Click Share to begin sharing, or Cancel to close the menu without starting a share.

If you wish to begin a new share after canceling, click the Start Sharing button in the
Action bar.

4. Move the window you wish to share to the front of the desktop. Obscured windows or por-
tions of windows will not be visible to remote Participants.

Tip: One helpful approach is to resize the window you intend to
share so that it matches the dimensions and position of the Content
area. That way you will be sure to have access to all of the
Blackboard Collaborate Web Conferencing tools even while you are
sharing.

The Application Share persists until it is closed or the host leaves the session. If a Mod-
erator switches to Whiteboard or Web Tour mode, the share will still be active, but not vis-
ible until a Moderator switches back to Application Sharing mode. For more information
refer to Pausing or Ending an Application Share on page 148.
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The Host's View of Application Sharing

When you are the host of an Application Sharing session, by default your shared application or
desktop will have a yellow border around it, making it easy to identify on your screen. (For this
feature to work, some requirements must be met. For details, see the Highlight Shared Region
option under the Hosting Options section on page 151.)

Attached to the border will be a controller (normally at the top but may move to the bottom, left
side or right side if there is no room for it on the top) with buttons for stopping and paus-
ing/resuming the application share and a button for sending a snapshot of the Application Shar-
ing window to the Whiteboard. If the entire desktop is shared, the controller appears in the top
right corner of the screen.

1 Host's Action bar 4 Pause/Resume button

2 Stop Sharing button 5 Send Snapshot to Whiteboard button

3 Host's controller

Controlling an Application Share
While running an Application Share, a host can, for the most part, continue to use the program
or desktop as usual. However, the Share itself can be stopped, paused, previewed, or captured.

Caution: If you are sharing an application that has a keyboard shortcut
identical to one in Blackboard Collaborate, and focus is on Application
Sharing, the shortcut will activate its associated command in the shared
application, not in Blackboard Collaborate.

Pausing a Share

A paused Share stops refreshing for remote Participants, but can be easily restarted later. A
Share is effectively paused if a Moderator switches to Whiteboard or Web Tour mode.

To pause a share, do one of the following:
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o In the Action bar, click Pause Sharing.

o Open the Toolsmenu, followed by Application Sharing, and click Pause Application Shar-
ing. This menu item is not available unless there is an active share.

o In the Host's controller, click the Pause button .

o Switch to either the Whiteboard or Web Tour mode. (For details, see The Content Area
Modes on page 22.)

To resume a Share, click the Pause button again, uncheck the Pause Application Sharingmenu
item, or click Resume Sharing in the Application Sharing Action bar.

Previewing a Share

Hosts can activate a small preview window to see how the Share appears to other Participants.
This helps them know if part of a shared window is obscured or if the Share becomes frozen or
lost.

To open the preview window, from the Toolsmenu select Application Sharing and then Show
Preview. A small preview window opens. This window reflects what is visible to remote par-
ticipants.

Taking a Screenshot

Hosts can send a Snapshot of what is being shared to the Whiteboard. To capture an image and
send it to the Whiteboard, do one of the following:

o Enter the keyboard shortcut, Ctrl+Print Screen (Control-F13 on Mac).

Tip: The keyboard shortcut is a "hot key", meaning you can
redefine it. For details, see Keyboard Shortcuts on page 29.

o In the Host's controller, click the Send Snapshot to Whiteboard button .

o From the Toolsmenu select Application Sharing and then Send Snapshot to Whiteboard
to send an image of the current Share exactly as it is at that moment. Select Send Snap-
shot to Whiteboard with Delay to take the Snapshot after a ten second delay.

Blackboard Collaborate Web Conferencing switches automatically to Whiteboard mode and
pauses the Share until the host resumes it.The snapshot will be placed as the background image
of a new Whiteboard slide, immediately after the current Whiteboard page. The title of the new
page will be Application Sharing Image x, where x is an incremental number.
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Giving Control of an Application Share to Another
You can give viewers of an Application Sharing session the ability to remotely control the shared
application or desktop. Participants do not need the Application Sharing permission to take con-
trol. (They do, however, require the Application Sharing permission to request control.)

Those with control over a remote application or desktop can move the mouse cursor, click, and
type. The Host also retains control at all times, and can revoke control from the remote con-
troller at any time. Only the Host and one other person can share control at once.

When sharing an application window or a program, the remote participant's control is limited
only to that application. The participant has no access to other areas of the host's desktop.

When the Host is sharing their entire desktop, the remote controller has
access to the Host's entire computer. Be very careful when giving remote
control access to your desktop.

To give another the ability to control an Application Share that you are hosting, do the fol-
lowing:

1. Select the desired person in the Participants list.

2. Open the Toolsmenu and select Application Sharing followed by Give Control of Shared
Applications.

The person remotely controlling your Application Share will have joint control over your cursor
until they voluntarily end their control or you revoke it.

To end control of the Application Share, the remotely controlling Participant can select Appli-
cation Sharing from the Toolsmenu and then Release Control of Shared Applications.

Moderators and Participants with the Application Sharing permission can
initiate a request for control. You have the option to deny or grant this
request. For details, see Requesting Control of Another's Application or
Desktop on next pageand Granting a Request for Control of an Appli-
cation Share.

Revoking Control

To revoke a person's ability to remotely control your Application Share, do one of the following:

o Type the keyboard shortcut for revoking control. The default is Control+Space.

Tip:The keyboard shortcut is a "hot key", meaning you can redefine
it. For details, see Keyboard Shortcuts on page 29.
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o From the Toolsmenu and select Application Sharing followed by Take Away Control of
Shared Applications.

Pausing or Ending an Application Share
To pause an Application Sharing session, do one of the following:

o In the Action bar, click Pause Sharing.

o Switch to Whiteboard mode. (For details, see The Content Area Modes on page 22.)

To end an Application Sharing session, do one of the following:

o Enter the keyboard shortcut, Ctrl+Shift+S (Control-Shift-S on Mac).

Tip: The keyboard shortcut is a "hot key", meaning you can
redefine it. For details, see Configuring Hot Keys on page 36.

o In the Action bar, click Stop Sharing.

o Open the Toolsmenu, followed by Application Sharing, and click Stop Sharing. This
menu item is not available unless there is an active share.

Requesting Control of Another's Application or Desktop
Application Sharing privileges are required to request control of someone else's desktop or
shared application.

Request Control of Someone Else's Desktop
Moderators and Participants with the Application Sharing permission can request control of
another person's desktop at any time – even when the session is not in Application Sharing
mode.

When you receive permission to remotely control someone else’s desktop, that person retains
the ability to control their desktop as well – control is shared.

Note: If a different user already has control of the desktop you want to
control, or the desktop owner is already sharing their own desktop, you
will not be able to request control (Request Desktop Control will be dis-
abled).
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To request control of another Participant’s desktop, do the following:

1. Select the person in the Participants list from whom you wish to request desktop control.

2. In the Toolsmenu, open the Application Sharingmenu and select Request Desktop Con-
trol. The desktop owner will receive a notification that you are requesting control of their
desktop. They may grant or refuse your request.

3. Depending on the Host's settings, you may be prompted for a password. For more infor-
mation on these settings, refer to Permit Remote Control of Your Desktop on page 153.

Requesting Control of an Application Share from the Host
Moderators and Participants with the Application Sharing permission can request cursor control
from the Host of a current Application Share.

1. Send a request to the Host through one of the following methods:
o In the Action Bar at the top left of the Content area, click Request Cursor Con-
trol.

This option does not appear if the viewer does not have Application Sharing per-
mission.

o In the Toolsmenu, select Application Sharing and click Request Control of Shared
Applications.

The desktop owner will receive a notification that you are requesting control of their
shared application. They may grant or refuse your request.

2. Depending on the Host's settings, you may be prompted for a password. For more infor-
mation on these settings, refer to Permit Remote Control of Your Desktop on page 153.

Simulated Keystrokes
A Participant with remote control of a desktop can move the mouse cursor, click, and type
within the Share area. However, some key combinations may be filtered in order to protect the
Host's computer. When a Participant controls the desktop of a host with another operating sys-
tem, some key combinations may not exist on the keyboard. (For example, the Command key
used by the Mac OS does not exist on the Windows system.)

Note: You can create, modify and delete simulated keystrokes in the Pref-
erences dialog. For details, see Configuring Simulated Keystrokes on page
158.

Also, some key combinations may be intercepted by the local operating system before they can
be sent to the remote Share. One common example is Alt+Tab (Windows) or Command-Tab
(Mac).
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Sending Simulated Keystrokes

To send a keystroke that can't be sent from the keyboard, do the following:

1. In the Toolsmenu, select Application Sharing and then Send Key. If the key combination
you need appears on the submenu, click it to send it. Otherwise, click Other…

2. If you clicked Other…, the Define Keystroke dialog menu appears.

Place your cursor in the text field and type a key to enter keystrokes directly.

Click the arrow to open a menu containing several common keys that are not on
all keyboards or are likely to be intercepted by the operating system.

Check one or more of the toggle boxes to add that modifier key to your keystroke.
(These are the most common keystrokes that cannot be entered manually.)

3. Click OK to send the keystroke. Click Cancel to return to the Share without sending a
keystroke.

Note: The list of available simulated keystrokes can be changed by defin-
ing simulated keys in the Preferences dialog. To add or modify a simulated
key, refer to Configuring Simulated Keystrokes on page 158.

Releasing Remote Control
You can relinquish control of a remotely controlled desktop or Application Share at any time. To
do so, open the Toolsmenu and select Application Sharing followed by Release Control of
Shared Applications. This menu item does not appear unless you are remotely controlling
another's desktop of Application Share.
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Advanced Application Sharing Options
Prior to hosting an Application Sharing session, you can define the following options through
the Preferences dialog box:

n Filtered Keys

n Hosting Options (to set the appearance of the Application Sharing window when you are
hosting an Application Sharing session)

n Remote Control

n Simulated Keys

Mac users also can set the option to use Open GL. See Use OpenGL
Option (Mac only) on page 161.

Hosting Options
The Hosting Options dialog box allows you to define how to display the Blackboard Collaborate
Web Conferencing Application Sharing window while you are hosting an Application Sharing ses-
sion.

To change the Hosting Options in the Preferences dialog, do the following:

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, select Hosting Options under Application Shar-
ing. The Hosting Options preferences panel appears.
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3. Change any options:

Hide content area – Select this option to collapse the Content area of the Black-
board Collaborate interface, leaving only the sidebar visible.

Shared region highlight color – Use this option to set the color of the border sur-
rounding your shared application. The border identifies what is being shared so you
will always know what the viewers of your application share are seeing

Raise shared applications to front – Select this option if you want the application
that is being shared to be brought to the front of all other windows. If the option is
not selected, the application may be hidden behind other windows on your monitor
and the Application Sharing window will be black.

This option does not work on Linux using KDE or Gnome.

Emphasize cursor – Select this option if you would like the cursor in your shared
application to stand out so it is easier for viewers of the shared application to follow
its movements. If set, the viewer’s cursor will be surrounded by a colored circle. (As
host, your view of the cursor is not emphasized.) Click the colored box to the right
to change the highlighter color.

Show a notification – Select this option if you want a Notification window to appear
on your monitor every time you start hosting an Application Sharing session. If you
wish not to have this window appear, de-select this option.

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Permit Remote Control of Your Desktop
You can grant permission to anyone with Application Sharing permissions to take control of
your desktop at anytime during the session. There are three choices for granting permission to
others to control your desktop: Ask me for permission, Require password and Allow without
asking.

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

153Application Sharing



From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, expand the Application Sharing list and select
Remote Control. The Remote Control preferences panel appears.

3. Select the desired Remote Control option:

Ask me for permission – See Ask me for permission below for details.

Require password – See Require password on the facing page.

Allow without asking. – See Allow without asking on the facing page.

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Ask me for permission

If you want other users to request permission from you to remotely control your desktop, set the
Remote Control option to Ask me for permission. Any time a user with Application Sharing per-
missions requests control of your desktop, the Remote Control Requested dialog box will appear
on your monitor.
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Select the option Allow all other requests until I quit, and leave the password field blank, if you
want to allow other users to be able to control your desktop without asking permission for this
session only. (This is equivalent to the Allow without asking option except that it resets at the
end of the session instead of being saved with other preferences.)

1. Select the option Allow all other requests
until I quit, and enter a password, if you
want to allow other users to be able to con-
trol your desktop only if they enter a pass-
word. (This is equivalent to the Require
password option.)

2. Click on Yes to grant the user permission to
remotely control your desktop.

3. If you click on No (or the window expires
before you acknowledge the message), per-
mission to remotely control your desktop
will be denied. A message, indicating that the request was denied, will appear to the user
requesting access.

Require password

If you want to require other users to enter a password prior to being able to remotely control
your desktop, set the Remote Control option to Require password. Only those who enter the cor-
rect password will have access to your desktop.

1. Any time a user with Application Sharing permissions requests control of your desktop,
the Password Required dialog box appears on their monitor.

2. They must enter the correct password and click on
OK before your desktop will appear in their Appli-
cation Sharing window. You do not have to
acknowledge the request.

Allow without asking

If you want anyone with Application Sharing permissions to be able to control of your desktop
without asking, set the Remote Control option to Allow without asking.
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Warning: This option lets anyone in the session take control of your
computer remotely. This preference will be saved with your computer and
will be the selected option in any future sessions until it is changed.

At anytime during the session, when anyone with Application Sharing permissions requests con-
trol of your desktop, your desktop will automatically appear in their Application Sharing win-
dow. You do not have to acknowledge the request.

Filtered Keys
When hosting an Application Sharing session, the keystrokes defined in the Filtered Keys list
will be ignored if sent by someone remotely controlling your application.

Note: The default set of filtered keystrokes is defined on a per-platform
basis.

Within the Filtered Keys panel of the Preferences dialog, you can add new keystrokes, modify
the existing keystrokes or remove the keystrokes from the list.

Change the Filtered Keys in the Preferences dialog.

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)
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2. In the left pane of the Preferences dialog, select Application Sharing > Filtered Keys. The
Filtered Keys preferences panel appears.

3. Add (See Adding Filtered Keys on next page), modify (Modifying a Keystroke on next
page), or remove keystrokes (Removing a Keystroke on next page).

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.

Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.
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Adding Filtered Keys

1. In the In the Filtered Keys dialog, click on the Add button. The Configure Filtered Key-
stroke dialog box opens.

2. Enter new keystrokes in one of two ways:

Place your cursor in the text field and type
a key to enter keystrokes directly.

Click the arrow to open a menu con-
taining several common keys that are not
on all keyboards or are likely to be inter-
cepted by the operating system.

Check one or more of the toggle boxes to
add that modifier key to your keystroke.
(These are the most common keystrokes
that cannot be entered manually.)

Modifying a Keystroke

1. In the Filtered Keys dialog, select the keystroke you wish to modify.

2. Click on theModify button. The Configure Filtered Keystroke dialog box opens.

3. Make your modifications. (For instructions, see Adding Filtered Keys on page 158.)

Removing a Keystroke

1. In the Filtered Keys dialog, select the keystroke you wish to remove.

2. Click on the Remove button. The keystroke will be removed from the list.

Configuring Simulated Keystrokes
Simulated keystrokes can be sent to a host system when remote controlling an Application Shar-
ing session from a computer running a different operating system than the host system. For
example, you may want to remotely control a Mac from your Windows system. Since Windows
does not have a Command key, you can simulate Mac accelerator keys such as Command-C by
defining them using the Simulated Keys feature of Blackboard Collaborate Web Conferencing

Within the Simulated Keys panel of the Preferences dialog, you can add new keystrokes, modify
the existing keystrokes or remove the keystrokes from the list.

Note: The default set of simulated keystrokes that may be sent is defined
on a per-platform basis.

Change the Simulated Keys in the Preferences dialog.
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1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, expand the Application Sharing list and select
Simulated Keys. The Simulated Keys preferences panel appears.

3. Add (see Adding Simulated Keys on next page), modify (seeModifying Simulated Keys on
page 161), or remove (Removing Simulated Keys on page 161) keystrokes.

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.
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Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Adding Simulated Keys

1. In the Simulated Keys dialog, click on the Add button. The Configure Keystroke dialog
box opens.

2. Enter new keystrokes in the dialog:

Place your cursor in the text field and
type a key to enter keystrokes directly.

Click the arrow to open a menu con-
taining several common keys that are
not on all keyboards or are likely to be
intercepted by the operating system.

Check one or more of the toggle boxes
to add that modifier key to your key-
stroke. (These are the most common
keystrokes that cannot be entered man-
ually.)

3. Enter a trigger keystroke (optional). Sending
the triggered keystroke in the Application
Sharing window will not send the typed triggered keystroke, but the associated simulated
keystroke.

4. You may further define the keystroke to be applicable only on a specified host client. The
choices here areWindows,Mac OS and Linux.

5. Click on OK.

Example Definition

Since you cannot type the ⌘Command key from a Windows system, you could define a sim-
ulated keystroke as follows:

n Keystroke to send: Meta+X (On Windows, the Meta key is labeled “Windows”.)

n Trigger on: Ctrl+X

n Only when host is: Mac

This will then automatically translate the Windows Ctrl+X (Cut command) gesture to the appro-
priate Mac gesture and only do it when remote controlling an application on a Mac.
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Modifying Simulated Keys

1. In the Simulated Keys dialog, select the keystroke you wish to modify.

2. Click on theModify button. The Configure Keystroke dialog box opens.

3. Make your modifications. (For instructions, see Configuring Simulated Keystrokes on
page 158.)

Removing Simulated Keys

1. In the Simulated Keys dialog, select the keystroke you wish to remove.

2. Click on the Remove button. The keystroke will be removed from the list.

Use OpenGL Option (Mac only)
OpenGL is a 3D imaging system used by many Mac programs (e.g., Keynote) for performing 3D
graphics effects directly on the video card (i.e., not rendered by the system CPU). OpenGL is the
preferred screen capture mechanism on a Mac as it will capture screen images from virtually all
applications correctly.

To get the best results in Application Sharing, select the Use OpenGL option (Tools > Appli-
cation Sharing > Use OpenGL).
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Chapter 11

Page 163

Web Tour
The Web Tour feature enables session participants to share web pages with others in the session.
Web Tour is a type of content that, like the Whiteboard and Application Sharing, appears in the
Content area.

A Web Tour also can be opened up in an external browser; this is called a Web Push. For details
about the differences between Web Tours and Web Pushes, seeWeb Tour vs. Web Push on page
168.

The Web Tour interface has the following components:

1 Collaboration toolbar 5 Address text box

2 Navigation bar 6 Follow Me option

3 Back button 7 Options menu

4 Forward button



You will know someone is hosting a Web Tour when the blue Web Tour activity indicator ( )
appears next to their name in the Participants list. (For details on activity indicators, seeWeb
Tour Activity and Permission Indicators below.) In the example below, Vivian is hosting a Web
Tour.

There are two conditions that need to be met before you can host a Web Tour: you must have
been granted the Web Tour permission and a Moderator must have switched to Web Tour mode
in the Content Area.

Web Tour Mode
Before you can conduct a Web Tour, you must have been granted the Web Tour permission and
must switch to Web Tour mode in the Content area. (For details on modes, see The Content
Area Modes on page 22.)

Be careful not to inadvertently switch modes on someone else who is
presenting content. Everyone in the session will follow you to the new
mode.

Switch to Web Tour Mode in one of the following ways:

o In the Collaboration toolbar, click the Web Tour Mode button.
o In the View menu selectWeb Tour.
o Enter the keyboard shortcut Ctrl+Alt+U (Command-Option-U on Mac).

Web Tour Activity and Permission Indicators
You can monitor the state of Web Tour activity and permissions through indicators displayed in
the Participants list of the Participants panel. These indicators are described in the table below.

For details about permissions, see Understanding Permissions on page 42.
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Activity
Indicator

Meaning

User is conducting a Web Tour (or Web Push).

Web Tour permission is set globally to "on" but the Moderator has revoked
Web Tour permission from this user.

Web Tour permission is set globally to "off" but the Moderator has granted
Web Tour permission to this user.

Starting a Web Tour
Before you can start a Web Tour, you must be in Web Tour mode. For details, seeWeb Tour
Mode on previous page.

To start a Web Tour, do the following:

1. Select the Follow Me option if you want others to see the web pages to which you will be
browsing. (For details, see The Follow Me Option below.)

2. Enter the URL of the desired web site in the Address text box of the Web Tour navigation
bar.

3. Press Enter.

Conducting a Web Tour
Within the Web Tour, you can navigate through the current web site by clicking on links or can
move to a different web site by entering a new URL in the Address text box. As you move
between web pages, Web Tour maintains a history of where you have been. You can use the
Back and Forward buttons to move between the pages kept in the history.

The Follow Me Option
By default, your Follow Me option is not selected and you will need to select it if you want
others to view the web pages to which you will be browsing. With Follow Me selected, session
attendees will be able to freely browse to other pages in the Web Tour, independent of the pages
to which you browse. However, when you move to a new page, they will be redirected to your
new page. If you don't want to push them to your new pages, unselect the Follow Me option.

When you start a Web Tour, you are automatically the "tour guide". However, a Moderator, or
Participant with the Web Tour permission, can take control of the Web Tour by selecting their
Follow Me option. Your Follow Me option will be unselected. You can take back control by
selecting it again.
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Publishing URL to Chat Panel
Moderators, and Participants with the Web Tour permission, can publish the URL of the current
web page to the Chat Conversation pane so it is accessible to (clickable by) everyone. To do so,
select Publish URL to Chat from the Web Tour Options menu.

Stopping the Web Tour
To stop the Web Tour, do one of the following:

o Unselect the Follow Me option.
o Switch to Whiteboard mode. (For details, see The Content Area Modes on page 22.)

Viewing a Web Tour
A Web Tour is a type of content, and appears in the Content area like the Whiteboard and Appli-
cation Sharing.

Once someone starts a Web Tour, you can freely navigate to other pages within the website by
clicking on links or using the Back and Forward buttons. However, if the Host of the Web Tour
has selected the Follow Me option, you will be redirected to the Host's current page whenever
the Host moves to a new page. For more information on Follow Me, see The Follow Me Option
on previous page.

Optimizing the Content Area
The Web Tour content often may not fit into your Content area so you will have to use the scroll
bars to view web pages.

You can optimize the space available in the Content area in two ways; for maximum space, do
both:

o Maximize your Blackboard Collaborate Web Conferencing window.
o Hide the side bar (Audio & Video, Participants and Chat panels) by unselecting Show Side
Bar in the View menu or by grabbing the border of any one of the panels and dragging it
all the way to the left.

To restore the side bar, reselect Show Side Bar or drag the panel border back to the right.
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Enabling Pop-ups in a Web Tour (Windows only)
The web browser embedded in the Blackboard Collaborate Web Conferencing Content area is,
by default, configured to block popup windows during web tours. When you are connected to
Blackboard Collaborate through a proxy server that requires you to enter authentication infor-
mation, the Popup Blocker will prevent the authentication dialog from “popping up” and you
will not be able to provide authentication credentials to the proxy server. (You will get an error
something like, “This program cannot display the web page.”) In this case, you need to disable
the Popup Blocker the Preferences dialog.

Note: This preference setting is available on Windows systems only.

1. Open the Preferences dialog in one of the following ways:
o From the Edit menu, select Preferences… (Windows & Linux)

From the Blackboard Collaborate Web Conferencing menu, select Preferences
(Mac OS X)

o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select Popup Blocker underWeb Tour. The
Popup Blocker preferences panel appears.

3. Unselect Block Popups.

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save
your preferences and leave the Preferences dialog open or Cancel to close the Preference
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the
settings each time you join another session on the same computer.
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Note: You can restore your preference settings to the default. For details
on restoring default preferences, see Restoring Default Preference Set-
tings on page 10.

Web Tour vs. Web Push
There are two ways for you to show session attendees web sites: in a Web Tour or a Web Push.

Web Tours are displayed in the Content area of Blackboard Collaborate Web Conferencing. As
the tour guide, you can control what others see by selecting the Follow Me option (see The Fol-
low Me Option on page 165). Although session attendees will be able to browse within the web
site you opened in the Web Tour, as soon as you move to a new page, they will be redirected to
your new page.

To start or view a Web Tour, you must be one of the following systems:

n any supported Windows system

n any Mac OS X 10.5 or higher running a 32-bit or 64-bit JVM

With a Web Push, the specified web page opens up in the default web browser of each session
attendee (including you) – outside of the Blackboard Collaborate application. Session attendees
will see the web page to which you initially directed (pushed) them and after that then are free
to browse to other pages, work with bookmarks, close the window, etc. When you move to
another web page, it will have no affect on what others see in their web browsers.

If you are on a Linux (Ubuntu) system, you will be able to perform or view
a Web Push only. Therefore, when a Moderator starts a Web Tour, you
will see the specified web page open in your default web browsers (a Web
Push).

In Elluminate Live! 8.5 recordings, Mac OS X users will see Web Tours as
Web Pushes, where each page of a Web Tour will open in a new external
web browser window.

Starting a Web Push
Before you can start a Web Push, you must be in Web Tour mode. For details, seeWeb Tour
Mode on page 164.

To start a Web Push, do the following:
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1. Select Open URL in Browser… from the Options menu of the Web Tour navigation bar.

The Open URL in Browser dialog opens.

2. Enter the desired URL and click OK.

The web page will open up in everyone's default web browser.

There is no way to stop a Web Push (since it exists outside of Blackboard Collaborate). However,
when you are done presenting a web site in a Web Push, you may want to ask the session attend-
ees to close their web browsers and redirect their attention back to Blackboard Collaborate.
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Breakout Rooms
To facilitate small group collaboration, a Moderator can create breakout rooms (separate from
the main Blackboard Collaborate room) and place session attendees into these rooms. Breakout
rooms have their own private Audio, Video, Whiteboard, Application Sharing, Polling, etc., so
the collaboration that takes place in a breakout room is independent of the main room (and
other breakout rooms).

Even if there is no Moderator in a breakout room, when anyone in the breakout room raises
their hand or sends a private message to Moderators, Moderators in other rooms will be noti-
fied.

When the Moderator moves someone into a breakout room, the Participants list is updated, dis-
playing the name of the room and the names of the people in the room. In the example below,
Lisa and Lucy have been moved to the breakout room called Lab 1.



Moving Yourself into Existing Rooms
If the Moderator allows it, you can move yourself between rooms. You will know you have the
ability to do when if the Room menu appears in your Participants panel toolbar.

You can send yourself from the Main room to an existing breakout room, a breakout room to
the Main room or from one breakout room to another.

Do one of the following:

o From the Room menu in the Participants panel toolbar, select the desired room from the
list of available rooms.

o From the Options menu of the breakout room to which you want to move, select Enter
Breakout Room.

o From the Toolsmenu, select Breakout Rooms, then Send Self to Breakout Room and
finally select the desired room from the list of available rooms.

o Drag and drop yourself into the desired room. You can drop yourself on a breakout room's
tab or on a person already in that room.
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Interactive Recordings

Note: Interactive recordings are not available in Blackboard Collaborate
vRoom™.

Moderators can record sessions and provide you with a link to the recording so you can play the
recording. This is useful for those who have missed a session or to those who attended but
would like to review the session.

All activity that occurs in the main room of the session will be recorded, except for private Chat
messages, the Timer and personal Notes. (Only the activity in the main Blackboard Collaborate
Web Conferencing room will be recorded. Anything that occurs in a breakout room will not be
recorded.) As the recording progresses, Blackboard Collaborate inserts index entries to mark sig-
nificant events within the session (see Using the Recording Index on page 178 for further
details). Anyone viewing the recording can navigate through the recording to points marked
with index entries.

You can tell that a session is being recorded in two ways:

o A red Recording icon appears in the Collaboration toolbar.

o The audible notification “Recording started” is played. (If you are using the telephone for
audio communications, you will not hear it.)



Note: If you join the session after recording has already resumed, you will
hear the audible notification “Recording in progress.”

Tip: You can turn audible notifications off. For details, see Setting
Notification Preferences.

Playing a Recording
A recording is played by clicking on a recording link. Access to recordings will be dependent on
your organization’s administrative interface. Please contact your administrator for more infor-
mation on accessing recording links.

To open the recording, click on the recording link. A Blackboard Collaborate Web Conferencing
window will open. Use the Playback Controller panel at the bottom the window to start, stop,
pause/resume and navigate through the recording.

1 Play/Pause button 5 Show Index Entry Menu button

2 Index Entry marks 6 Playback Time indicator

3 Playback Slider indicator 7 Playback slider

4 Current Index Entry 8 Total Recording Time

To play a recording or resume a paused a recording:

o Click on the Play button (to play at normal speed).

o From the Playback menu, select Player and then Play (to play at normal speed).
o From the Playback menu, select Player and then Fast Forward (to play at an accelerated
speed).

Note: Video, Multimedia, Web Tour and File Transfer are not displayed
when you fast-forward through a recording. Also, Audio is muted when
fast-forwarding.
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In Elluminate Live! 8.5 and older recordings, Mac users will see Web
Tours as Web Pushes, where each page of a Web Tour will open in a new
external web browser window.

As the recording advances, the Playback Time indicator, the Current Index Entry Mark and the
Playback slider will show your progress through the recording.

To pause the recording:

o Click on the Pause button to stop playing the recording and maintain your current
place in the recording.

o From the Playback menu, select Player and then Pause.

To stop the recording:

From the Playback menu, select Player and then Stop. When you stop a recording, you will not
maintain your current place in the recording – the recording goes back to the beginning.

Names Hidden in Recordings
If, when viewing a recording, you see session attendee names replaced by the generic “Par-
ticipant” or “Moderator” (such as in the Chat panel and Participants list), this means that the ses-
sion creator configured the session to hide attendee names. This is done to protect the identity
of session attendees.

Multi-Camera Video in Recordings
If a session with multiple simultaneous cameras is recorded, the video from all cameras is saved
and, when playing the recording, you can choose who to show in your primary video display just
as you would if you attended the live session.

For instructions on changing your display, see Controlling the Primary Video Display on page
67.
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Navigating Within a Recording
When you play a recording, you are not required to play it from start to finish. You can skip
ahead or move back to areas of particular interest by navigating through a list of index entries.
When Blackboard Collaborate Web Conferencing is recording a session, it automatically creates
index entries for the following events:

n Change slide in the Whiteboard

n Change topic in the Whiteboard

n Start a Web Tour

n Start an Application Sharing session

n Stop an Application Sharing session

n Start playing a Multimedia file

n Load a file for transfer

n Start a Quiz

n Show the Graphing Calculator

n Hide the Graphing Calculator

n Connect session to teleconference

n Disconnect session from teleconference

Moderators also can manually enter custom index entries.
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There are four ways to navigate within a recording:

To... Do...

Move to a general area within the record-
ing, not associated with an index entry

n use the Playback slider (see Using the Play-
back Slider on next page)

Move to the previous or next index entry n use the Playback slider (see Using the Play-
back Slider on next page)

n use the Index Entry menu (see Using the
Index Entry Menu on next page)

n from the Playback menu (in main toolbar),
select Skip Back and Skip to Next menu
options

Move to any index entry n use the Playback slider (see Using the Play-
back Slider on next page)

n use the Index Entry menu (see Using the
Index Entry Menu on next page)

Move to any index entry by selecting it
from, or searching for it in, the Recording
Index

n use the Recording Index (see Using the
Recording Index on next page)

Note: Regardless of which method you use, it may take several seconds
for the recording to reach the specified location – especially if moving
backward in the recording.

Knowing Where You Are
There are two ways you can determine your current position in a recording:

Playback Slider: When you move your cursor over the slider you will see a tool tip containing
the name of the index entry over which you are hovering and the associated time in the record-
ing. If you are not hovering over an index entry, the tool tip will display the text “Drag indictor
to move within the recording” followed by the time.

Current Index Entry and Time: The Current Index Entry and Current Time are displayed
in the Playback Controller panel. The Current Index Entry displays the icon and name of the
closest index entry within a +/- 30 second range. (The index entry normally is the same as the
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text in the Details column of the Recording Index. If there is no “Details” text, the text will be
the same as that in the Kind column of the Recording Index.) If there is no index entry within
that range, there will be no Current Index Entry displayed. In the example below, the recording
is currently at or near the point where the whiteboard page "Keys to Speaking" is being displayed
and 2 minutes and 39 seconds into the recording.

Using the Playback Slider
You can move to a specific index entry or just move randomly backward or forward in the
recording using the Playback Slider. Grab the Playback Slider Indicator with your cursor and
drag it to the left or right to the desired location in the recording.

Using the Index Entry Menu
If you want to move to a specific index entry, you can select it from the Index Entry menu.

1. Click on the Show Index Entry Menu button in the Playback Controller panel. The
Index Entry menu will open.

2. From the Index Entry menu, scroll to and click on the desired index entry.

Using the Recording Index
The Recording Index window displays a complete list of all index entries in your recording. You
can navigate to any index entry in the list.
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Opening the Recording Index

To open the Recording Index window, select Show Recording Index… from the Playback menu
(in the main toolbar).

1 Seek button 5 Sort icon

2 Suppress option 6 Column headers

3 Play icon 7 Search box

4 Time mark 8 Done button

Tip: You can resize the Recording Index window by grabbing a side or
corner and dragging it. The columns will automatically adjust themselves.

The Recording Index has five columns:

n Play icon column: is the left-most column (it has no text in the column header). It is
used to hold the Play icon, which indicates the current playback position in the recording.

n Time column: lists the times in the recording that index entries were created, either
automatically by Blackboard Collaborate Web Conferencing or manually by you.

n Source column: shows the icon of the Blackboard Collaborate module being used when
the index entry was created. For manually created index entries, the column will show the

Recording icon.

n Kind column: gives a description of the event that triggered the index entry.

179Interactive Recordings



n Details column: describes the specific screen, file, application or web address associated
with the event that triggered the index entry.

The Source, Kind and Details columns can be resized. Move your cursor over a column divider
between two column headers. The cursor will change to a double arrow. Drag the column

divider to the desired position.

Moving to an Index Entry

From the Recording Index, you can move to any place in the recording that is marked by an
index entry. You can do so in one of two ways:

o Double-click on the desired index entry.
o Select the desired index entry (by clicking on it or using the Up and Down Arrow keys)
and click on the Seek button.

The recording will begin playing at the point you specified. (If the recording was in a paused
state when you selected an index entry, you will have to click on Play to resume playback.)

Note: It may take a few seconds for the recording to reach the specified
location.

Note: The Whiteboard, Video and Multimedia may not be displayed when
you are navigating to an index entry. The Whiteboard will go black, the
Video window will be blank and the Multimedia file window will not open
– unless you are specifically moving to the index for the Multimedia file,
in which case it will open and start playing.

Sorting the Recording Index

The Recording Index can be sorted by the Time, Source, Kind and Details columns.

l Time: sorts numerically by time mark

l Source: sorts by grouping all entries related to the same modules (with the same Source
icon) together

l Kind: sorts alphabetically

l Details: sorts alphabetically
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Note: You can sort by one column only – there is no secondary sorting
on a second column.

The sort direction is indicated in the column header by the ascending and descending Sort
icons. To sort by a column, click on the column header. Each successive click on the same
header advances the sorting status through a sequence of ascending, descending and unsorted.

The default sort order is by Time, in ascending
order – chronologically from the beginning of the
recording to the end.

Click on the Kind column header to sort by Kind in
ascending alphabetical order.

Click on the Kind column header again to sort by
Kind in descending alphabetical order.

Click on the Kind column header again to stop sort-
ing by Kind and return to the default sorting order
(Time in ascending order).

Filtering the Recording Index

Sometimes in a session you might rapidly repeat
events, such as quickly skipping through pre-
sentation screens in the Whiteboard. You have the
option of filtering from view any consecutive dupli-
cate index entries (entries of the same Kind and
from the same Source) that occur within a couple
of seconds of each other. Filtering can help you
eliminate “noise” from your Recording Index.
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In the example below, a number of index entries were triggered by slide changes in the White-
board. The duplicates are highlighted in yellow.

To filter out the duplicate index entries in the Recording Index, select the option Suppress dupli-
cate entries. In the example below, the index entries that were highlighted in yellow above are
no longer shown.

Note: Suppressing duplicate entries does not remove them, but just hides
them. To see them again, simply de-select Suppress duplicate entries.
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Searching for an Index Entry

If you have a large recording, it may not be easy to find a particular index entry by scrolling
through the list in the Recording Index. You can quickly find index entries by searching for spec-
ified text in the Kind and Details fields of the index entry.

To search for an index entry, type your search term in the Search box. For example, if you want
to search for index entries containing the term “reaction”, start typing the word in the Search
box.

Note that the search begins almost
immediately as you type, so you will
start getting matching index entries
before you have finished typing the
word. (Note the highlight areas in
the example to the right.) Keep typ-
ing until you get the results you
desire.

Tip: To search immediately, without the one or two second delay, enter
your text and immediately press Enter.

Mac Note: Mac users will see a standard Mac search field rather than
the Blackboard Collaborate search field.

To clear the Search box and end your search, do one of the following:

o Click on the Cancel button
o Press Escape
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The Notes Window
The Notes window lets you easily take personal notes during a live Blackboard Collaborate Web
Conferencing session, edit them and later share them with others. (During the session, only you
will see your own notes.) As you write notes about what is being presented in a session, Black-
board Collaborate synchronizes the notes to the session timeline. This is very useful when
reviewing recorded sessions later. When playing a recording, the Notes window tracks the prog-
ress of the session and displays the notes that were taken at every point during the session. (For
information on recording sessions, see Chapter 13, “Interactive Recordings”.)

A new Notes document is created each time you enter a new session and take notes. (If you re-
enter the same session multiple times, there will be only one Notes document created for that
session for that particular day. If you attend a session that spans multiple days, you will get a
new Notes document for each day.) These documents are saved locally on your computer.

Beyond simple note-taking, the Blackboard Collaborate Notes facility has a number of useful fea-
tures:

n You can edit, format or reorganize notes at any time, either during a live session or when
playing a recorded session.

n You can share your notes with others.

n You can manage your notes library by importing, exporting and deleting Notes documents.

n You can search within your list of Notes documents to easily locate notes taken for a spe-
cific session.

n You can view presentation notes imported with a loaded presentation.



The Notes window has the following components:

Opening and Closing the Notes Window
Opening and closing the Notes window is quick and simple so, at any time, you can enter a note
without your attention being diverted away from the session in progress.

You can move, resize or close the Notes window so it is not obtrusive. If you close it, you can
reopen it later and continue where you left off. The window remembers where you were when
you closed the window so you can continue entering notes without worrying if your cursor is in
the right position. It also remembers its size and position, so it will appear exactly the same as
the last time you opened it.
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Note: The Notes window always remains in front of the Blackboard Col-
laborate Web Conferencing main window.

The following table describes how to open and close the Notes window:

You want to Precondition Use Keyboard Shortcuts Use menus or other

Open the Notes
window

Notes window is
closed

Ctrl+E (Windows &
Linux)

Command-E (Mac)

FromWindowsmenu,
select Show Notes

Activate the
Notes window
(bring it to the
front)

Notes window is
open but inactive (or
hidden in the back)

Ctrl+E (Windows &
Linux)

Command-E (Mac)

FromWindowsmenu,
select Show Notes

Close the Notes
window

Notes window is
open and active

Ctrl+W or ALT+F4
(Windows & Linux)

Command-W (Mac)

Click Close button in
Notes window

FromWindowsmenu,
unselect Show Notes

Note: You can also open the Notes window by importing a Notes file
through the Collaboration toolbar. For details, see Loading Content
through the Collaboration Toolbar.

Taking Notes
To start taking Notes, do the following:

1. Open the Notes window (as described Opening and Closing the Notes Window on pre-
vious page).
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2. Start typing. The cursor is positioned at the top of the Notes editor – presumably that is
where you want to enter your first note. As you enter a note, the text will wrap to fit the
Notes window.

3. Press Enter to end the note and start a new one. A note is similar to a paragraph (in a
word processor) in that pressing Enter ends a note and creates a new one immediately
below it. (To enter a new note somewhere other than directly below the existing note, see
Inserting Notes on page 192.)

Tip: If you want to enter a line break without creating a new note, press
Alt-Enter (Option-Enter on Mac).

Creating Lists
The Notes window provides basic support for creating lists. You simply enter designated list char-
acters at the beginning of a line. When you press Enter, those characters are examined to deter-
mine if this line is part of a list. All list items will remain grouped together in the same note.

1. Type the desired special list character (refer to the table below) followed by the text for the
first list item.

2. Press Enter to create the next line in the list.

3. Manually preface each list item with the special
list character – it is not done automatically like
in a word processor.

4. Press Enter twice to end the list. A new note
will be created below.

Use the following special list characters to create your
list:

Character(s) Description

- Create a hyphenated list

• Create a bulleted list

Alt-0149 using numeric keypad on Windows

Option- 8 on Mac OS X

1. Create a numbered list where numbers are followed by periods

2- Create a numbered list where numbers are followed by hyphens

3) Create a numbered list where numbers are followed by parentheses

a. or A. Create a lettered list where letters are followed by periods

a- or A- Create a lettered list where letters are followed by hyphens

a) or A) Create a lettered list where letters are followed by parentheses
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Formatting Notes Text
To enhance the readability of your notes, Notes lets you change font size and apply basic text
styles to your notes.

1. Select the text you want to format.

2. Enter the desired keyboard shortcut to format the text (see table below).

Note: You can use most standard text editing mouse actions within the
text of notes, such as double-clicking to select a word and dragging to
select text.
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The following standard text editing keyboard shortcuts can be used to perform functions within
the text of individual notes.

Function Windows & Linux Shortcuts Mac OS X Shortcuts

Make selected text Bold Ctrl+B Command-B

Make selected text Italics Ctrl+I Command-I

Underline selected text Ctrl+U Command-U

Decrease font size of selected text Ctrl+[

Ctrl+-

Command-[

Command-Minus Sign

Increase font size of selected text Ctrl+]

Ctrl+=

Command-]

Command-=

Select all text in current note Ctrl+A Command-A

Copy selected text Ctrl+C Command-C

Cut selected text Ctrl+X Command-X

Paste copied text Ctrl+V Command-V

Delete selected text Delete

Backspace

Delete

Insert a line break within a note Alt+Enter Option-Enter

Note: Text formatting will not be retained if you copy and paste for-
matted text from one note to another, or to an external text editing appli-
cation.

Changing the Text Size in the Notes Editor
You can change the size of the text displayed in the Notes editor to make it more readable for
you. The font size of the entire document will change and any changes that were made using the
Decrease and Increase keyboard shortcuts will be overridden.
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The available text sizes are 8, 9, 10, 11, 12, 13, 14, 15, 16, 18, 20, 22, 24, 28, 32 and 36 points. To
change the font size of the text, do one of the following:

o Select the font size from the Text Size menu in the tool bar of the Notes window.
o Right click (Control-Click on Mac) anywhere in the Notes
editor and select one of the options from the context
menu.

Make Text Bigger – increase the text size to the
next larger size. For example, if the text was set to
12, selecting Make Text Bigger will increase the size
to 13.

Make Text Smaller –decrease the text size to the
next smaller size. For example, if the text was set to
36, selecting Make Text Smaller will decrease the
size to 32.

Default Size –set the text size back to the default
setting of 12. (This value may be different for non-
English implementations of Blackboard Collaborate
Web Conferencing.)

Text Size – change the text size to that selected
from the submenu.

Working with Notes
Once you have entered your notes, you can work with them in a number of ways:

l Select them (see Selecting Notes on next page)

l Insert them (see Inserting Notes on next page)

l Move them (seeMoving Notes on page 194)

l Delete them (see Deleting Notes on page 194)

l Print them (see Printing Notes on page 195)

l Save them (see Saving Notes on page 195)
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Selecting Notes
You need to select notes to perform operations on them, such as moving and deleting them.

To select a note, you need to select the thumb associated
with the note. When a note is selected, its thumb is high-
lighted. You can do so in one of two ways:

o Click directly on the thumb. Note that the mouse
pointer changes from an arrow to a hand. This
means you can drag the note to another location.

o Press Escape. The thumb of the note that was cur-
rently being edited will be highlighted, indicating
the note is selected.

There are also keyboard shortcuts you can use to select notes:

Function Precondition
Windows & Linux

Shortcuts
Mac OS X Shortcuts

Select the previous note Initial note is selected pressUp Arrow
twice

pressUp Arrow
twice

Select the next note Cursor is within text of
note

press Enter twice press
EnterorReturn
twice

Initial note is selected pressDown
Arrow twice

pressDown
Arrow twice

Select the note you are
currently entering or edit-
ing

Cursor is within text of
note

press Escape press Escape

Inserting Notes
Typically, when you are first entering your notes, you will simply press Enter to create a new
note beneath the existing note. However, you can insert new notes anywhere in the Notes editor
– when initially entering them or editing them later. The existing notes will re-flow auto-
matically to make room for the new note.

Other than inserting a note below the existing note, you can insert new notes

l before the existing note,

l between existing notes, or

l anywhere in the Notes editor.
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Use keyboard shortcuts to insert notes:

Function Precondition
Windows & Linux

Shortcuts
Mac OS X Shortcuts

Insert a new note imme-
diately below the existing
note

Cursor is within text
of note

Enter Enter or Return

Initial note is
selected

Enter or

Down Arrow

Enter or Return or
Down Arrow

Insert a new note imme-
diately above the existing
note

Initial note is
selected

Up Arrow Up Arrow

Use a click of the mouse to insert new notes:

To insert a new note between two existing
notes, click between the two notes (either
between text or thumbs).

To insert a new note anywhere in the
Notes editor, click any blank area in the
Notes editor. (For example, you may want
to leave blank areas to remind you to go
back and fill in further details later on.)

Note: Each note has an internal timestamp (not visible to you) that keeps
it synchronized with its associated activity within the session. When you
enter a new note between two existing notes, the timestamp of the new
note will be a relative time between the time stamps of the two existing
notes.
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Moving Notes
Notes can be moved up and down and reorganized freely using the mouse. Other notes will auto-
matically re-flow if needed to make room for moved notes.

1. Click on the thumb of the note you want to move.
When the mouse is hovering over the thumb, the
cursor changes to a hand to indicate it can be
grabbed.

2. Hold down the mouse and drag the note vertically to
the desired location.

3. Release the mouse to drop the note.

You can also use keyboard shortcuts to move notes:

Function Precondition
Windows & Linux

Shortcuts
Mac OS X Shortcuts

Move the selected note
above the previous note

Note is selected Alt + Up Arrow Option-Up Arrow

Move the selected note
below the next note

Note is selected Alt + Down Arrow Option-Down Arrow

Note: Each note has an internal timestamp (not visible to you) that keeps
it synchronized with its associated activity within the session. When you
move a note between two other notes, the timestamp of the moved note
will be a relative time between the time stamps of the two other notes.

Deleting Notes
To delete a note, select it (click on its thumb) and press Delete or Backspace.
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Printing Notes
To print notes, you must export the Notes document as a .txt file (see Exporting Notes Doc-
uments on page 198), open it in a text editor and use the text editor’s print facility.

Note: Exported .txt files do not retain time stamp and formatting infor-
mation.

Saving Notes
You never have to save individual notes because Notes documents are saved automatically to
your local hard drive.

For information on saving a Notes file, see Exporting Notes Documents on page 198.

Viewing Presenter Notes Imported with a Presentation
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Sometimes Moderators include a presentation’s presenter notes when they load a presentation
into the Whiteboard. These notes will appear in your Notes editor, where each presenter note
becomes a separate entry and is prefaced with the name of the associated slide (as shown in the
screen capture to the right).

If you already have notes within your Notes editor, the presenter notes will be appended to the
end.

Managing Notes Documents
In addition to working with individual notes in the Notes Editor, you can manage Note Doc-
uments in the following ways:

l Open them (see Opening the Notes Documents List below)

l Search for them (see Searching for Notes Documents on the facing page)

l Export and import them (see Exporting and Importing Notes Documents on page 198)

l Delete them (see Deleting Notes Documents on page 202)

Opening the Notes Documents List
The Notes Documents list displays a list of the sessions for which you took notes. It is always
closed when the Notes window is first opened in a Blackboard Collaborate Web Conferencing
session, as the primary purpose of the Notes window is to take notes for the present session.

There are two ways to open the Notes Documents list:

o Click on the Manage Notes button.
o Drag the divider down using the mouse.

The Notes Documents list displays the date and name of
each session that has notes associated with it. Sessions are
always listed in reverse chronological order; this order can-
not be changed.

Selecting any Notes document in the list displays its notes
in the Notes editor below.
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The Notes document for the current session is highlighted in bold.

You can select multiple Notes documents. (Select the first
Notes document and hold down Control (Command on
the Mac) as you select the remaining notes.) When they
are for different sessions then nothing is displayed in the
Notes editor. When they are for the same session, the mul-
tiple Notes documents will be compounded (merged) and
displayed as one. See Using Compound Notes on page 203
for details.

When no Notes documents are selected, the Notes editor
is blank.

Searching for Notes Documents
Over time, your list of Notes documents will grow and locating a specific session document by
scrolling the list may become increasingly challenging. The Search Notes Documents feature can
be used to filter the Notes Documents list by allowing you to display only those Notes Doc-
uments whose session name contains your specified search string.

Tip: To display the Search field, you must first open the Notes
Documents list by clicking on the Manage Notes button.

Session dates are not searchable. Sessions
are listed in reverse chronological order and
it is easy for you to scroll to the desired
date.

The list of Notes documents is updated
dynamically as you type.

Note: The Search
field cannot be used
to search the text
within notes in the
Notes editor. There-
fore, it is hidden
when the Notes Doc-
uments list is closed.
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Exporting and Importing Notes Documents
You can share your notes with someone else by exporting and importing Notes documents. Per-
haps someone could not attend a session and would like to review your notes while playing a
recording of the session. Or maybe two of you (who both attended a session) would like to com-
pare notes.

You may also want to export notes to open them in another application to edit or print them.

n For details on exporting Notes documents, see Exporting Notes Documents below.

n For details on importing Notes documents, see Importing Notes Documents on page 200.

Exporting Notes Documents

Notes can be exported in one of two formats.

l For sharing notes with others to use within a Blackboard Collaborate Web Conferencing
session, export them as Notes documents (.eln files).

l For importing notes into other applications, export them as text files (.txt files).

Notes Document (.eln file): An .eln document is the format used within Blackboard Collaborate
It is not suitable for importing into other applications as other applications cannot interpret
them (making them unreadable). However, as .eln files retain all timestamp and formatting infor-
mation, they are the format required to share notes with others. When imported back into Black-
board Collaborate, they are perfectly readable.

Text File (.txt file): A .txt file can be opened by any application that reads text files. Because .txt
files do not retain time stamp and formatting information, they cannot be used to share notes
with others in Blackboard Collaborate However, if you want to edit or print a Notes document in
another application, export them as .txt files as the notes will be in a readable format (as in the
sample to the right).
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Tip: Another way to export notes is simply to copy and paste them into
another application. As with exporting via a .txt file, the text formatting
(bold, italics, etc.) will not be retained.

It is possible to export either one or multiple Notes documents at once.

Note: If the multiple documents pertain to the same session (same
name and date), they are automatically compounded into a single file dur-
ing export. See Using Compound Notes on page 203 for more infor-
mation.

To export Notes documents, follow the steps below:

1. From the Notes Documents list, select the Notes
document(s) you want to export.

2. Click on the Export Notes button at the top

of the Notes window. The Save file dialog will
open.

3. Browse to the directory in which you want to save
your Notes documents. (Blackboard Collaborate
will remember this location the next time you
export Notes documents.)

4. Select the file format in which you want to save your Notes documents.

5. Enter a name for your Notes document. (See Notes Document Filenames on page 200for
further information.)

6. If you are exporting multiple documents, and you want them all to be saved in the same
format and in the same location, check the Apply to All checkbox.

7. Click on Save. If you are saving multiple notes files at once, you will be required to click
on Save for each one.
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Notes Document Filenames

By default, the file name of an exported Notes document is named as follows:

<Date>-<Session Name>.eln

where

<Date> is the date the notes were taken and <Session Name> is the name of the session for
which the notes were taken. The format of the date is determined by your system preferences.

However, you can name an exported document whatever you like.

Note: If you change the name of a Notes document during export, and
import the renamed document back into Blackboard Collaborate, the
name within the Notes Documents list will be the same as it
was before export – it will be listed using the name and date of the ses-
sion for which the notes were taken.

Importing Notes Documents

Imported Notes document behave the same way as notes that were created locally. They can be
viewed, edited, deleted and reorganized just like local Notes documents.

You can import Notes documents in two ways:

o Through the Collaboration Toolbar. (For details, see Loading Content through the Col-
laboration Toolbar .)

o Through the Notes window.
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To import Notes documents through the Notes window, follow the steps below:

1. Click on the Import Notes button at the top of the Notes window. The Open file
dialog will open.

Note: Only .eln files can be imported as only they contain
the information required by Blackboard Collaborate – such
as time stamps and formatting information.

2. Select the document(s) you wish to import.

3. Click on Open. The imported Notes document(s) will appear in the Notes Documents list.
(If the Notes Documents list was previously closed, it will be opened to display your
imported Notes document.)
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If you import notes from someone else for a
session for which you already have your
own notes, or if you import more than one
set of notes for the same session, Black-
board Collaborate will distinguish the Notes
documents by appending the authors’
names to the session name (as in the exam-
ple to the right).

Note: Imported
Notes documents are
copied to the Notes
storage directory.
Therefore, the orig-
inal notes files you
imported are no
longer required and,
if you like, you can
delete them.

Deleting Notes Documents
When you delete a Notes document, it is removed from the Notes Documents list and deleted
from the Notes storage directory.

Warning: Be careful when
deleting Notes documents –
deletion is permanent.

To delete Notes documents, follow the steps below:

1. From the Notes Documents list, select the
Notes document(s) you want to delete. (To
select more than one Notes document, select
the first document and hold down Control
(Command on the Mac) as you select the
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remaining documents.) Click on the Delete Notes button. A message dialog will

appear, asking you to confirm the delete operation.

2. Click on Yes to complete the deletion.

Deleting the Notes Document for the Current Session

If you try to delete the Notes document for the current session, it will remain listed in the Notes
Documents list since the current session must always have a Notes document open into which
you can enter notes. However, the contents of the Notes document (the actual notes) will be
deleted. If you do not enter new notes before the session ends, no notes will be saved for the cur-
rent session.

Using Compound Notes
Blackboard Collaborate Web Conferencing lets you view multiple Notes documents simul-
taneously by compounding (merging) the documents together as one in the Notes editor. This is
a great way to compare your notes with those written by someone else for the same session.
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When you have multiple Notes documents for a particular session, they appear as separate items
in the Notes Documents list. The name of each author is appended to the session name.

In the Notes editor, each note is prefaced by the name
of its author. The notes are sorted by time stamps (not
visible to you), just as they are in a single Notes doc-
ument.

A compound Notes document behaves like a “normal”
document. You can add, move, edit or delete notes. The
changes you make are saved to their respective under-
lying Notes documents. In the example to the right, if
you edited the first note, it would be saved to Ricky’s
Notes document.

When you add new notes, if you are the author of one
of the underlying Notes documents, the new notes will
be added to your Notes document. However, if you
didn’t author any of the underlying documents, the new
notes will be added to the first underlying document
(the first one listed in the Notes Documents list). In the
example to the right, Vivian’s note will be added to
Ricky’s Notes document.

If you want to save the compound notes, you can merge
them into a single document by exporting them. (See
Exporting Notes Documents on page 198.) Once
exported, it can be managed like any other Notes doc-
ument (e.g., searched, deleted, compounded with yet
another Notes document, etc.).

Viewing Notes in Recordings
Notes are tied to events in a session via an internal clock. When viewing a recorded session, the
Notes window automatically moves a marker (arrow) through the notes to point to the notes
that were entered at specific times during the session.
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The Notes window does not automatically
open when you begin playing a recording.
You must open it manually (see Opening
and Closing the Notes Window).

If you pause, rewind or forward the record-
ing, the marker will move in the Notes doc-
ument in accordance with the current time
of the recorded session.

If the current note is out of view, the editor
will scroll to it automatically. The arrow
marker is always aligned with the top of the
note. However if the note is significantly
taller than the arrow, a vertical tail will
cover the entire height of the note to make
sure the indicator is always visible.

Note: If no notes
were taken for the
recorded session, a
new blank Notes doc-
ument will be
created, allowing you
to enter notes about
the recording.

Editing Notes in a Recording
Other than the arrow marker, there is basically no difference between notes in a recording and
notes in a live session. Notes can be edited, inserted and deleted while you play a recording in
the same way as can be done during a live session. (Refer to Taking Notes andWorking with
Notes.) Just like notes in a live session, they are automatically saved and any changes will over-
write the original notes file.

When you select a note, and it is the current
note at this point of the recording, the
arrow marker changes from gray to the
highlight color for your operating system.

While you edit the text of a note, the
recorded session continues and the arrow
marker moves to the next notes in the order
they were taken. Subsequently, as the Notes
editor scrolls down, you may lose sight of
the note you are editing.
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Tip: Pause the recording to keep
the note you are editing in focus –
displayed within the visible
portion of the Notes editor.
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Miscellaneous Windows

Page 207

Besides the basic panels that appear in the Main window (Participants, Chat, Audio & Video and
the main Content area) you may have access to additional windows.

Some of the windows described in this chapter are launched by the Moderator and will appear
in front of the Main window.

The Timer
The Timer in Blackboard Collaborate Web Conferencing is a clock that Moderators can use to
effectively manage sessions. It can be useful in helping you pace yourself and stay on track with
your assignments. The Timer appears in the Collaboration toolbar, showing the time counting
either up or down, depending on how the Moderator has set the Timer.

When the Timer has expired, you may be notified by an audible tone and/or visual notification
(such as the one below), depending on how the Timer was configured. Anyone in the session
can turn their own audible and visual notifications off. For details, see Setting Notification Pref-
erences on page 16.



The Quiz Manager
The Moderator is able to administer multiple choice and short answer quizzes during the session
using the Quiz Manager feature. A quiz consists of questions and the results can be published for
the Participants to review.

Responding to Quiz Questions
When a Moderator administers a quiz, the Quiz Manager window will appear in front of your
main Blackboard Collaborate Web Conferencing window, displaying the first question. If the
Moderator set a time limit for the quiz, the time remaining will be displayed in the lower right
corner of the Quiz Manager window.

To answer the quiz questions, in the Quiz Manager window,

Select a response for multiple choice questions or enter your answer into the text box provided
for short-answer questions.

Use the arrow buttons or drop-down menu (shown below) to navigate between questions.

Once you have completed the quiz, click the Hand In button.
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You will receive a message querying whether you wish to hand your quiz in. The message will
also inform you if you have not answered all of the questions. Click Yes to submit the quiz. Click
No to return to the quiz.

Viewing Quiz Results
Once the quiz has been completed the Moderator may show the results. You will be able to view
each question along with your response and the correct response (identified with a green check-
mark). A summary of the responses from all of the Participants will be displayed graphically. Use
the arrow buttons or drop-down menu (shown below) to navigate between questions.

Multimedia Window
The Multimedia feature allows a Moderator to play a multimedia file or a multimedia URL in
your session.

Note: The appropriate players must be installed to view these files. The
Multimedia feature will first attempt to play the file in the Multimedia win-
dow and if this is not possible, it will then attempt to open the file up in
your machine’s supported media player.

If the Multimedia window is open on your screen, when the Moderator closes their Multimedia
window, the Multimedia window will close on your screen.
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The File Transfer Library
The File Transfer Library permits Moderators to upload files into the session in order to share
them with everyone. To open the File Transfer Library, select Show File Transfer Library under
theWindow menu.

The File Transfer Library displays a list of all the preloaded files and files currently being loaded
into the library.

Each file or URL displayed in the list contains the following information:

n Name of the File — the name of the file is derived from where the file was loaded. If the
file was loaded from a user's file system, then this is the name of the original file. If it was
loaded from a URL, this is the last component of the URL path.

n Owner of the File — this is the name of the person who loaded the file. If the file was pre-
loaded by the server, then the owner will be listed as a dashed line (---).

n Size – the size of the file and what progress has been made downloading the file to your
machine.

n Server — indicates the status of loading the file onto the server. If the file has been fully
loaded onto the server the status will read Complete. If the file is uploading, it will indicate
the status as Loading and the percentage of completion. If the file has not been com-
pletely uploaded to the server and the user who was uploading the file has left the session
or been disconnected, the status will read Partial and the percentage of completion.

n Progress — the Progress bar is a status indicator showing the progress of loading the file
into the library. It shows a graph with red, orange, yellow, cyan, and green bars, where
red indicates less than half the file is loaded and green indicates it is completely loaded.

Note: If you had saved the file locally, you can find out where by hov-
ering your mouse over the filename in the library. A tool tip will display
the full path name.
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Saving a File
A Moderator may prompt you to save a file. If so, the Save File dialog will appear.

1. Click on Yes. The Save dialog will open.

2. Navigate to the folder to which you wish to save the file and click Save.

You also can save the file without being prompted to do so.

1. Open the File Transfer Library by selecting Show File Transfer Library from theWindow
menu.

2. In the File Transfer Library, select the file you would like to save.

3. Click on the Save button in the toolbar. The Save dialog will open.

4. Navigate to the folder to which you wish to save the file and click Save.

Closing the File Transfer Library
Closing the File Transfer Library will not affect the files already loaded into the library – it just
closes the window. To close the window, do one of the following:

o Click on the window’s Close button in the title bar of the window.
o Enter Ctrl+W (Command-W on Mac)
o Enter Alt+F4 (Windows and Linux only)

Session Plans
A Moderator may use an Elluminate Plan! session plan to conduct the session and may (or may
not) show that plan to all session attendees. Session plans are created in a standalone desktop
application called Elluminate Plan! They are essentially a session outline that automates various
session activities, helping the Moderator run the session. As a Participant, you cannot interact
with the session plan, only view it, save it or print it – and only if permitted by the Moderator.
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If a Moderator selects the option to show session plans to Participants, your Session Plan win-
dow will open automatically, displaying the Plan Outline. The window has the following com-
ponents:

Closing and Reopening the Session Plan Window
To close the window, do one of the following:

o In theWindow menu, unselect Show Session Plan.
o Enter the keyboard shortcut Ctrl+W (Command-W on Mac).
o Enter the keyboard shortcut ALT+F4 (no Mac equivalent).
o Click on the Close Window button in the title bar of the window.

To reopen the window, in theWindow menu, select Show Session Plan.

Printing Session Plans
When you print a session plan, the printout will include only the text that is displayed by the ses-
sion plan for Topics, Actions and Text Items, indented appropriately to reflect the Plan Outline.
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1. Open the Print dialog by doing one of the following:
o From the File menu, select Print and then Session Plan.
o Enter the keyboard shortcut Ctrl+P (Command-S on Macintosh).

Note: If you have the main Blackboard Collaborate window
in focus (rather than the Session Plan window), when you
enter the keyboard shortcut, you will be presented with a
dialog from which you need to select Session Plan from a list
of printable files (others are Participants list and Whiteboard)

o Click on the Print button in the Session Plan toolbar.

2. Select your print options and click OK.

Saving Session Plans
Participants can save session plans only as plain text – not as fully functioning session plan files.
The plain text version contains only the text that is displayed by the session plan for Topics,
Actions and Text Items, indented appropriately to reflect the Plan Outline.

Tip: A plain text outline can be useful as a basis for taking class notes.

1. Open the Save Session Plan dialog by doing one of the following:
o From the File menu, select Save and then Session Plan.
o Enter the keyboard shortcut Ctrl+S (Command-S on Macintosh).

Note: If you have the main Blackboard Collaborate window
in focus (rather than the Session Plan window), when you
enter the keyboard shortcut, you will be presented with a
dialog from which you need to select Session Plan from a list
of files that can be saved (others are Chat, Participants list
and Whiteboard).

o Click on the Save button in the Session Plan toolbar.

2. Enter a name for your saved file and click Save.
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Chapter 15
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The Graphing Calculator
To display the calculator, select Graphing
Calculator from the Window menu. The cal-
culator is displayed in front of the other win-
dows. Resize or re-position the Graphing
Calculator window as desired.



1 Y-axis 8 Restore default button

2 X-axis 9 Function boxes

3 Zoom buttons 10 Evaluate buttons

4 Manually shift view area button 11 Minimum X range box

5 Point select button 12 Maximum X range box

6 Grid spacing selection 13 Minimum Y range box

7 Privacy settings 14 Maximum Y range box

Opening and Closing Graphing Calculator Window
To open the window, in theWindow menu, select Graphing Calculator.

Closing the Graphing Calculator window will not affect any of the work you have already done –
it just closes the window. To close the window, do one of the following:

o Click on the window’s Close button in the title bar of the window.
o Enter Ctrl+W (Command-W on Mac)
o Enter Alt+F4 (Windows and Linux only)

Private and Shared Calculators
The Graphing Calculator feature supplies everyone with two calculators: a private and a shared
calculator.

Anyone can open and use their private calculator, which is visible only to them. Participants do
not need any permissions to use the private calculator, however, they can access it only if the
Follow Moderator option is turned off (which it is by default).

The shared calculator resides on the Moderator’s application. Only Moderators can use the
shared calculator. No permission is required to view the shared calculator.

Both Graphing Calculators function identically.
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Switching between the Private and Shared Graphing Calculator
You can switch back and forth between calculators when 1) the Follow Moderator option is
turned off and 2) you have been granted the calculator permission by the Moderator (so you can
access the shared calculator). To switch between the two calculators, select Shared or Private
from the drop down menu in the Graphing Calculator window.

The information on your private calculator does not change or get deleted
when you switch between private and shared calculators.

Using the Shared Graphing Calculator

Graphing Functions Using the Calculator
You can enter only explicit functions in the Graphing Calculator. The calculator allows you to
plot two functions on the same grid. If your function contains a variable, it must be represented
by an x.

1. Type your function in the Function box and
press Enter to graph it.

2. Optionally, you can enter a second function in
the second function box. Your first function is
graphed in blue, the second in red.

Entering Mathematical Operators and
Functions
The following table lists the allowable mathematical
operators.

Type To perform this operation…

+ Add

- Subtract

* Multiply

/ Divide

^ Exponent

( ) Parenthesis (to indicate order of oper-
ation)
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Use the following abbreviations for these functions and numbers.

Type To represent this function or number…

sqrt Square Root

abs Absolute Value

log Logarithm (base 10)

ln Natural Logarithm

sin Sine

cos Cosine

tan Tangent

csc Cosecant

sec Secant

cot Cotangent

asin Arcsine

acos Arccosine

atan Arctangent

pi pi

e e

Note: Trigonometric functions are graphed in radians.

Displaying the Function History
Both function entry fields maintain a history of the ten most recent functions that you graphed.
When you exit the session, all the functions are erased.

Click the drop down arrow button next to the function field to display the history of graphed
functions for that field.
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Evaluating Functions
1. Enter a value or expression for X in the Y= text box.

2. Click the button to evaluate Y for the given value of X. The Solve Function dialog
box appears.

3. Select the option Mark the resulting point on the graph if you want the coordinates of the
result plotted on your graph.

4. Click OK to accept your changes and dismiss the dialog box. Your result is displayed in the
Solve Function information box.

5. Click OK to dismiss the information box and view the coordinates on your graph. The
coordinates are displayed and plotted on the graph. You can zoom out or move the display
region to view the plotted coordinates on your graph.
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Selecting and Displaying Points on the Graph
Select the button on the calculator and then click a point on the grid. The point is identified
with a green X and the x- and y-coordinates for the point are displayed to four decimal places.

To display an x- or y-intercept or a point of intersection

1. Select the button on the calculator.

2. Drag a selection box over a region that contains an x- or y-intercept or a point of inter-
section of two functions to display the coordinates for a point.

If you select a region that has more than one point of interest, the point will be identified in the
following order of preference:

1. Point of intersection

2. x-intercept

3. y-intercept

If you select a region that has more than one point of equal priority, only the point with the low-
est x-value will be plotted. Alternatively, you can re-select a region with only one point of inter-
est.

Note: The calculator displays the coordinates of only one point at a time.
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Changing the Calculator Display Region

Setting the Display Region and Grid Spacing
The display region of the graph is defined by the X range and Y range values. The Grid Spacing
draws visible lines that correspond to tick points on the x- and y-axis. By default, the display
region is set at –5 to 5 for the X range, –5 to 5 for the Y range and the Grid Spacing is set to 1.

To display a different region of the graph, enter values for the X range and Y range and set the
Grid Spacing.

Zooming In and Out
To zoom in, click the button and then click the region of the graph you want to zoom in on.

You can zoom in as many times as you need until you see the level of detail that you require.

To zoom out, click the button and then click the display region. Click the display region

again to zoom out to see more of the display.

Moving the Graph in the Display Region

Click the button and then click and drag the display region to move the graph with your
mouse.
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You can also re-position the display region by selecting the options on the Restore Defaults
menu:

l Center Graph: This option is dependent on your current X and Y range and centers the
graph in the display region based on those values. If you had changed the grid size, this
option will not restore the grid defaults.

l Default Graph Area: Centers the graph and resets the maximum and minimum Display
Region values back to the defaults (-5, 5 for both X and Y axes). If you had changed the
grid size, this option will not restore the grid defaults.
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1252 Windows Latin 1 (ANSI)
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Trademarks
Blackboard Collaborate® and Blackboard Collaborate Web Conferencing® are registered trade-
marks of Blackboard Inc. and its subsidiary companies, all rights reserved.

Elluminate Plan!TM is a trademark of Blackboard Inc. and its subsidiary companies. All rights
reserved.

Elluminate Publish!TM, Elluminate Unplugged!TM, and Elluminate Unplugged! RecordingTM are
trademarks of Blackboard Inc. and its subsidiary companies. All rights reserved.

All other brand or product names are trademarks or registered trademarks of their respective com-
panies or organizations.
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